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This document is provided to customers who have purchased Molecular Devices equipment, software,

reagents, and consumables to use in the operation of such Molecular Devices equipment, software, reagents,

and consumables. This document is copyright protected and any reproduction of this document, in whole or

any part, is strictly prohibited, except as Molecular Devices may authorize in writing.

Software that may be described in this document is furnished under a non-transferrable license. It is against

the law to copy, modify, or distribute the software on any medium, except as specifically allowed in the

license agreement. Furthermore, the license agreement may prohibit the software from being disassembled,

reverse engineered, or decompiled for any purpose.

Portions of this document may make reference to other manufacturers and/or their products, which may

contain parts whose names are registered as trademarks and/or function as trademarks of their respective

owners. Any such usage is intended only to designate those manufacturers’ products as supplied by

Molecular Devices for incorporation into its equipment and does not imply any right and/or license to use or

permit others to use such manufacturers’ and/or their product names as trademarks.

Each product is shipped with documentation stating specifications and other technical information. Molecular

Devices products are warranted to meet the stated specifications. Molecular Devices makes no other

warranties or representations express or implied, including but not limited to, the fitness of this product for

any particular purpose and assumes no responsibility or contingent liability, including indirect or

consequential damages, for any use to which the purchaser may put the equipment described herein, or for

any adverse circumstances arising therefrom. The sole obligation of Molecular Devices and the customer's

sole remedy are limited to repair or replacement of the product in the event that the product fails to do as

warranted.

For research use only. Not for use in diagnostic procedures.

The trademarks mentioned herein are the property of Molecular Devices, LLC or their respective owners. These trademarks may not be used

in any type of promotion or advertising without the prior written permission of Molecular Devices, LLC.

Patents: http://www.moleculardevices.com/patents
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Safety Information

The safety information section provides information on the safe use of the instrument. It
includes the use of user-attention statements in this guide, a key to understanding the safety
labels on the instrument, precautions to follow before operating the instrument, and
precautions to follow while operating the instrument.

Read and observe all warnings, cautions, and instructions. Remember, the most important key
to safety is to operate the instrument with care.

WARNING! If the instrument is used in a manner not specified by Molecular Devices,
the protection provided by the equipment might be impaired.

Warnings, Cautions, Notes, and Tips

All warning symbols in the user guide are framed within a yellow triangle. An exclamation mark
is used for most warnings. Other symbols can warn of other types of hazards such as biohazard,
electrical, or laser safety warnings as are described in the text of the warning.

When warnings and cautions are displayed in this guide, be careful to follow the specific safety
information related to them.

The following user-attention statements can be displayed in the text of Molecular Devices user
documentation. Each statement implies a particular amount of observation or recommended
procedure as described:

WARNING! A warning indicates a situation or operation that could cause personal
injury if precautions are not followed. The warning symbol can vary depending on the
warning. The definition of the symbol is included in the text of the warning.

CAUTION! A caution indicates a situation or operation that could cause damage to the
instrument or loss of data if correct procedures are not followed.

Note: A note calls attention to significant information.

Tip: A tip provides useful information or a shortcut but is not essential to the completion
of a procedure.



FLIPR Penta High Throughput Cellular Screening System User Guide

8 5069582 G

Symbols on the Instrument

Each safety label on the instrument contains an alert symbol that indicates a type of potential
safety hazard.

Symbol Indication

The product documentation must be consulted. Indicates a warning for a

situation or operation that could cause personal injury if precautions are

not followed. There are specific details written next to the warning

symbol.

Potential ultraviolet light hazard.

Potential pinch hazard.

Potential heat hazard.

Power on.

Power off.

Instrument manufacture date.

European technology conformity.

United Kingdom technology conformity.

Certification by TUV Rheinland for compliance with US and Canadian

product safety standards.

Compliance with TUV Rheinland product safety for Germany.

Compliance with Chinese RoHS Pollution Control Requirements.

Compliance with California Proposition 65, which requires businesses to

warn Californians about significant exposures to chemicals that cause

cancer, birth defects or other reproductive harm.



Safety Information

5069582 G 9

Electrical Safety

To prevent electrically related injuries and property damage, inspect all electrical equipment
before use and immediately report all electrical deficiencies. Contact Molecular Devices
Technical Support to service equipment that requires the removal of covers or panels.

The instrument must be connected to a properly grounded power outlet to protect from the risk
of electric shock. The main chassis of the instrument is grounded together with all related
electrical components.

Do not remove the fixed covers, as there are no user-serviceable parts inside. All electrical work
must be referred to Molecular Devices approved service personnel.

In the event of a liquid spillage into the main cavity of the instrument, disconnect the mains
power supply before trying to clean up.

If the external covers on the instrument are removed, the power supply does not automatically
stop.

WARNING! HIGH VOLTAGE Power off the instrument and disconnect the power
cord before you do maintenance procedures that require removal of a panel or cover
or disassembly of an interior instrument component.

Do not try to use the instrument until all covers are replaced.

To provide access for disconnecting power from the instrument, maintain a 66 cm (26 in.)
minimum clearance area on the right side of the instrument.

To protect against fire hazard, replace the fuses only with the same type and rating as the
original factory-installed fuses.

Chemical and Biological Safety

Normal operation of the instrument can involve the use of materials that are toxic, flammable, or
otherwise biologically harmful. When using such materials, observe the following precautions:

Handle infectious samples based on good laboratory procedures and methods to prevent
the spread of disease.
Observe all cautionary information printed on the original containers of solutions before
their use.
Dispose of all waste solutions based on the waste disposal procedures of your facility.
Operate the instrument in accordance with the instructions outlined in this guide, and take
all the required precautions when using pathological, toxic, or radioactive materials.
Splashing of liquids can occur. When working with potentially hazardous liquids, take
applicable safety precautions, such as wearing safety glasses and protective clothing.
Observe the applicable cautionary procedures as defined by your safety officer when using
hazardous materials.
Observe the applicable cautionary procedures as defined by your safety officer when using
flammable solvents in or near a powered-up instrument.
Observe the applicable cautionary procedures as defined by your safety officer when using
toxic, pathological, or radioactive materials.

WARNING! Never use the instrument in an environment where potentially damaging
liquids or gases are present.
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Moving Parts Safety

To prevent injury due to moving parts, observe the following:

Never try to exchange labware, reagents, or tools while the instrument is operating.
Never try to physically restrict the moving components of the instrument.
Keep the interior of the instrument clear to prevent obstruction of the movement.

The motors use high-powered magnets. The linear drive units and encoders are delicate, so be
very careful with them. To prevent serious damage to the instrument or its auxiliary parts, follow
the preparation instructions in this guide before every process.

The instrument door automatically locks whenever you run a process. The door prevents UV
light from passing through during operation.

As a safety measure, if the door is open, an electromagnetic switch prevents the instrument
from running. Never tamper with this switch, as it serves two purposes:

It prevents the motors from running to reduce the potential of physical damage.
It disables the UV light to prevent the risk of damage from UV radiation.

Motors and their related drives and cabling are sources of electromagnetic fields. Keep
magnetic storage devices or strips, such as hard drives and credit cards, away from the
instrument covers.

Note: Observe all warnings and cautions listed for all external devices attached to or in
use during the operation of the instrument. See the applicable user guide for the
operating and safety procedures of that device.

Ultraviolet (UV) Light Safety

The instrument door automatically locks whenever you run a process. The door prevents UV
light from passing through during operation.

As a safety measure, if the door is open, an electromagnetic switch prevents the instrument
from running. Never tamper with this switch, as it serves two purposes:

It prevents the motors from running to reduce the potential of physical damage.
It disables the UV light to prevent the risk of damage from UV radiation.
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Chapter 1: Introduction

The FLIPR® Penta High-Throughput Cellular Screening System provides an automated solution
to identify early leads in the drug discovery process and to evaluate drug efficacy and toxicity.
The system supports fast kinetic cellular assays with simultaneous pipette and read function
and can be configured based on library size, detection mode, screening format, assay and
target. A fully integrated solution from assay development to lead optimization.

The FLIPR Penta System includes:

Simultaneous 96-well, 384-well, or 1536-well liquid or cell transfer
Expanded wavelength support
User-configurable pipettors and optics
FLIPR® Cycler, internal robotic plate handler option that works in conjunction with external
robotic software
Choice of camera:

EMCCD camera for fluorescence applications
HS EMCCD high-speed, high-sensitivity camera for fluorescence and luminescence

Compact platform with minimal facilities requirements
ScreenWorks® Software and optional ScreenWorks® Peak Pro™ Software modules for
analysis

Workflow

The FLIPR Penta High-Throughput Cellular Screening System uses the following sequence of
processes:

1. Prepare the cells.
2. Power on the system.
3. Run a system check.
4. Load cell dye.
5. Prepare source plates.
6. Set up an assay protocol.
7. Run the experiment.
8. Analyze the data.

Before You Start

CAUTION! Before you use the instrument, read and understand all the safety
instructions. Then follow the procedures in Powering On the System on page 16.

1
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System Requirements

Electrical

The FLIPR Penta System consumes 5 A continuous and 9 A peak of 110 V power and requires
90-240 VAC power source at 50-60 Hz, which equates to 2.5 A continuous and up to 4.5 A
peak at 240 VAC/50 Hz. The system ships with a power cord appropriate for the receiving
country.

Note: The power supply has a circuit breaker rated at 15 A because the inrush current
has been measured to be as high as 13 A at 110–120 VAC. Customers with 240 VAC
should inform their facilities engineers that a breaker may have to be installed for their
electrical lines to handle an inrush current 2x the 13 A current. Molecular Devices
recommends a D curve circuit breaker for this equipment. Additional shared outlets are
required for computer and monitor. A power strip, not included, is acceptable for
providing the additional outlets for the computer and monitor.

Minimum Lab Space

System dimensions are approximately 99 cm wide x 69 cm deep x 1780.44 mm high (39 inches
wide x 27 inches deep x 70.25 inches high).

Note: To open the stage access door you need more than 76 cm (30 inches) additional
space in front of the instrument.

The external ScreenWorks Software host computer mounts on the right side of the instrument
cabinet. The monitor, keyboard, and mouse install on an adjustable arm attached to the front
right side of the instrument cabinet. Combined, they require an additional minimum amount of
space of 102 cm (40 inches) wide x 102 cm (40 inches) deep for maneuverability.

A chiller with dimensions 33 cm (L) x 28 cm (W) x 28 cm (H) (13 inches L X 11 inches W by
11 inches H) connects to the right side of the instrument with a 91.4 cm (3 feet) long tube. Place
the chiller within the 91.4 cm (3 feet) radius with access to the chiller on/off button.

A minimum 81 cm (32 inch) square footprint is required on the right side of the instrument for tip
wash bottles.

The instrument cabinet should have service access space of 122 cm (48 inches) in front, 61 cm
(24 inches) behind, and 25.4 cm (10 inches) on the left.

The FLIPR Penta System has rolling castors to move it for necessary adjustments and perform
maintenance. The lower instrument chassis has foot levelers to establish a uniform instrument
deck level in situations where the lab floor is not flat and to stabilize the instrument when you
integrate a robot. Lower and level the instrument feet when you run an experiment.

WARNING! The FLIPR Penta System can weigh as much as 390 kg (860 lbs.). Follow
all necessary safety precautions and use proper moving techniques.
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Computer System

The FLIPR Penta System uses two computers, an embedded computer and a host computer.

Embedded Computer

The embedded computer is in the lower chamber of the instrument cabinet. The embedded
computer controls the FLIPR Penta System basic functions that the ScreenWorks Software
initiates. The ScreenWorks Software is installed on the host computer. This allows separate
data processing and instrument control to ensure maximum productivity during an experiment.

Note: External or local IT interference with the embedded PC is not recommended.
Contact support for any assistance.

Host Computer

You use the ScreenWorks Software that runs on the external host computer to interact with the
FLIPR Penta System.

Item Description

CPU 2.5 GHz, quad processor or faster

Operating system Windows 10 (64-bit), or Windows 11

Memory 32 GB RAM (8 GB RAM minimum)

Data Connection 10/100 Ethernet port

Storage 500 GB hard drive

Display 27 in., 2560 x 1440 resolution maximum, Custom scaling set to not exceed 107%

Computer Specifications

Note: Do not change the Display settings to those that exceed the stated specifications.

Do not install anti-virus software that blocks ports or applications which could slow down the
performance of software. Do not upload anti-virus software to avoid blocking the software.

Avoid blocking the following ports:

5001 - Used for communication between the embedded computer and the host computer.
3389 - Used by service engineers to access the embedded computer system.
1947 - Used for software license activation.

Operating System Disclaimer

Microsoft continuously updates the Windows operating system. Molecular Devices tests the
compatibility of the ScreenWorks Software with a selection of the current Windows operating
system releases that are available when the ScreenWorks Software is in development.

The following Windows operating systems are known to be incompatible with the ScreenWorks
Software and are not supported: Windows 10/11 Home edition, Mobile edition, and Enterprise
IoT edition.

Please contact Molecular Devices for guidance before you select or update your Windows
operating system. Although not tested, other Windows operating systems are compatible with
the ScreenWorks Software.
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Software Installation

Your Molecular Devices representative sets up the FLIPR Penta System in your lab. Use the
following software installation procedures when you update the ScreenWorks Software on the
host computer. You must have administrative privileges on the computer.

Installing ScreenWorks Software

The installer uninstalls the old software version as long as it is the same major release (5.x to
5.x+x). If you update to the next major release (4.x to 5.x), you must manually uninstall the old
software. See Uninstalling ScreenWorks Software on page 15.

To install the software:

1. Double-click the ScreenWorks_x.x.exe ScreenWorks Software installation file to display the
Welcome to the ScreenWorks Setup Wizard.

2. Click Next to display the License Agreement page.
3. Select the I Accept the Terms of the License Agreement check box.
4. Click Next to display the Online/Offline Mode page.
5. Select a default mode in which to start the software:

Select Online to have the software look for a connected instrument when the software
starts.
Select Offline to have the software not look for a connected instrument.

See Online Mode vs. Offline Mode on page 39.
6. Click Next to display the Destination Folder page.
7. Note the default installation directory. To change the installation directory, click Change,

navigate to the destination directory, then click OK.
8. Click Next to display the Select Program Folder page.
9. Leave the default Program Folder settings and select the Anyone Who Uses This

Computer check box to make the software available to all users on the FLIPR Penta System
host computer.

10. Click Next to display the Configuring the ScreenWorks Installation page.
11. Click Next to start the installation.
12. When the Completing the Installation Process page displays, click Finish.
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Activating the ScreenWorks Peak Pro License

The ScreenWorks® Peak Pro™ Software is license protected. The software license activation
allows the Peak Pro analysis functionality after the trial period expires. The following Peak Pro
analysis licenses are available for purchase:

ScreenWorks Peak Pro Software version 1.0 adds additional Kinetic Reduction
Configuration types.
ScreenWorks Peak Pro Software version 2.0 adds a new Peak Pro 2.0 Analysis dialog and
support for high-speed and high-sensitivity data.

Note: There is a 14-day Peak Pro trial usage option in the Help menu. When the trial
period expires, the Peak Pro 1.0 analysis functionality disappears, the Peak Pro 2.0
analysis functionality disables, and the Help menu trial option is inactive. The rest of the
ScreenWorks Software remains functional.

To activate the ScreenWorks Peak Pro Software license:

1. Start the ScreenWorks Software.
2. Select the Help tab and click Software License.
3. If you did not start the 14-day Peak Pro Software trial, either start the 14-day Peak Pro

Software trial or enter the product key. After the trial expires, you can only enter the
software license product key. Click Yes.

4. If the computer has internet access, in the Product Key field, enter the product key and click
Activate Online. Then follow the on-screen instructions.
If the computer does not have Internet access, click Activate Offline and follow the on-
screen instructions. You need:

Product key
A computer with Internet access
A USB to transfer files between the computers

5. Restart the ScreenWorks Software to finish the license activation.

Uninstalling ScreenWorks Software

To uninstall the ScreenWorks Software:

1. Open the Control Panel.
2. Depending on the Windows operating system:

Windows 7 - Click Add or Remove Programs
Windows 10 - Click Programs and Features

3. Select ScreenWorks.
4. Click Remove or Uninstall.
5. Follow the on-screen instructions to finish the software removal.
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Powering On and Powering Off the System

Do the following to power on and power off the FLIPR Penta System, which includes connecting
the ScreenWorks Software to the instrument.

Powering On the System

To power on the FLIPR Penta System:

1. Power on the computer and the monitor.
2. Simultaneously press CTRL+ALT+DELETE to launch the Windows operating system.
3. Enter your password.

Note: The first time you log in after system installation, the default password is
fliprtetra.

4. Power on the external chiller with the switch on the left side of the chiller.

CAUTION! When the system is idle, the external chiller should remain powered on to
protect the camera.

5. Power on the FLIPR Penta System with the switch located on the right side of the
instrument.

Note: The system goes through an initialization cycle to register all of the instrument
components. This cycle is not complete until the green Assay Finished (Unlock) light
on the upper door is the only light illuminated on the instrument status panel.

6. On the computer desktop, double-click to start the ScreenWorks Software.

Do not repeatedly double-click the software icon. The software can take several seconds to
start.

Note: The system is ready for use when the camera temperature is at operating
temperature. The camera temperature and status display in the ScreenWorks Software
Instrument Status panel. The camera operating temperature depends on the camera
installed in the instrument. See CCD Camera Options on page 29.
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Connecting the Software to the Instrument

After you power on the instrument, when you start the ScreenWorks Software in Online mode, it
should automatically connect to the instrument. In the software, in the Instrument Status panel,
the lower right corner of the screen displays a green connection status icon to indicate the

connection and displays in the toolbar.

If the connection status icon is black, the software is disconnected from the instrument and
displays in the toolbar.

Click to connect the software to the instrument.

Powering Off the System and the Software

To power off the FLIPR Penta System:

1. Wait for the Assay Finished (Unlocked) light on the upper door, Instrument Status Panel to
turn green which indicates the experiment is finished.

2. If the last protocol run did not remove the tips from the pipettor head, use the manual
command to remove the tips. Failure to remove tips can result in an error on next start.

3. Click the File menu and select Exit to exit the ScreenWorks Software.
4. Power off the computer and the monitor.
5. Power off the FLIPR Penta instrument.
6. Power off the chiller.
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Checking Instrument Status and Configuration

Check the instrument status on the front of the instrument and from within the ScreenWorks
Software. Check the instrument configuration status from within the ScreenWorks Software.

System Status Panel

The system status panel, located next to the upper door handle, indicates if the door is locked
or unlocked, depending on the instrument activity. It also includes an emergency Interrupt
button to stop any running processes.

The following are on the System Status panel:

Assay Running (Locked) Yellow light - The system is performing a task. The upper and
lower instrument doors are locked until the task finishes or is stopped.
Assay Finished (Unlocked) Green light - The system is not performing a task and it is safe to
open the upper and lower instrument doors.
Interrupt Flashing green light - Press to override the system and stop all tasks, so you can
access the instrument. When pressed, the light flashes until the system reaches a safe state
for you to open the doors.

CAUTION! The Interrupt button immediately ends the experiment and should only be
used in emergencies. Before you can use the instrument again, you might need to be
reinitialize the system from within the software. Click the Instrument menu and select
Reset.
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Software Status Tabs

Within the ScreenWorks Software, the Instrument Status Configuration Process tab, located on
the bottom of the main screen, reports the status and settings for the FLIPR Penta System
hardware and includes the processes you use to create protocols. See Instrument Status
Configuration Process on page 55.
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Chapter 2: System Hardware Overview

The FLIPR Penta System consists of a cabinet 965 mm (39 inches) wide x 686 mm (27 inches)
deep x 1780 mm (70 inches) high. There is a top compartment for wet components and bottom
compartment for dry components. Outside the cabinet are the wash system fluid bottles, chiller,
computer, monitor, keyboard, and mouse.

FLIPR Penta System with Optional Modules

For system component details, see:

Five-Position Stage on page 22
Plate Support on page 23
Plate Handling System on page 24
Liquid Handling System on page 26
Optical System on page 29
Chiller on page 37

2
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Five-Position Stage

Run experiments from the five-position stage in the upper compartment of the instrument.
Manually load plates through the upper compartment door before an experiment or robotically
during the experiment using the optional FLIPR® Cycler internal plate handler.

The following are the five plate positions of the stage from left to right:

Position 1 - Tips and Source Plate 1
Position 2 - Source Plate 2
Position 3 - Read Plate
Position 4 - Source Plate 3
Position 5 - Tip Washer

Positions 1, 2, and 4 support standard, low-volume, deep-well and reservoir source addition
plates.

Position 1 is to load and unload tips and can be used as a source plate position after tips load
and the tip box is removed.

Position 3 opens to the optics chamber below for excitation of fluorophores in read plate wells,
the read position, and emission reads.

Position 4 is a source plate position.

Positions 1 through 4 have a mechanical plate sensor to identify the presence of plates, tips, or
reservoirs.

Position 5 is a dedicated tip wash reservoir and should be configured to match the pipettor
heads, such as 96, 384, or 1536. Tip wash reservoirs are included with the purchase of a
pipettor head. See Washing Pipettor Tips and Pin Tools on page 139.

Robotic integration allows the optional FLIPR Cycler internal plate handler to automatically
exchange up to 12 source plates and tip racks and one read plate in an experiment. See
Automating Plate Loading on page 24.
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The plate indexers in positions 1 through 4 register plates and tip racks with well A1 in the lower
left corner. The indexers serve as mechanical sensors to detect the presence of plates or tips. If
the instrument does not sense plates or tips during a Manual mode experiment when the
software requests a plate or tips, the instrument stops and ends the experiment. During Remote
mode, the system notifies the SynchroMax™ ET plate handler robot or third-party plate handler
robot that no plate or tip container is available and stops the instrument until it detects plates or
tips. The SynchroMax ET plate handler or third-party plate handler is then responsible to deliver
plates or tips to the system. See SynchroMax ET External Plate Handler on page 26.

CAUTION! Sensors can only detect the presence of a plate or a tip container. Sensors
cannot identify the type of plate or tips, or if lids are on the plate. It is your responsibility
to ensure that the correct plates and tips are loaded into position without lids.

Note: Molecular Devices no longer sells the SynchroMax ET plate handler robot. The
FLIPR Penta System becomes dependent on the robot system configuration.

Regulating Stage Temperature

Plate stage positions 1, 2, and 4 for source plates, have temperature control. Stage temperature
settings range from ambient 25°C (77°F) to 40°C (104°F). It can take approximately 15 minutes to
reach equilibrium temperature.

Configure temperature regulation with the Temperature Control ON/OFF toggle command.
Click the Instrument menu and select Manual Operation.

Plate Support

The FLIPR Penta System supports the use of 96-well, 384-well, and 1536-well plates that
conform to the ANSI standards submitted by the Society for Biomolecular Sciences.

Note: Only low-profile 1536-well plates are supported.

Black walled, clear-bottomed read plates provide an optimal imaging environment for
fluorescence assays. These plates prevent signal diffraction while allowing excitation and signal
access. Use black walled, clear-bottomed plates or white walled, clear-bottomed plates for
luminescence assays.

For 96-well read plates, use a slit-shaped mask to minimize saturation and edge effects
associated with these plates. Place the mask over the read position. 384-well and 1536-well
plates do not require a mask. See Consumables and Accessories on page 179.

Use the 96-pipettor heads and 384-pipettor heads with source or read plates with equal or one
order higher well number. The FLIPR Penta System can aspirate or dispense into quadrants of a
plate. The following combinations are possible:

Use the 96-pipettor head with 96-well and 384-well plates.
Use the 384-pipettor and pin tool head with 384-well and 1536-well plates.
Use the 1536-pipettor and pin tool head with 1536-well plates.

You can substitute deep-well plates or reservoirs for standard well plates.

When you aspirate or deliver compound to a plate with a greater number of wells than the
pipettor head, enter the quadrant number in the protocol configuration for each dispense.

Many compatible source and read plates are available from Molecular Devices. See
Consumables and Accessories on page 179.

For compatible plate details, see FLIPR Penta Plate Dimensions on page 189.
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Plate Handling System

The plate handling system includes two methods to place plates on the five-position stage to
run experiments.

Loading Plates Manually

Before you run an experiment in Manual mode, position the assay components in the five-
position stage by hand in the upper compartment. You cannot make additional plate or tip
changes after the experiment starts.

Note: Keep the top compartment door closed during system operation. All system
functions stop when the door is open.

Automating Plate Loading

Note: Molecular Devices no longer offers the SynchroMax ET external plate handler
robot. The following information is for reference only.

Support for automated plate delivery with the FLIPR Penta System is facilitated using optional
robot systems.

To increase the number of plates in an experiment and minimize personnel requirements, use
the FLIPR Cycler internal plate handler coupled with the external SynchroMax ET plate loader
robot or a third-party plate loader robot. One read and up to 12 source plates and tip racks can
shuttle in and out of the FLIPR Penta System in one experiment using automated delivery.

When you use automated delivery, the SynchroMax ET plate loader robot or third-party plate
loader delivers plates to the landing pad on the outside left of the instrument and picks plates
up from the landing pad on the outside left of the instrument. The FLIPR Cycler plate handler
then shuttles the plates in and out of the plate stage compartment. The shuttle door over the
landing pad opens and closes to maintain a light-tight environment within the compartment.

During automated operation the SynchroMax ET plate loader or third-party plate loader controls
the FLIPR Penta System by sending instructions to load protocols, run experiments, and retrieve
plates from the landing pad. The instrument executes these commands upon receipt from the
SynchroMax ET plate loader or third-party plate loader. Instrument settings cannot be persisted
from the remote controlling program. You must configure these settings in the ScreenWorks
Software before control passes to the plate-delivery system.

To start Remote Mode:

To pass control to the plate delivery software, in the ScreenWorks Software, click the
Instrument menu and select Set Remote Mode.

To stop Remote Mode:

The FLIPR Penta System stays in remote control until you click the Instrument menu and
select Set Manual Mode.

The third-party plate loader software communicates with the FLIPR Penta System computer
through the serial communication port. Install the SynchroMax ET software with the
ScreenWorks Software on the FLIPR Penta System computer so it can communicate directly
with the instrument. See Robotic Integration on page 203.
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FLIPR Cycler Internal Plate Handler

The FLIPR Cycler plate handler system is a plate gripper that runs along the back wall of the
upper read compartment to give it access to positions 1 through 4 in the five-position stage and
the landing pad on the outer left side of the cabinet.

The FLIPR Cycler plate handler shifts source plates and tip containers between these locations
when under the control of the external SynchroMax ET plate holder robot or a third-party plate
handler.

The FLIPR Cycler plate handler carries standard, low volume and deep well 96-well, 384-well,
and 1536-well plates that conform to proposed ANSI standards submitted by the Society for
Biomolecular Sciences. The FLIPR Cycler plate handler can move Molecular Devices qualified
tips.

Note: You can use reservoirs during robotic integration, however the FLIPR Cycler plate
handler cannot move the reservoir. You must manually load the reservoirs before you
run an experiment, including the cell reservoir.

CAUTION! Some plates may not be handled as reliably by the FLIPR Cycler plate handler
because of their low plate weight. During robotic integration, you should evaluate plate
and tip handling by the FLIPR Cycler plate handler for handling reliability before you start
a screen. The FLIPR Penta System is validated for use with the Molecular Devices tips
and there is no guarantee regarding performance or troubleshoot any instrument issues
with any other tips.

The upper and lower door of the FLIPR Penta System must remain closed for the duration of the
experiment. Plates are transported in and out of the instrument through the FLIPR Cycler plate
handler robotic landing pad door.

WARNING! Do not place your fingers in the FLIPR Cycler shuttle door as this can
cause injury.
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SynchroMax ET External Plate Handler

Note: The SynchroMax ET plate handler robot is no longer available for new purchases.
Other robotic systems are supported.

The SynchroMax ET robot is a six-stack plate handler that was available as an optional purchase
with the FLIPR Penta System. It delivers plates to and from the landing pad and integrates with
the FLIPR Cycler internal plate handler, which ferries the plates to and from their locations in the
five-position stage. The configuration interface of the SynchroMax ET software opens from
within ScreenWorks Software.

Liquid Handling System

The liquid handling system includes four components to move liquids to and from the five-
position stage.

Standard Pipettor Head

Standard pipettor heads are available in 96-tip, 384-tip, and 1536-tip formats. The 96-pipettor
head and 384-pipettor head both use disposable plastic tips.

The 1536-pipettor head uses a stainless-steel tip block with a disposable 1536-tip gasket. Wash
the plastic tips, replace them between each compound addition, or replace them at the end of
an experiment. Was the 1536-tip block at specified times.

The ScreenWorks Software protocols control pipettor operations. You can use commands in
the Instrument menu to load tips. Connectors on the back of the pipettor head identify the head
format as 96-tips, 384-tips, or 1536-tips and the ScreenWorks Software offers valid plate formats
and pipetting parameters for protocol setup.

The standard pipettor head uses air displacement to control aspiration and dispense speed and
volume. Use the software to configure the volume of compound to transfer. You can configure
the protocol to draw compound from multiple source plates to dispense into one destination
plate or to aspirate from one plate and dispense to multiple well plates or quadrants.

The instrument can use 384-pin and 1536-pin pipettor heads with pin tool and the software has
protocols to aspirate, dispense, and wash. These protocols activate when you install the
appropriate head.

Wells Pipettor Head Range Pipetting Increments Precision

96 5–200 µL 1 µL 3% CV @ 75 µL

384 1–25 µL 0.5 µL 4% CV @ 25 µL

1536 0.5–3 µL 0.1 µL 6% CV @ 3 µL

FLIPR Penta Fluidics Specifications

The 96-pipettor head and 384-pipettor head displace air in the disposable pipette tips.

The 1536-pipettor head contains a plunger for each of the 1536 tips that presses against an
elastic gasket seated on the tip block. When the plungers move down, they create an initial seal
between the gasket and tip-block. After creating the seal, further plunger movement causes air
displacement in the tip-block.
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Seal Creation in the 1536-Pipettor Head

CAUTION! Performance depends on tip-block and gasket seating and can be
compromised if the seal breaks.

Use only Molecular Devices recommended tip-blocks and gaskets to ensure the highest
accuracy and to reduce the possibility of damage to the pipettor and tips. See Consumables
and Accessories on page 179.

Pin Tool Head

Pin tools are blocks of solid or slotted pins, where the pins replace the hollow tips you use with
a standard pipettor. The pins use capillary action to pick up and transfer liquid from one plate to
another. The ability to accurately and reliably transfer compounds in nanoliter volumes allows
you to supply test compounds in 100% DMSO solution, which removes the need to prepare
intermediate dilution plates.

The volume that each pin picks up is determined by the size of the pin (and, if slotted, the size of
the slot) and the withdrawal speed of the pin from the liquid. A faster removal speed leaves
more liquid on the pin. Enter the pick-up volumes and tip removal speeds during assay
development.
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You can use 384 pin tool heads or 1536 pin tool heads and you can exchange the pin tools to
change the pin size. The 384 pin tool has four different pin sizes to give a total range (across all
the sizes) from 84 nL to 656 nL. The 1536 pin tool has seven different pin sizes to give a total
range from 19 nL to 117 nL. The pin tools are available with a hydrophobic and lipophobic
coating to prevent or reduce the nonspecific binding of proteins and lipids to the pins. See
Exchanging Pin Tools on page 148.

Each pin size has a volume range that it carries:

The lowest reported volume is for a tip removal speed of 7.8 mm/s.
The highest reported volume is for a tip removal speed of 57.0 mm/s.

To ensure uniform compound pick-up across the entire pin tool, configure the pins to float in
source plate wells. Individual pins are not rigidly attached to the pin block and have a small
amount of vertical movement up into the block. When set to float, the pin head moves down
very low so that all pins sit on the bottom of the well and push up a little into the block. This
ensures that all pins are equally immersed in the wells. This outcome cannot be guaranteed if
the pins were rigidly fixed to the block, given that plate bottoms are often not completely flat.

Pipettor Tip and Pin Tool Washer

The washer consists of a reservoir top for the pipettor format that is mounted over a wash basin.
The wash basin connects to two solvent-supply carboys and two waste carboys located on the
floor beneath the computer monitor. A basin beneath the tip washer base drains to a waste
carboy to safely remove any solvent that overflows from the reservoir.

Wash solution fills the reservoir for a calibrated amount of time. Solvent then drains from the
reservoir after each wash cycle. You can configure up to five wash cycles within a single wash
process in the protocol. See Wash Cell Reservoir Process on page 95, and Creating New
Protocols on page 96.

For pipettor tips, you define the volume of solvent to draw up, how long to hold, the volume to
expel, and to repeat up to 20 times.

For pins, vertical motion of the tip block agitates the wash solvent around the pins.

You can wash tips or pins in up to two solutions before you reuse the tip washer. When you
require additional wash solutions, you can wash pipettor tips or pins a boat or reservoir in one of
the source plate positions with a protocol Mix Fluid process configuration. See Mix Fluid
Process on page 87.

WARNING! High volumes of volatile, flammable solvents in the read chamber can
cause explosive conditions. Use of 100% isopropanol, etc., in the tip washer is
discouraged without additional ventilation. Consult your facilities expert to determine
the appropriate ventilation to avoid explosive conditions.

Pin tools are supplied with blotting stations that you load in one of the plate positions on the
stage, such as Position 4 (Source 3). Configure blot pin steps in the protocol to remove fluid
from the pins.

Note: A waste bottle sensor override (P/N 0700-0827) is available in the
FLIPR Penta System accessory kit to bypass the waste sensor and dispose waste in
containers other than the dedicated waste carboys.

To exchange the wash reservoir top, see Exchanging Pipettor Tips and Pin Tool Wash Reservoir
Top on page 145.
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Optical System

The FLIPR Penta System optics are housed in the bottom compartment of the main cabinet. In
fluorescence assays, where excitation is required, light from light-emitting diodes (LEDs) is
directed at the base of the read plate exposed in position 3 in the 5-position stage above. Light
emitted from the plate travels down through emission filters before being captured in the CCD
camera.

CCD Camera Options

The FLIPR Penta System supports the following types of CCD cameras:

EMCCD (Electron Multiplying CCD) - Camera for fluorescence only experiments.
HS EMCCD (High-Speed, High-Sensitivity Electron Multiplying CCD) - Camera for both
high-speed, high-sensitivity, fluorescence, and luminescence assays.

EMCCD Camera

The camera is located directly beneath the read plate on the five-position stage. The camera is
thermoelectrically cooled and requires about five minutes to reach its operating temperature of
-70°C (-94°F) ± 2°C.

CAUTION! The instrument does not let you use the camera before it reaches the proper
operating temperature. Check the camera temperature on the Instrument Status panel
before you start an experiment.

The camera uses frame-transfer technology that shifts pixel values from the exposed portion of
the chip to the data processing portion. This allows a high acquisition rate and eliminates the
possibility of camera shutter failure.
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The camera is an integrating-type detector that uses temporal integration to build up the
signal-to-noise ratio. Depending on the intensity of the emitted light (reliant on dye efficiency
and LED power), you may need to vary camera exposures. This prevents the measured
fluorescence signal from being dominated by detector noise.

Images are taken of the bottom of the entire plate for the time you specify in the protocol and
exposure time can be from 0.05 to 30 seconds. In ratiometric experiments where two or more
wavelengths are measured, the number of images captured increases so that an image is taken
for each wavelength at the rate you specify. The software calculates a relative light value from
each image for each well. The FLIPR Penta System reports relative fluorescence units (RFUs) in
a range from zero to approximately 12,000.

Use the Gain setting in the ScreenWorks Software to amplify the light intensity detected by
each pixel on the CCD chip. This parameter has a range from one to 240. Amplification is
exponential, increments increase as you go higher up the range. Fluorescence assays typically
use a gain of 80 whereas luminescence assays should use 200 as a starting point. Gain
optimization should be done during assay development to determine optimal conditions for the
protocol.

When a luminescence experiment follows a fluorescence experiment, you should cycle the
camera temperature to eliminate ghost images that may be created during the fluorescence
assay. Click the Instrument menu and select Manual Operation and then select Cycle Camera
Temperature. The camera warms up to room temperature to release ghost images, before
cooling back down to approximately -70°C (-94°F).

Note: Luminescence readings are available with the EMCCD camera option, however
camera sensitivity is not optimal for this type of experiment.

HS EMCCD Camera

The camera is located directly beneath the read plate on the five-position stage. The camera is
thermoelectrically cooled and requires about five minutes to reach its operating temperature
range between -70°C (-94°F) ± 2°C.

CAUTION! The instrument does not let you use the camera before it reaches the proper
operating temperature. Check the camera temperature on the Instrument Status panel
before you start an experiment.

The camera uses frame-transfer technology that shifts pixel values from the exposed portion of
the chip to the data processing portion. This allows a high acquisition rate.

The camera is an integrating-type detector that uses temporal integration to build up the
signal-to-noise ratio. Depending on the intensity of the emitted light, which is reliant on dye
efficiency and LED power, you may need to use shorter or longer camera exposures. This
prevents the measured fluorescence signal from being dominated by detector noise.

Images are taken of the bottom of the entire plate for a time you specify in the protocol. There
are a variety of exposure settings available depending on the mode in which the camera is run.
In ratiometric experiments for example, where two or more wavelengths are measured, the
number of images captured increases so that an image is taken for each wavelength at the
specified rate. From each image a relative light value is calculated for each well. The
FLIPR Penta System reports relative fluorescence units (RFU) in a range from zero to
approximately 64,000 RFU.
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Use the Gain setting in the ScreenWorks Software to amplify the light intensity detected by
each pixel on the CCD chip. The parameter for the Fluorescence mode has a range from 1.5 to
128. In the Camera Mode > Normal, fluorescence assays typically use a gain of 8 for bright
calcium assays depending on the exposure time and LED power. Gain optimization should be
done during assay development to determine optimal conditions for the protocol.

Tip: When you use the Camera mode > High-Speed, for optimal performance, use a
camera gain of 20 or higher and adjust the Exposure Time and Excitation Intensity for
your experiment.

When a luminescence experiment follows a fluorescence experiment, you should cycle the
camera temperature to eliminate ghost images that may be created during the fluorescence
assay. Click the Instrument menu and select Manual Operation and then select Cycle Camera
Temperature. The camera warms up to room temperature to release ghost images, before
cooling back down to approximately -70°C (-94°F).

When you use the High-Speed camera mode or the Sensitivity camera mode, the camera
behaves differently than in the Normal camera mode. The High-Speed camera mode and the
Sensitivity camera mode use 2x2 pixel binning in the camera, which combines 4 pixels into one.
This increases sensitivity to smaller signals, as well as for speed. The effect of overexposure in
the camera sensor when you use this binning mode is different than for a non-binned exposure,
due to the design of the sensor. See Determining Protocol Saturation Levels for the
HS EMCCD Camera on page 106.

Stabilizing the HS EMCCD Camera

When you use the HS EMCCD camera, you can run the optional stabilization process before the
experiment starts to avoid camera signal drift. The Stabilizing camera process takes 50 seconds
to complete.

Tip: The software may prompt you to run camera stabilization, but if camera stabilization
is not important for the protocol, you can skip the stabilization process.

If the biology is time-sensitive, you can ready the instrument before you run the experiment.
Click the Instrument menu and select Manual Operation and then select Pre-Stabilize.

If the biology is not time-sensitive, select Auto Stabilize in the protocol settings to start
stabilization before the experiment begins. See Edit Read Mode on page 61.

Note: When you save auto stabilize as part of the protocol, if the camera is not already
stabilized and the protocol has multiple reads, auto stabilize only runs the first time.

The instrument maintains the camera stability for a limited time. The Instrument Status tab
displays a stabilization timer countdown. As long as the protocol is unchanged, and the
instrument door is closed, camera stability is sustained for two hours between experiment runs.
The two-hour expiration countdown restarts after every experiment runs.

When you open the instrument door, you have up to 15 minutes with the instrument door open
before you have to run the camera stabilization process again. Within the 15-minute time limit,
after you close the door, the timer returns to the two-hour expiration countdown.
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Understanding HS EMCCD Camera Protocol Saturation

When you set up a protocol, you must define the read exposure settings avoid over saturation
on the HS EMCCD camera sensor. If well signals hit saturation, they cannot be quantitatively
compared. The camera provides a saturation warning when 5% of well values on the plate
exceed 90% of the camera sensor dynamic range. Keep the maximum signals below this level.
The HS EMCCD camera threshold is about 45000 counts; but it can vary a few thousand counts
between cameras. Use the Protocol Signal Test dialog to determine the camera saturation level
and to adjust the exposure for the biology.

As the exposure increases past the saturation threshold, the software displays a saturation
warning and the raw image in the Protocol Signal Test dialog shows the wells becoming bright
white, as before with Normal camera mode as noted in the following images.

High-Speed Mode Signal Test Saturation with Warning
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Image Display of High-Speed Mode Signal Test Saturation

For a short range of over exposure, the saturation warning works. As the exposure increases
further, the brightest pixel values start to get darker in the center of the well areas, as shown in
the following image.

Image Display of High-Speed Mode Signal Test Saturation Reversing

As the brightest pixels get darker, the pixel values drop lower, instead of staying at the
maximum saturation value. This reversal effect happens when the binned image pixels are
overexposed. The overall average for the image decreases, and after about a 4x overexposure
increase, no saturation warning appears. As the exposure increases further, the wells start to
bloom and flood across the image as before, except that the center of the streaks are darker,
and no saturation warning appears, as shown in the following image.
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Image Display of High-Speed Mode Signal Test Blooming Without Saturation Warning

This is a problem to detect when the image measurements are saturated, and the system
cannot give a reliable saturation warning for grossly overexposed well signals when you use the
High-Speed camera mode. See Determining Protocol Saturation Levels for the
HS EMCCD Camera on page 106.

All Cameras

When calculated, relative luminescence units (RLU) and relative fluorescence units (RFU)
display in real time in the Analysis process window (within the limits of computer processing
speed). Data for one wavelength for all 96-wells, 384-wells, or 1536-wells of the plate, display in
the Multi-Well graph on the right. Select wells in the Multi-Well graph to populate the Detail
graph. You do post-assay analysis in the ScreenWorks Software when the experiment
completes, and you can export the data.

In normal operation, the software discards images after relative luminescence units (RLU) and
relative fluorescence units (RFU) values are measured. You can define the number of images to
save per Read with Transfer Fluid step for quality purposes, up to 6,000 images per
experiment. These images are useful to troubleshoot problems, such as cells lifting from well
bottoms during compound addition. Images save as *.tif files with the same name and to the
same directory as the data file. To view the image, click Image on the Analysis process page
when the result data file is open.

Note: The robustness of an assay is not dependent on the size of the signal. It is better
determined by the signal-to-noise ratio. A commonly used calculation to determine assay
robustness is the Z’ factor equation.
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LED Modules

The FLIPR Penta System has four LED banks to provide illumination for plate reads. When an
image is to be captured, the LED banks pulse on, two at a time to protect cells from dye photo-
bleaching.

The LED banks are divided between two modules, one on either side of the read plate position
above. LED banks in corresponding positions in either module are paired. The paired LED
banks pulse simultaneously during an experiment, so that light strikes the read plate base from
two directions to help ensure that the entire plate is maximally illuminated.

Typically, the two LED bank pairs are set up with LEDs of different wavelengths, for example,
one pair might have LEDs of range 470 nm to 495 nm, while the other pair might be 510 nm to
545 nm. You can set up Ratiometric experiments to use both wavelengths, in which case the
paired banks fire alternately.

Note: Despite the two excitation wavelengths firing alternately, output data files show
time points for each as occurring simultaneously.

Deflectors around the LED banks direct all light from the LEDs through excitation bandpass
filters that further refine the wavelength. The light is then funneled into light pipes that focus it
onto the base of the read plate.

The FLIPR Penta System does not operate without the full complement of LED banks installed.
You can use blank LED banks for one pair if only one excitation wavelength is available. You
can change the LED banks. See Exchanging LED Modules on page 150.

The FLIPR Penta System includes one set of default calcium LED banks (470 nm – 495 nm) and
one set of blank LED banks. Additional LED banks are available for purchase. See FLIPR Penta
Instrument LED and Filter Combinations on page 195.

Use the Protocol Builder Settings screen to configure the LEDs for the experiment. See Setup
Read Mode on page 61.

The system does not require an LED warmup time before you run an experiment. Start time is
only dependent on the time it takes for the camera to cool down and for the stage to heat up.

The LEDs are air-cooled by fans. The light output varies slightly as the LEDs heat up. To help
with the heat transfer, a piece of foam in inserted in the back of the LED bank on each side. To
counteract the temperature change, a temporal correction is applied to the LED feedback
circuit to normalize the system.
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The software applies flat field calibration to the read plate to adjust for non-uniformity of
illumination across the plate. To manually calibrate the system, see Calibrating Optics on page
101.

WARNING! Do not look into LED banks when turned on, especially at intensities over
30% or in the UV spectrum. If you see light escaping the instrument when the LED
modules are turned on, shut the instrument down immediately and call Molecular
Devices Technical Support.

Emission Filters

A three-position filter slide holds up to three 60 mm diameter interference filters and is located
in front of the CCD camera. The slider can be alternated in front of the camera to separate out
the emission band of the dye you use. Use these filters with a single excitation wavelength or
paired up with additional emission filters and LEDs in a ratiometric experiment, for example, as
excitation LEDs alternate between two different wavelengths, filters change at the same time so
each image the camera takes matches the right emission filter with the excitation LED bank. The
most common configuration is a LED excitation wavelength of 470 – 495 nm with a 515 – 575
nm bandpass emission filter. You can run without the filter for luminescence experiments.

You can change the emission LEDs and emission filters. The instrument mechanically senses
the filters you install, and the Instrument Configuration panel displays the filter configuration.
The instrument prompts you to calibrate a new emission filter to correspond to an LED module
when are used in an experiment. See Exchanging Filters on page 154.

Note: You can purchase a custom filter cassette (P/N 5018841) for use with filters created
by an outside vendor. These filters appear in the ScreenWorks Software as Custom 1,
Custom 2 and Custom 3.

Fluorescence Mode

In Fluorescence mode the system LEDs illuminate the bottom of a 96-well, 384-well, or 1536-
well read plate that contains cells loaded with fluorescent dye and measure the fluorescence in
each well. By taking a sequence of measurements in conjunction with compound application,
changes in fluorescence emission characteristics due to the change in ion concentration, for
example, Ca2+, TI+, or Membrane Potential.

Light-emitting diodes (LEDs) produce light at distinct wavelength ranges to excite the
fluorescent dye that you add to the cells in the read plate wells. The instrument illuminates the
entire well plate bottom. Fluorescent light emitted by the dye (for the entire plate) passes
through an emission filter before being captured in a CCD camera, high-speed, high-sensitivity
HS EMCCD or EMCCD. The software measures fluorescence from each well independently and
converts it into a numerical value. You can configure the FLIPR Penta System with two LED
banks and three emission filters to allow the software configuration of up to four
excitation/emission wavelength combinations (read modes). You can measure up to four
different fluorescence effects within a single experiment.
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Luminescence Mode

The FLIPR Penta System provides a Luminescence mode with the HS EMCCD camera option.
The instrument has a light-tight enclosure to operate in Luminescence mode. You can have a
specialized high-sensitivity HS EMCCD camera installed in place of the standard EMCCD
camera to detect signal at both high-speed Fluorescence mode and Aequorin (luminescence)
mode. The camera is mounted directly beneath the read plate, so images are taken of the entire
bottom of the plate. From the 3 filter positions available on FLIPR Penta System, you should
have one open position, so no filter is used during the luminescence assay.

The software measures luminescence from each well independently and converts it into a
numerical value.

Chiller

The chiller sits outside of the FLIPR Penta instrument and connects with a cable and tubing. The
chiller uses a special cooling liquid, and the instrument embedded computer and firmware
controls the chiller.

Because the FLIPR Penta System is a light-tight instrument, there is very limited airflow inside
the instrument enclosure. The chiller provides the operating environment requirements for all
available camera options.
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Chapter 3: ScreenWorks Software Overview

Online Mode vs. Offline Mode

The software has two startup modes:

Online - The software is connected to the instrument.

Offline - The software is disconnected from the instrument.

You determine the default startup mode when you install the software. You must reinstall the
software to change the default startup mode. Regardless of the startup mode, the pipettor head
and tip washer type must always match.

Note: To allow the selection of either mode when you generate protocols, you must
install the software to default to Offline mode.

To switch modes: click the Instrument menu and select either Go Online or Go Offline. This
does not change the default startup mode.

Online Mode

When the ScreenWorks Software starts in Online mode, the software checks for instrument
connections. A message displays if no connections are sensed. Check the connections and
attempt to connect again or select to run the software in Offline mode.

Create new protocols in Online mode.

The software flags the protocols you create in Offline mode with instrument hardware settings
that do not match current instrument hardware. You must change the hardware settings to
match the protocol before you can run the protocol.

When the software starts in Online mode and connects to the instrument, the default installation
configuration file is overwritten using the current instrument settings and plate library
information.

If you work in Online mode and then switch to Offline mode, the instrument setup configuration
is remembered as the last setting.

Offline Mode

When the ScreenWorks Software starts in Offline mode, you can configure the following
hardware options:

Camera Type
Pipettor Format

When the default ScreenWorks Software start is set to Online mode and no instrument
connection registers, a message displays. You can check the connections and attempt to
connect again in Online mode, or you can select to run the software in Offline mode.

3
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User Interface Overview

The ScreenWorks Software main screen includes a menu and a toolbar across the top and a
status bar at the bottom. The main area in the middle has two sections:

Experiment Window - Use the central proportion of the main window to configure protocols,
view data, and perform analysis.
Instrument Status Configuration Process Panel - Use the bottom of the main work area to
view instrument information and create protocols. This panel contains three tabs:
Instrument Status, Instrument Config, and Process described in the following sections.

Item Description

1 Menu Bar

2 Toolbar

3 Experiment Window

4 Instrument Status Configuration Process Panel

5 Status Bar

Main Window Layout
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Menu Bar

The menu bar contains sub-menus that group related functions.

File Menu

Use the File menu to select the following options:

Option Description

New Opens a new protocol (*.fmp) in the Experiment window, with default settings for

one read with fluid transfer.

New protocols are named Untitled[n], where n is a number.

Open Displays the Open File dialog to open a saved protocol (*.fmp), data (*.fmd) or

image (*.png) file. Click the Tools menu and select Set Default Directories to set

the default folder.

Note: Only data files you create with ScreenWorks Software can be opened in

ScreenWorks Software. You cannot open data files from previous

FLIPR Tetra Systems (versions 1.X through 2.X).

Close Closes the active protocol or data file that displays in the Experiment window. If

you modify the file, a message prompts you to save the modifications.

Save Saves the active protocol or data file that displays in the Experiment window. The

Save As dialog displays if the file is a default protocol that is untitled.

Save As Displays the Save As dialog to save a protocol or data file with a new name or

format (for example, save a data file as a protocol). Allows you to save a protocol

or data file as an earlier version of the ScreenWorks Software. Select a file type

from the Save as Type drop-down to change the format.

Save All Files Saves all open protocol and data files. The Save As dialog displays if the default

protocol file is open.

Close All Files Closes all open protocol and data files. The Save As dialog displays if a file

changed or the default protocol file is open.

Export Displays the Export File dialog or the Batch Export dialog to export data from the

open data file, or other data files on the disk. See Exporting Data on page 117.

Page Setup Displays the Page Setup dialog to configure the printer and print settings for the

document.

Print Preview Report Displays how the document looks before you print.

Print Report Displays the Print Report dialog to select the graphs or reports to print. Click Print

Preview Report to display how the document looks before you print or click Print

to print.

1–6 Data Files Displays the six most recently opened data files with the most recently opened at

the top.

7–10 Protocol Files Displays the four most recently opened protocol files with the most recently

opened at the top.

Exit Closes the ScreenWorks Software.

File Menu Options
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Saving Data Files as Protocol Files

When the active file is a protocol file, you can add, remove, or change processes in the file, then
save the protocol and run it. You cannot edit the protocol information stored in data files nor
used to run a new experiment, however you can extract this information to a new protocol file.
Experiments run using this file have exactly the same steps as the steps used to create the data
file.

To store a data file as a protocol file, click Save As, enter the protocol name, select *.fmp as the
File Type, and click Save. The software strips all data the file and stores the protocol
information.

Note: Saved changes only affect the protocol. The data file from which the protocol was
derived remains intact.

View Menu

Use the View menu to select the following options:

Option Description

Experiment Setup Displays the Experiment Setup view of a protocol or data file that includes

the processes and associated dialogs in the Experiment window.

Experiment Summary Displays the Experiment Summary for the current protocol or data file in

the Experiment window.

To return to the Experiment Setup view, click the View menu and select

Experiment Setup.

Save Layout Saves the proportions that display in the Experiment window including;

Multi-Well graphs, Detail graphs, Group Statistics window, and Instrument

Status panel to one of four layouts. Click Restore Layout to toggle

between the layout.

Restore Layout Restores the screen layout to one of four layouts you save.

Instrument Status Toggles the Instrument Status panel in and out of view. See Instrument

Status on page 56.

Toolbar Toggles the Toolbar in and out of view. See Toolbar on page 52.

Status Bar Toggles the Status Bar at the bottom of the main window in and out of

view. See Status Bar on page 59.

View Menu Options
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Instrument Menu

Use the Instrument menu to access instrument communication and manual dialogs.

Option Description

Go Online/Offline Select Go Online to change to Online where you can connect the software

to the instrument and give the ScreenWorks Software control of the

instrument.

Select Go Offline to change to Offline mode and disconnect the software

from the instrument.

Run Experiment Starts the experiment that uses the uppermost protocol file in the

experiment.

Stop Experiment Stops the experiment. Only use in emergencies to halt an experiment. An

instrument reset may be required.

Manual Operation has the following sub-menu that control hardware operations. A command is not

available when the associated hardware is not installed.

Load Tips Instructs the pipettor to load tips or pin tool from the stage Position 1.

Unload Tips Instructs the pipettor to unload tips or pin tool to the stage Position 1.

Unload tips to a tip rack, otherwise, make sure there is a container at stage

Position 1 to receive tips.

Wash Tips Displays the Wash Tips dialog to configure how the pipettor is to wash tips

or pin tool.

Drain Wash Basin Drains the wash basin to the waste bottles when there is an instrument

error.

Yellow Plate Signal Test Coordinates the read of the stage Position 3 read plate for the protocol

and displays the numerical results in the Signal Test dialog. See Signal

Test Dialog on page 45.

Protocol Signal Test Coordinates the read of the stage Position 3 read plate and displays the

numerical results in the Signal Test dialog. Instrument settings can be

saved to the open protocol. See Signal Test Dialog on page 45.

Change Head Instructs the pipettor head to move over stage Position 3 to exchange to a

new head format. See Exchanging Pipettor or Pin Tool Head on page 140.

Cycle Camera

Temperature

Cycles the camera temperature to run a low-fluorescence or luminescence

experiment immediately after you run a high-fluorescence experiment.

The temperature cycle runs for about 15 minutes, warms to room

temperature, 20°C to 25°C (68°F to 77°F), and then cools to operating

temperature:

EMCCD camera: -70°C (-94°F) ± 2°C

HS EMCCD camera: -70°C (-94°F) ± 2°C

Temperature Control Turns heat on and off for stage source plate Positions 1, 2, and 3, and

allows you to enter the temperature.

Cell Flask Stirring Control Sets the stir speed rate for the cell flask.

Instrument Menu Commands



FLIPR Penta High Throughput Cellular Screening System User Guide

44 5069582 G

Option Description

Additional Instrument Menu Commands

Set Remote/ Manual Mode Select Set Remote Mode to integrate a third-party robotic system with the

FLIPR Penta System. The ScreenWorks Software goes into Remote Mode

when you use SynchroMax Automation. See Robotic Integration on page

203.

Select Set Manual Mode to switch instrument communication to the

ScreenWorks Software and prevent robotic system control.

SynchroMax Automation Displays the SynchroMax dialog to configure plate handling with the

SynchroMax ET. See SynchroMax Automation on page 47.

Reset Reinitializes the system to clear any fatal errors that display in red at the

bottom of the Instrument Status panel.

Clear Error Clears minor system errors that display in yellow in the Instrument Status

panel. See Instrument Status Colors on page 159.

Calibration Displays the Calibration dialog where you do flat field calibrations. See

Calibrating Optics on page 101.

Refresh Configuration Refreshes the instrument configuration after you change hardware

settings.

Instrument Menu Commands (continued)
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Signal Test Dialog

The signal test has two functions:

Check the state of the overall system: This test is run using the yellow test plate with the
plate format for the assay. Open the dialog with the Yellow Plate Signal Test option in the
main menu. The table below outlines the default settings to use when you perform the
yellow plate signal test. These settings cannot be saved in the protocol for later use.
Check initial fluorescence of a plate before you run an assay: This test is run to evaluate the
assay plate before you run an experiment. Open the dialog with the Protocol Signal Test
option in the main menu. The table below outlines the settings that reflect the Normal
camera mode and default to the settings in the open protocol when you run the protocol
signal test. These settings can be saved in the protocol for later use.

Option Description

Select Plate Select the plate type.

Excitation/Emission

Wavelength

Select the excitation/emission wavelength pair for the signal test. Only calibrated

excitation/emission wavelength pairs display in the list.

Reading Mode Select Fluorescence or Luminescence.

Camera Gain Select the camera gain for the signal test.

For the 470–495/515–575 nm excitation/emission pair with a yellow test plate:

* Standard EMCCD Camera - 50

* HS EMCCD camera - 8 for Camera Mode Normal, 20 for Camera Mode High-

Speed

Camera Mode In Read Mode > Florescence: Normal, Sensitivity, and High-Speed for the

HS EMCCD camera only

In Read Mode > Luminescence: Normal and Sensitivity

Excitation Intensity Select the LED intensity for the signal test.

Excitation intensity scales as a percentage of the total LED output (0–100%).

For the 470–495/515–575 nm excitation/emission pair with a yellow test plate:

* Standard EMCCD Camera - 80

* HS EMCCD camera - 50

Exposure Time Enter the amount of time (in seconds) to keep the camera shutter open during the

Signal Test.

For the 470–495/515–575 nm excitation/emission pair with a yellow test plate:

* Standard EMCCD Camera - 0.4

* HS EMCCD camera - 0.005

Highlight Range Highlights well values that lie within the set statistical range. Use the slider to set

the statistical range.

Wells Above Range Displays the number of wells above the statistical range as determined by the

Highlight Range.

Wells Below Range Displays the number of wells below the statistical range determined by the

Highlight Range.

Maximum Displays the largest value on the signal test plate.

Yellow Plate Signal Test and Protocol Signal Test Setting Options
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Option Description

Average Displays the average value on the signal test plate.

Minimum Displays the smallest value on the signal test plate.

Std. Dev Displays the standard deviation of the signal test plate.

Test Signal Initiates a new signal test.

Save Saves the signal test as an ASCII text file (*.sig).

Print Prints the signal test.

Image Viewer Displays the CCD image that shows where relative fluorescence units (RFU)

values derived for the signal test.

Show > Hide Mask - Shows or hides the mask used in the test to indicate the pixel

area used to derive the RLU value for each well.

View Image - Refreshes signal test image.

Diagnostics For Technical Support only.

Yellow Plate Signal Test and Protocol Signal Test Setting Options (continued)

For procedures, see Signal Tests on page 104.
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SynchroMax Automation

Note: Molecular Devices no longer offers the SynchroMax ET external plate handler
robot. The following information is for reference only.

The SynchroMax™ Automation option is available when you install a SynchroMax ET external
plate handler.

When you access the SynchroMax dialog from Instrument > SynchroMax Automation, the
ScreenWorks Software goes into Remote mode and the SynchroMax ET software controls the
instrument. The ScreenWorks Software returns to Manual mode when you close the
SynchroMax dialog.

To run a series of experiments with the SynchroMax ET plate handler, first open the protocol file
to use in the ScreenWorks Software. Only one protocol is used in a run for as many times as the
SynchroMax ET plate handler delivers plates.

Prepare the protocol, then open the SynchroMax dialog, and then select a Stack Layout
Template. Stack Layout Template files specify, for each plate location in the five-position stage,
how many plates load to that position, from which stack, and where they move after use. A
number of Stack Layout Templates are included in the software.

When you open a Stack Layout Template, the graphic in the dialog displays on which stacks the
plates load. Use this as a guide to load the plates. All plates in a single stack should be the same
type.

If any stage positions use the same plate throughout the duration of the run, you should
manually load the stage positions before you begin the run. Stage positions that have plates
brought to them during the run must be empty at the start of the run.

Before you click Run, make sure all output racks are empty before you run the experiment.
When plates are in position and the FLIPR Penta System is ready, click Run in the SynchroMax
dialog. After the instrument checks that the plate configuration is compatible with the protocol
settings, the instrument runs until all plates are used. The Run button changes to Stop so you
can stop the run before it completes.

Note: Use Stop only in emergencies to halt an experiment. An instrument reset may be
required.

When the SynchroMax ET plate handler is active, the system clears all plates at the end of an
experiment. The SynchroMax plate handler remembers only the plates it loads during the
experiment and checks if any of those plates remain when the experiment completes. Plates
are removed when they remain. You can use a reagent reservoir in a source position within the
FLIPR Penta System as long as you load it manually and the SynchroMax template does not
include the loading or removal of plates to that position.
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Tools Menu

Use the Tools menu to select the following options:

Option Description

Set Default Directories Displays the Set Default Directories dialog to designate directories in

which to store protocol and data files, signal tests, group templates and to

which export files are written.

The Open > Protocol, Data, and Image File commands in the File menu

open to the default folder you set here, as do the File > Export dialogs.

Group templates *.fmg export and import from the default folder.

The default protocol directory is: C:\Documents and Settings\[your_user_

name]\My Documents\Molecular Devices\ScreenWorks\MyProtocols

[MyData, MySignalTests, or MyGroupTemplates]

The default data and export directories are: C:\Documents and Settings\

[your_user_name]\My Documents\Molecular

Devices\ScreenWorks\MyData \

The default signal test directory is: C:\Documents and Settings\[your_

user_name]\My Documents\Molecular

Devices\ScreenWorks\MySignalTests

The default group template directory is: C:\Documents and Settings\[your_

user_name]\My Documents\Molecular

Devices\ScreenWorks\MyGroupTemplates

Note: Save all protocol and data files on the local hard drive to ensure

instrument function or data is not lost if the server fails during an

experiment.

Plate Library Displays the Plate Process Definition dialog that lists current plate

definitions and allows you to add plate definitions to the system. See Plate

Process Definition on page 49.

Open Error Log Displays an error log generated by the FLIPR Penta System. This is for

technical support and requires a password.

Save Error Log Saves error logs. Logs save as *.fel (FLIPR Penta System error log)

encrypted files to forward to Molecular Devices Technical Support.

Assay Log Displays a dialog that reports when the protocol steps were applied. For

data files only.

Tools Menu Options
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Plate Process Definition

The Plate Process Definition dialog lists the plates in the system. Click the Tools menu and
select Plate Library. Plates are categorized first into read plates and source plates and then by
well-number format. The Plate Library is camera specific. If you add plates with one camera
type, they are unavailable after you change the camera type.

The Plate Process Definition dialog is accessible only to administrators and is password
protected. The default username is fliprtetra and password is flipr.

The software includes the following plates:

Default 96
Default 96 small volume
Default 96 no slit mask
Default 96 boat
Default 384
Default 384 small volume 5X3 mask
Default 384 small volume 3X3 mask
Default 384 boat
Default 384 blot
Default 1536
Default 1536 boat
Default 1536 blot

Option Description

Close Closes the Plate Process Definition dialog.

Open Plate Displays the Define Basic Plate Parameters dialog for the plate you select.

Copy Plate Displays the Define Basic Plate Parameters dialog to add a new plate.

Note: When you copy a plate, select a plate with a similar well format, as

the number of wells and plate mask transfer to the new plate.

Delete Plate Deletes the plate that displays in the Plate Process Definition field.

Collapse All Collapses the Plate Process Definition tree.

Expand All Displays all plates in the Plate Process Definition tree.

Plate Process Definition Options
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Define Basic Plate Parameters

Click Open Plate or Copy Plate in the Plate Process Definition dialog to define the plate
dimensions. You cannot modify the dimensions of the default plates, but you can realign the
plate mask.

Option Description

Plate Name Enter the plate name (maximum 50 characters).

Plate Type Select Source Plate to create a plate that does not include a plate mask.

These plates are used for compound storage.

Select Read Plate to create plates that are read in the read position and

require a plate mask.

Plate Specifications Refer to the diagram in the upper right corner of the dialog and for best

results, obtain the plate dimensions from the plate manufacturer. See

FLIPR Penta Plate Dimensions on page 189.

Note: Molecular Devices is not responsible for instrument malfunctions if

plate specifications are not correct.

Rows - Enter the number of rows on the plate.

Columns - Enter the number of columns on the plate.

Well Shape - Select the shape of the well.

Well Volume (µL) - Enter the maximum well volume in microliters.

X (mm) - Enter the distance (in mm) from the left side of the plate to the

center of well A1.

Y (mm) - Enter the distance (in mm) from the top of the plate to the center

of well A1.

Bottom (mm) - Enter the distance (in mm) from the bottom of the plate skirt

to the inside of the well.

Top (mm) - Enter the distance (in mm) from the bottom of the plate skirt to

the top of the well.

Well Offset (mm) - Enter the distance (in mm) from the center of one well to

the center of adjacent well.

Define Basic Plate Parameters Options

Define Camera Parameters

The Finish button is available for the Read plate type. Before you click Finish, place a read plate
with 10-8 M fluorescein in the read position. When you select this plate, the instrument reads the
plate and defines a plate mask for the plate definition. If the plate is in position and the
instrument cannot define a mask, the plate definition is saved as a source plate.
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Window Menu

The Window menu options allow you to change the way you view the Experiment window.

Option Description

Cascade Aligns the open windows so that they overlap and stagger with the title bars

visible.

Tile Divides the screen into as many segments as there are windows and aligns

them so that they display side-by-side. Each file occupies a segment and is

visible. Each file image scales according to the number of files that display.

1–10 Data Files Lists the open files (up to 10)

Window Menu Options

Help Menu

The Help menu provide access to user guides and information about the software.

Option Description

FLIPR Penta System User Guide (PDF) Displays a .pdf version of this manual.

Release Notes (PDF) Displays the ScreenWorks Software Release Notes.

Protocol Guide (PDF) Displays a guide that provides detailed information,

procedures, and optimization guidelines to run common types

of experiments.

Software License Displays the Software License dialog for the ScreenWorks Peak

Pro Software activation.

Contact Us Displays the Molecular Devices website.

About ScreenWorks Displays the About ScreenWorks dialog with the software

version number, the Firmware EC, Firmware Motion, and

Remote Interface.

Help Menu Options
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Toolbar

The toolbar provides shortcuts for main menu commands. To hide or display the toolbar, click
the View menu and select Toolbar. See Menu Bar on page 41.

Icon Name Description

New

Document

Opens a new protocol file (*.fmp) with default settings for an assay with a

single read with fluid transfer.

Files are named Untitled[n] where n is a number.

Open Protocol

File

Displays the Open File dialog to open protocol (*.fmp) files.

Open Data

File

Displays the Open File dialog to open data (*.fmd) or image files.

Save File Displays the Save File dialog to save the current file.

Export File Displays the Export File dialog to export the current file.

Print Displays the Print dialog.

Experiment

Summary

Displays the process steps and correction for the current protocol or data

file. This button toggles with Experiment Setup.

Experiment

Setup

Displays the Experiment Setup window to edit the current protocol or

analyze data in a data file. This button toggles with Experiment Summary.

Help Displays help documentation.

Stop Stops the current experiment.

Run Starts the protocol.

SynchroMax

Automation

Displays the SynchroMax Automation window to select the template to run

the SynchroMax ET plate handler.

Online Mode Displays when System Control is in Offline mode. Click to connect to the

instrument and go into Online mode. This button toggles with Offline

Mode.

Offline Mode Displays when the ScreenWorks Software is in Online mode. Click to

disconnect from the instrument and go into Offline mode. This button

toggles with Online Mode.

Toolbar Icons
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Icon Name Description

Remote Mode Instructs the ScreenWorks Software to disable the manual connection and

to receive Remote commands from a third-party robot. This button toggles

with Manual Mode.

Manual Mode Instructs the ScreenWorks Software to disable the remote connection and

to receive manual commands from the ScreenWorks Software user

interface. This button toggles with Remote Mode.

Calibration Displays the Calibration dialog to set flat field calibrations.

Yellow Plate

Signal Test

Displays the Yellow Plate Signal Test dialog to view the numerical results

using the yellow plate.

Protocol

Signal Test

Displays the Protocol Signal Test dialog to view the numerical results

before you run an experiment. You can save the settings in the signal test

to a protocol file.

Set Spinner

Flask Stirring

Rate

Displays the Spinner Flask Control dialog to set the stirring rate.

Set Stage

Temperature

Displays the Set Temperature dialog to set the stage temperature in

degrees Centigrade.

Restore

Layout 1

Changes the Experiment window layout to the layout 1 you define in the

View menu.

Restore

Layout 2

Changes the Experiment window layout to the layout 2.

Restore

Layout 3

Changes the Experiment window layout to the layout 3.

Restore

Layout 4

Changes the Experiment window layout to the layout 4.

Toolbar Icons (continued)
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Experiment Window

The Experiment window is the main area in the ScreenWorks Software. The Experiment window
can have one protocol file and multiple data files open simultaneously. Select a file pane to
make it active. Use the options in the Windows menu to view the file panes individually,
cascaded, or tiled. See Window Menu on page 51.

Experiment Setup

The ScreenWorks Software opens the View > Experiment Setup screen in the Experiment
window, by default.

A new protocol file displays as a tab named Untitled1 that contains four default processes. Use
the default protocol file to create a new protocol file. Close or ignore the default file to work with
an existing protocol file or data file. See Understanding Processes on page 60.

Protocol (*.fmp) and data (*.fmd) files display the process steps to use at the top of the window,
sequenced from left to right. Click the process icons to open the Settings dialog. A data file is a
protocol file that also includes acquired data in the Analysis process dialog.
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Experiment Summary

The Experiment Summary page is a text-based protocol summary.

To display the Experiment Summary page, click the View menu and select Experiment
Summary.

Instrument Status Configuration Process

The Instrument Status Configuration Process panel opens and docks to the bottom of the main
screen, by default. See User Interface Overview on page 40.

To undock and relocate the panel, drag the title bar on the left of the panel to where you want it.

Do one of the following to hide the panel:

Click the X in the title bar.
Click the View menu and select Instrument Status.

To show the panel when hidden, select the View menu and select Instrument Status.
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Instrument Status

Use the Instrument Status tab to view the status of the system hardware components.

Option Description

Stage Temp (°C) Displays the stage temperature.

Set Point Displays the stage temperature setting.

Stage Status Displays whether the heated stage is turned on or off.

Camera Temp (°C) Displays the camera temperature. Operating temperature for the camera depends

on the camera.

EMCCD camera: -70°C (-94°F) ± 2°C

HS EMCCD camera: -70°C (-94°F) ± 2°C

Camera Status Indicates whether the camera is turned on or off.

Chiller status Indicates whether the chiller is available or not.

Pipettor Tips Indicates when tips are loaded on the pipettor head.

Upper Door (Inner) Indicates whether the inner-upper door is open or closed.

Note: The system runs as long as the inner door is closed. Data may not be valid if

the outer door is open.

Upper Door (Outer) Indicates whether the outer-upper door is open or closed.

Lower Door Indicates whether the lower door is open or closed.

Tip Washer Indicates the status of the tip washer.

Chiller Temp (°C) Displays the temperature in the chiller.

Read Plate Indicates when a plate is present in position 3 (read plate position).

Source Plate 1 Indicates when a plate is present in position 1 (source plate 1 or tip loading

position).

Source Plate 2 Indicates when a plate is present in position 2 (source plate 2).

Source Plate 3 Indicates when a plate is present in position 4 (source plate 3).

Chiller Setpoint (°C) Displays the set point from the chiller.

Fill Bottle A Indicates when bottle A is empty of wash solution.

Fill Bottle B Indicates when bottle B is empty of wash solution.

Waste Bottle A Indicates when waste bottle A is full.

Waste Bottle B Indicates when waste bottle B is full.

Instrument Status Options
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Option Description

Cell Flask Displays the last known state of the stir cell flask. At start the state is Unknown

until you use the cell flask.

Cell flask rate Displays the stir rate of the cell flask.

Fluid 1 Displays the last known state of the fluid 1 bottle. At the start the status is Unknown

until the fluid is used.

Fluid 2 Displays the last known state of the fluid 2 bottle.

Fluid 3 Displays the last known state of the fluid 3 bottle.

Fluid 4 Displays the last known state of the fluid 4 bottle.

Intensifier Indicates if the intensifier is installed or not installed.

Mode Indicates if the software is in Manual mode or Remote mode.

Instrument Status Options (continued)

Identify Connection Status

The connection status displays in the bottom-right corner of the panel to report the connection
status between the ScreenWorks Software and the instrument. Green means online
(connected) and black means offline (disconnected). See Instrument Status Colors on page 159.

Instrument Status Tab Panel with Offline Status Indicator

View Messages and Faults

To view status messages and faults click next to the connection status icon to display the
Instrument Status History dialog that lists the last one thousand messages.

Tip: Copy the text to the computer clipboard to paste elsewhere.
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Instrument Configuration

Use the Instrument Configuration tab to view the configuration of the LED banks, emission
filters, pipettor head, and optional FLIPR Cycler.

When the system is Offline, you can configure these settings to define protocols. For camera
type details, see the CCD Camera Options section of the FLIPR Penta High-Throughput Cellular
Screening System User Guide. See Online Mode vs. Offline Mode on page 39.

CAUTION! If you create a protocol offline that does not match the instrument
configuration, when you open the protocol online, the protocol does not run until the
configuration of the protocol and instrument match.

Option Description

Excitation Wavelengths Upper LEDs - Displays the wavelength range of the top set of LED banks in

the LED modules.

Lower LEDs - Displays the wavelength range of the lower set of LED banks in

the LED modules.

Emission Wavelengths Displays the emission filter wavelengths installed on the system. You can

install up to three filters.

Pipettor Displays the pipettor head type (96, 384, 1536, 384 pin tool, or 1536 pin tool)

installed in the system.

Note: The pipettor head format must agree with the tip wash reservoir format.

A message displays if these are different.

Tip Washer Displays the tip washer type (96, 384, or 1536) installed in the system.

Camera Type Select from EMCCD or HS EMCCD.

Chiller Indicates when a chiller is installed.

FLIPR Cycler Indicates when the FLIPR Cycler is installed.

Barcode Reader Indicates when a barcode reader is installed.

Instrument Configuration Options
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Process Tab

Use the Process tab to create new protocols and edit existing protocols.

The Process tab displays processes that you can incorporate into experiment protocols. See
Using Protocols on page 60. The color of the process icon depends on the function in the
protocol. See Protocol Process Icon Colors on page 59.

The list of processes is dependent upon the instrument configuration. For example, different
processes appear when the instrument uses a pin tool instead of a pipettor. See Understanding
Processes on page 60.

Protocol Process Icon Colors

Green - Indicates the process is required to run an experiment and cannot be deleted.
Blue - Indicates the process involves liquid handling. The steps run in series with each other
and never run simultaneously.
Orange - Indicates the process runs simultaneously with any liquid handling process.
Purple - Indicates linked processes that are connected to the Transfer Fluid process, for
example Mix with TF and Read with TF.

Status Bar

The status bar, across the bottom of the main window provides tool tips for commands in the
main menu. When you open a menu from the menu bar and place the cursor over a command, a
description of the command displays in the status bar.

To hide or display the status bar, click the View menu and select Status Bar.
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Using Protocols

The protocols you create determine how the system functions while you run an experiment.
Protocols consist of a series of process configurations. As you create the protocol, you define
each process. See Creating New Protocols on page 96. Process options are located on the
Process tab in the Instrument Status Configuration Process panel. See Process Tab on page 59.

Tip: Refer to the FLIPR Penta High-Throughput Cellular Screening System Protocol
Guide for specific assay protocols.

To save a data file as a protocol file, see Saving Data Files as Protocol Files on page 99.

Understanding Processes

The following sections explain how to use the process options.

Settings Process

Settings is the first process in all protocols. Use settings to define the read mode, plate position,
data directory, automatic file naming, and plate temperature.

Click Settings in the Experiment window to display the Settings page.
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Setup Read Mode

Use the Setup Read Mode table on the Settings page to display settings for up to four read
modes that can run in a single experiment.

Each read mode displays:

Read Mode
Excitation and Emission Wavelength
Excitation Intensity
Camera Mode (EMCCD camera and HS EMCCD camera)
Exposure Time
Camera Gain
Auto Stabilize (HS EMCCD camera only)

For protocols that use multiple read modes, the instrument alternates between the read modes
for each time point and outputs distinct sets of reads, one for each mode. The software
calculates the ratio of the reads from each mode for each time point.

Protocol files that use read modes not supported by the instrument configuration display in red.

In the Setup Read Mode table:

Select the check box for each read mode to use.
Clear the check box for each read mode to not use.

Edit Read Mode

To edit read mode settings:

1. Select a Read Mode Name row and click Edit Mode or double-click a Read Mode Name
row to display the Edit Read Mode dialog.

2. Change the following settings, then click OK to finish.

Note: Available options depend on the camera installed in the instrument.
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Option Description

Read Mode Name Enter the read mode name.

Reading Mode Select Fluorescence or Luminescence.

Excitation/Emission

Wavelength

Select the excitation LED and emission filter wavelength pair.

Select NONE to not turn on the LEDs or to use an empty emission filter position.

These are used in luminescence experiments. Note: Only calibrated wavelength

pairs display when the software is in Online mode. See Calibrating the Optics on

page 101.

Excitation Intensity Select the value to regulate the intensity of light emitted by the LEDs for a

Fluorescence read. The range is 20% to 100%.

Camera Mode Select the High-Speed, Sensitivity, or Normal camera mode.

Note: Available with the HS EMCCD camera. See Understanding

HS EMCCD Camera Protocol Saturation on page 32.

Exposure Time Enter the time to regulate the light that the camera collects and measures. A

longer exposure increases signal intensity.

Exposure time affects the read interval for data collection. For example, in

Camera mode Normal, an exposure time of 0.4 seconds added to a required 0.1

second camera integration time makes the highest update frequency 0.5

seconds.

Depending on the camera, the range is 0.01 second to 30 seconds. For example,

the range for the HS EMCCD camera in Camera mode High-Speed is 0.001

second to 30 seconds.

Camera Gain Select the value to regulate the amplification of the camera power. Increase the

camera gain to increase the signal.

Ranges depend on the camera in use:

* EMCCD camera: 1–240

* HS EMCCD camera: Read mode Fluorescence: Camera mode Normal: 1-128 or

Camera mode High-Speed or Sensitivity: 20-128. Luminescence mode: 1–500

Auto Stabilize Automatically adjusts the camera for 50 seconds for optimal functionality before

the protocol starts.

Note: Available with the HS EMCCD camera. See Stabilizing the HS EMCCD

Camera on page 31.

Edit Read Mode Options

Note: Differences in camera gain or exposure time between read modes significantly
increase the minimum update time. For fastest update time, use the same gain and
exposure time for all read modes.
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Assign Plate to Position

Current plate assignments display in the Assign Plate to Position table. The pipettor head must
have a plate type assignment for each of the positions to use in the experiment.

Click Edit Plate to change plate settings.

For each plate position:

Plate Name - The type of plate from the Plate Library.
Bar Code Expect - Does the system to read a bar code from the plate. Bar code numbers
can be incorporated into output data file names.
Bar Code List - The bar codes on the plates in the experiment, in the given plate position
(data files only).

If you use position 1 only for tips and to not hold a source plate, select the Load Tips Position
check box. This removes Source Plate 1 from the assignment table.

Edit Plate

To change a plate position assignment:

1. Select a Position row and click Edit Plate or double-click a Position row to display the
Change Plate dialog.

2. Change the following settings and then click OK.
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Option Descriptions

Position Displays the plate position to edit.

Plate Name Select the plate type from the list of default plates and the plates you add

to the Plate Library.

Note: Only plates with the same number of wells or one order of

complexity higher than the pipettor head format display.

Bar Code Expected Select this check box to use a bar code for the plate. You can include the

bar code number in the data file name that the protocol generates.

In Manual mode, the software prompts you to enter the bar codes before

you start the experiment.

In Remote mode, the FLIPR Cycler automatically scans the barcode on the

landing pad, or the third-party plate handler passes it to the ScreenWorks

Software.

Cell Flask Spinning Rate Enter the spin rate.

Change Plate Options

Note: Each plate position has a mechanical sensor to detect the presence of a plate, tip
rack, or boat in each position. The instrument does not distinguish the type of apparatus
you place in a position.

Data File Name

Use the Data File Name options to configure a file naming protocol for the data files the
experiment creates. The file naming protocol applies to *.fmd (data) and *.png (image) files.

Option Description

Include Date Select this check box to include the date in the file name.

Note: Select this check box to ensure that data files are not overwritten.

Include Bar Code Select this check box to include the bar codes of the first five plates in the

experiment in the file names. If there are fewer than five bar codes, then only

those are used.

Note: You must also select the Bar Code Expected check box for the plate

position to incorporate the bar code.

User Defined Name Enter the file name (up to 25 characters).

Date File Name Options
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The base structure for file names is as follows:

Date_UserDefinedName_Barcode1_Barcode2_Barcode3_Barcode4_ Barcode5_NNN.fmd

where NNN is an integer from 1 to 999. The integer value NNN starts at 001 and increments for
each data file generated with the same base data file name.

The date uses format: MMDDYYYY, where M = month, D = day, and Y = year.

If a software error occurs during a run that interferes with normal instrument operation the data
file is stored as:

InterruptedExperiment_Date_Time_NNN.fmd

Folders

Use the Folders fields to define the directories to save the data and export files.

Click Change to select a different directory.
Click Open Folder to display the Windows Explorer dialog with the directory you designate.

Data, image, and export files save in the following location by default:

C:\Documents and Settings\[your user name]\My Documents\Molecular
Devices\ScreenWorks\MyData\

Temperature Control

Use the Temperature Control field to set the plate stage heaters to the temperature for the
experiment. Temperature range is from ambient 25°C (77°F) to 40°C (104°F).

Select the Use Manual check box to control the heaters manually when the experiment runs.

When the experiment starts, a message displays if the stage temperature is different from the
value you set. Wait until the stage reaches the temperature or run the experiment anyway.

Note: When you manually turn the temperature on through the Instrument menu, a
setting of “0” in the protocol does not affect the temperature setting. To turn off the
temperature manually, click the Instrument menu and select Manual Operations and
then select Temperature Control Off.

Analysis Process

The Analysis process is included in all protocols and is always the second process after
Settings.

Viewing Data

View acquired data in the ScreenWorks Software on the main Analysis process page in the
Multi-Well graph or in the larger Detail graph.
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Multi-Well Graph

The Analysis process page displays a grid that represents the wells of the read plate you use in
the protocol or data file in the Multi-Well graph. This graph is empty for protocol files because
no data is acquired. For data files each cell displays a trace of one of the measurements taken
from the corresponding read plate well. The maximum and minimum relative light units value of
the display data displays above the Multi-Well graph.

The Multi-Well graph displays one trace of relative light units versus time for each well. If the
software records two or more read modes, select the mode to view from the display list above
the graph. To see the ratio of two read modes, activate Ratiometric Options in the Configure
Corrections > Corrections dialog, and select Ratio in the list.

The software applies the read mode you define in the Multi-Well graph to any traces that display
in the Detail graph.

Use the Corrections dialog to adjust the traces that display in the Multi-Well graph. You can
scale the traces relative to the average positive control response. See Corrections on page 75.

If you define groups for the assay, the Multi-Well graph color-codes the wells to represent each
group. See Grouping on page 72.

You can include the kinetic reduction value below each well trace in the Multi-Well graph.

Use the icons above the Multi-Well graph to access various data analysis options; some
relevant to protocol set up, some to already-acquired data in data files, and some to both.

Icon Name Description

Configure Groups Displays the Grouping dialog to classify wells in the plate into groups.

Groups in protocol files transfer to the data files the protocol generates.

In data files, you can create new groups or edit existing groups. See

Grouping on page 72.

Select Groups Displays the Select Groups dialog to classify which groups display in the

Detail graph based on the groups you define in the Grouping dialog.

Note: Shift + Click or Ctrl + Click to multi-select.

Group Selection

Mode

Group Selection mode displays the wells you select within a group in the

Multi-Well graph in the Detail graph. Toggles between Group Selection

Mode and Well Selection Mode.

Well Selection

Mode

Well Selection mode displays only wells you select in the Multi-Well

graph on the Detail graph with the assigned group colors. Toggles

between Group Selection Mode and Well Selection Mode.

Notes Displays the Notes dialog. For protocol files, enter the comments to

store with the data files that the protocol generates. For data files, view

the comments (now read-only).

Images Displays the images for data files when images save in an experiment.

Copy Copies data in the Multi-Well graph to the computer clipboard to paste

into a different software application.

Multi-Well Graph Icons



Chapter 3: ScreenWorks Software Overview

5069582 G 67

Icon Name Description

Configure Auto-

Export

For protocol files, displays the Auto-Export dialog to configure the

statistics and time sequence files to automatically create whenever the

protocol runs. This button also exports the data after data file creation.

For data files the button changes to Export and displays the File Export

dialog. See Exporting Data on page 117.

Configure

Correction

Displays the Corrections dialog to apply corrections that modify the data

display or to view ratiometric data. Settings made to protocol files affect

how data displays when the protocol runs, but since all raw data stores

in data files, these options remain available for acquired data. See

Corrections on page 75.

Hide Kinetic

Reduction Value

Hides the kinetic reduction values that display in the Multi-Well graph.

Show Kinetic

Reduction Value

Displays the kinetic reduction value in each well of the Multi-Well graph.

Configure Kinetic

Reduction

Displays the Kinetic Reduction Configuration dialog to define the kinetic

reduction parameters.

Reduction Type - Select the reduction for the kinetic data traces in the

Multi-Well graph.

Start Read - Select the first read to use to determine the kinetic

reduction.

End Read - Select the last read to use to determine the kinetic

reduction.

Read Mode - Select the read mode for the kinetic reduction.

Multi-Well Graph Icons (continued)

Kinetic Reduction Types

The options in the Reduction Type field in the Kinetic Reduction Configuration dialog depend
on the software version. A separate license for the ScreenWorks® Peak Pro™ Software adds
advanced peak detection and characterization measurements to the field of standard
measurement options. This functionality is optimal for relatively fast events that are acquired
with long sampling intervals. Contact your Molecular Devices Sales Representative for details.

CAUTION! High-speed camera data is not compatible with Peak Pro 1.0. You must use
the ScreenWorks Peak Pro Software version 2.0 for the high-speed camera data
analysis. See ScreenWorks Peak Pro Software Version 2.0 on page 123.
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Standard measurement options:

Average - Numerical average of relative light units counts of the reads.
Sum - Numerical sum of relative light units counts of the reads.
Minimum - Lowest detected count (a single number) of the reads.
Maximum - Highest detected count (a single number) of the reads.
Maximum-Minimum - Result of subtracting the minimum count (a single number) from the
maximum count (a single number).
Area Under Curve - Numerical calculation of the area under the curve for the reads.
Slope of Curve - Result of calculating the slope between two reads.

The ScreenWorks Peak Pro Software version 1.0 measurement options and definitions include
(requires optional license):

Peak Count - Number of peaks or action potentials detected within the read data that meet
the specifications in the Configure Peak Detection dialog settings.
Peak Frequency (BPM) - The beats per minute frequency of the peaks detected based on
the inverse of the peak temporal spacing. At least two peaks are required for this
measurement.
Average Peak Width - Average peak width measurement in seconds from the 50% peak
amplitude from baseline.
Peak Width Standard Deviation - Standard deviation of average peak widths.
Average Peak Amplitude - The average peak amplitude relative to the Average Peak
Baseline measurement.
Peak Amplitude Standard Deviation - Standard deviation of peak amplitudes.
Average Peak Baseline - Average baseline amplitude measurement from the base of each
peak detected.
Average Peak Spacing - Average peak spacing in seconds. At least two peaks are required
for this measurement.
Peak Spacing Standard Deviation - Standard deviation of peak spacing.
Average Peak Rise Time - Average time measured on the rising edge for each peak. Equal
to the time between the 10% and 90% peak amplitudes.
Rise Time Standard Deviation - Standard deviation of rise times.
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Average Peak Decay Time - Average time measured on the falling edge for each peak.
Equal to the time between the 90% and 10% peak amplitudes.
Peak Decay Time Standard Deviation - Standard deviation of decay times.
Average Peak Width at 10% Amplitude - Average peak width in seconds at the 10% peak
amplitude from baseline.
Irregular Spacing - Identifies wells that have irregular spacing between peaks. Wells with
regular peak temporal spacings display OK. Wells with missing peaks display MISS. Wells
with extra peaks display EXTRA. Wells with peak spacing characteristics of both missing
and extra display IRREG.

The Configure Peak Detection button is available when you select a Peak Pro measurement in
the Reduction Type field. Use the Configure Peak Detection dialog to adjust and optimize the
Peak Pro measurement settings.

Configure Peak Detection dialog options:

Smooth Width - Running average to reduce noise (between 5 to 10).
Fit Width - Number of data points that are fit for each peak (between 5 to 15).
Slope Threshold - Distinguishes between cardio beats and noise (set to 0.001).
Amplitude Threshold Dynamic - Value setting is relative to the data average.
Amplitude Threshold Fixed - Value setting is relative to zero.
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Detail Graph

The read modes for the wells you select in the Multi-Well graph can display enlarged in a Detail
graph. You can select individual or multiple wells to view or select by group.

Note: When you configure the FLIPR Penta System for two or more read modes, it cycles
through each mode and alternates between the read modes for each read. Although
reads from each mode within a cycle occur at different times, they are represented as
occurring simultaneously.

The data that displays in the Detail graph have the same corrections applied as the data that
displays in the Multi-Well graph. The Detail graph settings display at the top of the graph
window:

Subtract Bias
Spatial Uniformity Correction
Negative Control Correction
Positive Control Scaling
Response Over Baseline
Crosstalk Correction

These settings correspond to options in the Correction dialog that you access from the Analysis
process page. Use the Corrections dialog to change the settings. This changes the data in the
Multi-Well graph and the Detail graph.

Icon Name Description

Copy Graph Copies the Detail graph to the computer clipboard to paste into a different

software application.

Copy Graph Data Copies graph data in the Detail graph to the computer clipboard to paste

into a different software application.

Zoom Mode Zooms in the graph. Drag over a region in the graph to enlarge the region

to the full size of the graph. Drag the cursor along a part of the X or Y axis

to zoom in on that axis.

Auto Scale The software prompts you to use the Auto Scale feature to automatically

scale the Detail graph and Multi-Well graph to include all data points of the

traces.

Auto Scale Always Automatically scales the Detail graph and Multi-Well graph to include all

data points of the traces without a prompt.

Undo Zoom Rescales a graph to the original settings.

Manual Scale

Graph

Displays the Manual Scale Graph dialog to set the maximum and minimum

values for the X-axis and Y-axis of the Detail graph and Multi-Well graph.

Show/Hide Data Toggles to display or hide the relative light unit values for the traces at

each read.

Show Point Labels Writes the value of each data point beside the point on the graph.

Detail Graph Icons
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Icon Name Description

Show/Hide

Legends

Toggles to display or hide the Detail graph legend.

Average/Overlay

Trace

Toggles to display either the average or overlay traces for groups.

Average Group - Displays average time point values for all wells in the

group. Generates a separate trace for each read mode. When you select

Well Selection Mode in the Multi-Well graph, all traces in the Detail graph

are averaged regardless of the group to which they are assigned.

Overlay Group - Displays traces for all wells in the group. Traces are color-

coded by group.

Show/Hide

Standard

Deviation

Toggles to display or hide the standard deviation for the average group

trace.

Note: You must select Average Group to access this function. When you

select Well Selection Mode in the Multi-Well graph, traces that display in

the Detail graph are averaged regardless of the group to which they are

assigned and the standard deviation for this average displays.

Detail Graph Icons (continued)

Individual Well Selections

To view a single well in a Detail graph, double-click or drag the cursor inside the Multi-Well
graph over a well.

To view the traces of multiple wells overlaid in the Detail graph, drag the cursor inside the Multi-
Well graph over multiple wells. This allows you to view data from rectangular block of wells
within the plate. To add additional wells to the overlay, double-click or drag the cursor over the
wells.

Group Selections

Use group membership to select the data to view in a Detail graph. Use Select Group or Group
Selection Mode functions found in the Multi-Well graph. See Grouping on page 72.

Analyzing Data

Use the Grouping dialog and the Corrections dialog to analyze data produced during an
experiment. The settings in these dialogs affect the way that data, in data files generated by the
protocol, display when first viewed. They affect data in the automatic output option Auto Export
that occur when you run the protocol. See Exporting Data on page 117.

Data files that the ScreenWorks Software create retain all raw data readings, so the analysis
options in the Grouping dialog and the Correction dialog apply to acquired data, modifying the
display of these, irrespective of the analysis settings configured in the original protocol. See
Grouping on page 72 and Corrections on page 75.
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Grouping

Use groups to select data to view in the Detail graph. Use in the Correction dialog to correct the
data relative to responses to positive and/or negative control groups.

Define groups in the Analysis > Configure Groups > Grouping dialog.

A group is a selection of wells with a common characteristic, usually in the type of compound
you add to the wells. Three groups (background fluorescence correction, positive controls, and
negative controls) are defined by default, but no wells are assigned to them. You specify the
well assignment for these groups.

Create additional groups to represent wells with a specific ligand, ligand concentration, or any
other characteristic to classify data. Group definition includes input for compound
concentration. Use the Series option to create a series of groups where a number of different
concentrations are automatically assigned to each group. This is useful to create groups for an
IC50 or EC50 experiment.

The Grouping dialog contains a grid that represents the 96-well, 384-well, or 1536-well read
plate. The basic steps are to select a group from the list then drag the cursor over the wells in
the grid to assign to the group.

Option Description

Groups Displays the list of groups, group name, concentration, and notes. Wells you

assign to the group have the same color in the grid below and in the group list.

Positive Controls - Use this group to assign positive control wells, typically the

maximum response to a concentration of an agonist. Note: You must define

Positive Control wells to use the Positive Control Scaling Correction.

Negative Controls - Use this group to assign negative control wells, typically

buffer addition controls. Note: You must define Negative control wells to use the

Negative Control Correction feature.

BF Controls - Use this group to assign wells in which to measure background

fluorescence. The software uses the measurements for each time point from

these wells background fluorescence correction of ratiometric data. See

Ratiometric Options on page 77.

Add New Group - Use this to define a new group or a series of groups.

Add/Edit Group Displays the Edit Group dialog to edit the group. Select the Add New Group row

to add a new group. See Adding New Groups on page 73.

Delete Group Deletes the group you select in the list. Wells assigned to the group lose their

color to indicate that they no longer belong to a group.

Delete All Groups Deletes all user defined groups. You cannot delete positive, negative, and

background fluorescence control groups, but this command deletes all wells

you assign to these groups.

Clear All Selections Removes all group assignments from all wells. This does not affect the group

names in the list.

Undo Last Selection Removes group membership from the last wells that you assign to a group.

Grouping Options
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Assigning Wells to Groups

To assign wells to a group:

1. Click the Groups drop-down and select a group.
2. In the plate layout, drag the cursor over the wells to add to the group. Click the row or

column title to include the respective wells in the group.

Note: Wells in a group do not need to be contiguous. You can select multiple areas
of the plate.

To deselect an individual well or neighboring wells, right-click in one corner of the well,
then drag over the well or wells to deselect.

Adding New Groups

Use the Grouping dialog to add and edit groups.

To add a new group:

1. Click the Analysis menu and select Configure Groups to display the Grouping dialog.

2. Click Add/Edit Group or double-click a group name to display the Select Type of Group
dialog.

3. Select a tab:
Select the Group tab to configure a single group with specific settings.
Select the Series tab to configure a series of groups with incrementing concentration
values.
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Group Tab

To add a group:

1. Select the Group tab.
2. In the Group Name field, enter the group name.
3. In the Concentration field, enter the concentration value.
4. Click the Units drop-down and select nM, µM, mM, M, or Log.
5. In the Notes field, enter a note to associated with the group.
6. Click OK.

Series Tab

Use a series to assign a dose response curve with regular increment steps. The software
assigns successive rows or columns different concentrations. See Assigning Wells to Groups on
page 73.
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To add a series of groups:

1. Select the Series tab.
2. In the Group Name field, enter the group name.
3. In the Starting Value field, enter the value for the lowest or highest concentration of the

series.
4. In the Step Increment field, enter the value for the change in concentration between

concentrations in the series.
5. Click the Units drop-down and select nM, µM, mM, or M.
6. Click the Operation drop-down and select Plus, Minus, Multiply, or Divide.
7. Select a Replicates option: select whether replicates align in Row format or Column format

on the plate.
If replicates align in both row and column formats, indicate the number of replicates, for
example, replicates in rows indicates all wells in the rows that have the same
concentration.
If two rows include the same concentration, enter 2.
If there are no replicates, select None.

8. Select the direction in which the series increments, either Left, Right, Top, or Bottom.
9. In the Notes field, enter notes to associate with the group.
10. Click OK.

Corrections

Use the Corrections dialog to apply data correction algorithms and to view ratiometric data.

Changes affect:

Data display in the Multi-Well graph and Detail graph.
Data display in group statistic table and graphs.
Data in file export. See Exporting Data on page 117.

The settings you make in the Correction dialog for protocol files are important for the output
options because you cannot change exported data. The ScreenWorks Software keeps the raw
data, so the settings you change in the Correction dialog simply change how you view the data
in resulting data files.
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Option Description

Positive Control

Scaling

Select this check box to average each maximum relative light units value from

the positive control group and normalize all samples to this value (set at 100%).

Use this to graph a dose response curve or to compare data between

experiments.

Negative Control

Correction

Select this check box to calculate an average negative control well value and

ratio-to-well value for each sample interval (time point). The software calculates

this ratio for each sample interval and applies it to all wells. This provides a

good correction for signal drift and artifacts.

Spatial Uniformity

Correction

Select this check box to use the initial signal to normalize signal in each well,

remove fluctuations due to well-to-well variation in cell density, and dye

loading. The algorithm averages the initial signal from all wells together and

then scales each individual well relative to the average. Use this to normalize

cell number, type, and dye-loading conditions throughout a plate.

Note: Use spatial uniformity only when all wells in a plate are treated the same

prior to an experiment (for example, dye loading, cell numbers, etc.).

Subtract Bias Based on

Sample

Select this check box to subtract the relative light units measured at a read

number from all other time points in each well. Use this to set the Y-axis values

for all data graphs to zero at the time point you enter. Enter the read number to

subtract in the corresponding field. The default is read number 1.

Response Over

Baseline

Select this check box to display the trace as a ratio of the response to the

average of a set of reads.

Baseline Start - First read to include in the averaged baseline value.

Baseline End - Last read to include in the average baseline value.

Show As Percentage - Displays response as a percent increase over the

average baseline value.

Corrections Options

For details, see Data Processing Algorithms on page 197.

You can apply each of the correction options alone or in combination with the others. When you
select a combination, they apply in the following sequence:

1. Crosstalk
2. Spatial Uniformity Correction or Response Over Baseline
3. Negative Control Correction
4. Positive Control Scaling
5. Subtract Bias

Note: You cannot apply spatial uniformity correction and percent baseline at the same
time.
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Ratiometric Options

Where you configure two read modes you can view the data as a ratio of one read mode to the
other, for each data point.

When you activate this option, traces of the calculated ratio display in the Detail graph.

Before calculating the ratio, the software corrects ratiometric data for fluorescence background
by subtracting estimated background values from both numerator and denominator for each
time point. After the fluorescence background is subtracted, the ratio is then calculated.
Additional corrections are applied to the ratio, beginning with negative control correction,
positive control scaling, followed by subtract bias.

Note: Spatial uniformity correction and response over baseline are not available when
Ratiometric Options are active.

Option Description

Ratiometric Options Select this check box to allow ratiometric data viewing.

Select the read modes to use as numerator and denominator to

specify how the ratio is defined.

Background Fluorescence Correction Scale by BF Control Group - For each time point and read mode

in the ratio, the average value for that time point in the

background fluorescence control wells (BF Controls, in the

Grouping dialog) is subtracted. The ratio is calculated after

subtraction of the average value from both numerator and

denominator.

Scale by Constant Values - Enter the constant values to

subtract from the numerator and denominator for each time-

point ratio. You must enter these constant values in the

numerator and denominator fields.

Ratiometric Options

Group Statistics

Use the Group Statistics table to analyze data from an experiment. You can analyze only groups
you define in the Grouping dialog in this section. See Grouping on page 72. Settings you make
in the Correction dialog influence the group statistics that are reported. See Corrections on
page 75.

Click Configure Kinetic Reduction in a Multi-Well graph to define the reads and reduction type
to analyze.

Icon Name Description

Copy Table

Data

Copies data in the Group Statistic table to the computer clipboard to paste into

a different software application.

Collapse All

Groups

Collapses the Group Statistics table to display the group name and statistics.

Toggles with Expand All Groups.

Group Statistics Table Icons
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Icon Name Description

Expand All

Groups

Expands the Group Statistics table to display the individual wells and kinetic

reduction values that comprise each group statistic. Toggles with Collapse All

Groups.

Auto Fit All

Columns

Collapses the column width so it is no wider than the title of the column or

largest data point.

Select

Statistics

Displays the Choose Statistics dialog to define groups statistics.

Concentration - Numerical concentration values you assign to each group.

Units - Concentration units you assign to each group.

Notes - Comments you assign to each group.

Average - Numerical average of the kinetic reduction values for a group.

Maximum - Highest value (single #) of all kinetic reductions within a group.

Maximum-Minimum - Result of subtracting the minimum kinetic reduction

value from the maximum count kinetic reduction value for a single group.

Minimum - Lowest kinetic reduction value within a group.

Sum - Numerical sum of all kinetic reduction values within a group.

Standard Deviation - Defines the numerical value you associate with one

standard deviation from the average.

Standard Deviation+1 - Equals the average group value plus one standard

deviation.

Standard Deviation-1 - Equals the average group value minus one standard

deviation.

Z Score - Evaluates quality or performance of the assay and is dependent on

the concentration evaluated1.

Z-factor - Evaluates the quality or performance of the assay at a given

concentration. Typically used for all concentrations, not including the positive

control. Calculation used:

Z = 1 - [3*(std dev of GROUP + std dev of neg ctrls)/abs(mean of GROUP - mean

of neg ctrls)]

Z’-factor - A characteristic parameter for the quality of the assay itself. Typically

performed using data only from the positive control concentration. Calculation

used:

Z' = 1 - [3*(std dev of pos ctrls + std dev of neg ctrls)/abs(mean of pos ctrls -

mean of neg ctrls)].

1. Zhang, J., Chung, T. D. Y. and Oldenburg, K. R. (1997). A Simple Statistical Parameter for Use
in Evaluation and Validation of High Throughput Screening Assays. Journal of Biomolecular
Screening 4(2):67:73.

Group Statistics Table Icons (continued)

You can plot the statistics you define in the Group Statistic table in the Group Statistic graph,
located behind the Detail graph, to view a dose-response curve. All groups are included in the
graph, unless you right-click on the group and select Exclude Groups From Statistic Chart.
Groups not used in the graph display a green line through the row. To include the group in the
graph, right-click and select Include Groups In Statistic Chart. Select a group statistic in the
Group Statistic table to display the data in the Group Statistic graph.
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Icon Name Description

Copy Graph Copies data in the Group Statistic graph to the computer clipboard to paste

into a different software application.

Copy Graph

Data

Copies the graph data in the Group Statistic graph to the computer clipboard

to paste into a different software application.

Zoom Mode Zooms in the graph. Drag over a region in the graph to enlarge the region to

the full size of the graph. Drag the cursor along a part of the X or Y axis to

zoom in on that axis.

Auto Scale The software prompts you to use the Auto Scale feature to automatically scale

the Detail graph and Multi-Well graph to include all data points of the traces.

Auto Scale

Always

Automatically scales the Detail graph and Multi-Well graph to include all data

points of the traces without a prompt.

Undo Zoom Rescales the graph to the original settings.

Manual Scale

Graph

Displays the Manual Scale Graph dialog to set the maximum and minimum

values for the X-axis and Y-axis.

Show/Hide

Data

Toggles to show or hide the data for the traces at each read.

Show Point

Labels

Writes the value of each data point next to the point on the graph.

Show/Hide

Legends

Toggles to display or hide the detail graph legend.

Show/Hide

Smoothed

Curve

Toggles to display or hide the 4-parameter curve fit. Can display at the same

time as Show/Hide Original Trace.

Show/Hide

Original Trace

Toggles to display or hide the trace of the graph, which connects each data

point. Can display at the same time as Show/Hide Smooth Curve.

Show/Hide

Real Data

Points

Toggles to display or hide the data points to create the graph. When you hide

the data points, you should activate either the Original Trace or Smoothed

Curve function.

Display X-Axis

in Log Scale

Toggles to convert the X-axis from a concentration to a log concentration

scale.

Show/Hide

EC/ICXX Value

Toggles to display or hide the effective/inhibition concentration. You define

the percentage of activation/inhibition that the graph plots.

Group Statistic Graph Icons
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Image Display

Use the Image Display dialog, from the Analysis process page, to view images you save in data
files when you activate Save Images during a Read with TF step. This stores a total of up to
6,000 images per experiment and you define the number of images per dispense. The default
is set to one image before and nineteen images after the fluid addition initiates. You can play
back saved *.tif files in sequence, frame-by-frame or as a video.

Use Image Display to diagnose problems. For example, if cells are blown off during a fluid
dispense, you see dark holes in the middle of the cell layer after the fluid addition. If the entire
well decreases in relative light units, it is likely that extracellular dye has been diluted.

Notes

Use the Protocol Notes dialog to enter comments to keep with the data files that the protocol
generates. In data files the same dialog displays the comments that you add in the protocol file
in read-only format.

Transfer Fluid Process

Use the Transfer Fluid process to program reagent or cell additions and to execute them in
conjunction with other processes. The default protocol has one Transfer Fluid process.

A blue Transfer Fluid icon indicates that the process occurs in series with other blue colored
processes in the protocol. A purple icon indicates that the execution of the process is
synchronized to a Read or Mix Fluid process.

The Transfer Fluid process has options for pin tools and standard pipettors. You must configure
aspiration and dispense of compound in each case separately.

For a standard pipettor you can configure more than one aspiration or dispense (but not both)
within the process, with the multiple Fluid Transfer type.

When you select a standard pipettor, you configure aspiration and dispense steps by selecting
the row in the aspiration or dispense table and then click Edit to display a configuration dialog.
With the Pin Tool, aspiration and dispense configuration is done on the Transfer Fluid page.

Select a multiple dispense Fluid Transfer type to allow additional dispense steps with a
standard pipettor. Then configure the first dispense with a volume less than the volume
aspirated. An additional dispense is automatically activated for the remaining volume. For
multiple aspirates, configure the first aspirate with less volume than the dispense.

Note: The entire volume of fluid aspirated is always dispensed.
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Aspirate Configuration (Standard Pipettor)

Option Description

Fluid

Transfer

Type

Select Single Aspirate – Single Dispense to aspirate one liquid volume and dispense that

entire liquid volume in one action into a plate.

Select Multiple Aspirate – Single Dispense to aspirate up to four liquid volumes from up to

four aspirate plates and dispense entire tip contents into a single plate. To add additional

aspirates, make the aspirate volume less than the dispense volume.

Select Single Aspirate – Multiple Dispense to aspirate one liquid volume and dispense up

to four distinct liquid volumes into four distinct quadrants or plates. Add additional

dispenses by making the dispense volume less than the aspirate volume. The last dispense

expels all liquid that remains in the tip.

Tips to improve Single Aspirate – Multiple Dispense (by quadrature) pipetting precision

include:

* When pipetting, do not use hold and expel volumes and use the slowest removal speed (2

mm/s).

* Aspirate 5 –10% more than is needed from the source plate (for example, aspirate 110 µL

when you dispense 25 µL into four quadrants.

* Include a mix step with 3 strokes in the source plate to pre-wet tips. Mixing of fluid in the

source plate primes the internal walls of the tips, reducing surface tension between the fluid

and tip plastic.

Read Select this check box to link a Read process to the Transfer Fluid process. This

automatically adds a Read with TF step to the protocol and displays the configuration page

for that step. See Read Process on page 89.

Note: This is required if you intend to read a plate while transferring liquid during a kinetic

cell-based assay.

Aspirate Select the check box at the start of a row to activate an aspirate sequence. If you select the

Multiple Aspirate Fluid Transfer type, enter an aspirate volume less than the dispense

volume to add another aspirate step. Only the aspirate sequences you select are active in

the protocol.

Aspirate Configuration Options for Standard Pipettor Use
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Option Description

Edit

Aspirate

Select the check box for an aspirate row and click Edit Aspirate or double-click on a row to

display the Edit Aspirate dialog.

Source Plate - Select the plate from which to remove an aliquot of fluid.

Quadrant - Select the quadrant from which to aspirate the volume. Available when you

aspirate liquid from a plate using a pipettor head of lower density, for example, 384-well

plate using a 96 pipettor head.

Volume - Enter the volume (in µL) to aspirate.

Speed - Enter the speed at which to aspirate (in µL/s).

Height - Enter the distance (measured in µL) from the bottom of the well where the tips

should start aspiration.

Note: Tips move downward full volume of aspiration, for example, aspirate 10 µL with a start

height of 35 µL moves the pipettor height to 25 µL after aspiration. Pipettor head movement

helps prevent well overflow when tips submerge in the well. To prevent downward pipettor

motion, set the tip height to minimum value. Tip movement downward halts when the tips

reach 1/30th well volume.

Hold Volume - Enter the size of the air gap (in µL) following aspiration. Air gaps prevent

liquid from leaking out of the tip before dispensing.

Removal Speed - Enter rate (in mm/s) at which to pull tips from the well after aspiration.

Adjust this value depending on fluid viscosity or volume of fluid in the well. For low volume

transfers, a slow up-speed may improve precision.

Put Tips in

Well

Before

Read

Select this check box to place the tips in the read plate prior to beginning read intervals.

Use this for assays where placing tips below the fluid surface can prevent excessive

turbulence. This helps ensure accurate timing of fluid dispense relative to reads.

Aspirate Configuration Options for Standard Pipettor Use (continued)
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Dispense Configuration (Standard Pipettor)

Option Description

Dispense Select this check box for a row to activate a dispense sequence. If you select the Multiple

Dispense Fluid Transfer type, enter a dispense volume less than the aspirate volume to add

a dispense step. Only dispense sequences you select are active in the protocol.

Mix Fluid

After

Dispense

Select this check box to link a Mix Fluid process to the Transfer Fluid process. This adds a

Mix with TF step to the protocol and displays the configuration page for that step. Available

when the fluid transfer type has a single dispense. See Mix Fluid Process on page 87.

Unload

Tips after

Fluid

Transfer

Unloads tips after the Fluid Transfer process. Use this to change the tips during an

experiment or to reduce down time between experiments. Available when you select Load

Tips Position on the Settings process page. This feature also requires that no source plate is

placed in plate Position 3 during the experiment.

Dispense Configuration Options for Standard Pipettor Use
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Option Description

Edit

Dispense

Displays the Edit Dispense dialog to define dispense parameters.

Target Plate - Select the plate to receive the fluid dispense. This is the Read Plate.

Quadrant - Select the quadrant from which to dispense the volume. Available when you

aspirate liquid from a plate using a pipettor head of lower density for example, 384-well

plate using a 96-pipettor head.

Volume - Enter the volume (in µL) to dispense. In the last dispense, the entire content in the

tip dispenses.

Height - Enter the distance (measured in µL) from the bottom of the well to insert the tips

prior to dispense. Tips move upward the full volume of dispense during dispense, for

example, a 10 µL dispense with a start height of 35 µL moves the pipettor to a height of 45

µL after dispensing. This movement helps prevent well overflow when tips submerge in the

well. Tips do not move higher than the full volume of the well.

Speed - Enter the speed to dispense (in µL/s). Ideal dispense speed accounts for the

volume added, how fast the signal increases in response to compounds, and strength of the

attached cells at the bottom of the plate.

Expel Volume - Enter an additional volume (in µL) the pipettor dispenses over the dispense

volume. This is equal to the aspirate hold volume. In a multiple dispense, only the last

dispense can have an expel volume.

If you select Mix Fluid After Dispense, expel volume changes to zero for the dispense for

the fluid transfer to ensure that tips remain in the well prior to the mix step. The expel

volume is transferred to the Mix with TF step to help ensure liquid is properly expelled from

the tips after mixing.

Removal Speed - Enter the rate (in mm/s) at which to pull the tips from the well after the

dispense. Adjust this value for fluid viscosity, fluid volume in the well, or if the transfer

performs to a dry well.

Pause in Well - Enter the time (in seconds) to pause with the tips in the wells after the

dispense and mix before the next pipettor move.

Hold Pipettor During Dispense - Select this check box to hold the pipettor at the dispense

height. Read intervals might occur simultaneously with this step. The pipettor pauses during

a read to prevent disturbances in the imaging process.

Dispense Configuration Options for Standard Pipettor Use (continued)
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Aspirate Configuration (Pin Tool)

Option Description

Source Plate Select the plate from which to remove an aliquot of fluid. This is a plate that

contains an agonist or antagonist.

Height Enter the distance (measured in µL) from the bottom of the well to place the pins.

The distance equivalent in millimeters displays.

Select the Float Pins check box to move the pipettor down to a position at which

the pins should be 1 mm below the bottom of the wells. As pins come to rest on

the well bottoms additional downward motion of the tip block is absorbed by the

tips moving into the block. This ensures that all pins are submerged in the same

volume of fluid across the plate. The Height is designated as -1.00 mm.

Quadrant Select the quadrant from which to aspirate volume. Available when you use a

pipettor head of lower density to aspirate liquid from the plate, for example, 1536-

well plate using a 384 pin tool head.

Down Speed Enter the speed (in mm/s) at which to insert the pin tool into the source plate.

Removal Speed Enter the speed (in mm/s) at which to remove the pin tool from the source plate.

The speed of removal determines the volume of fluid remaining on the pins.

Increase the removal speed to increase the volume of compound on the pin after

aspiration. Slow the removal speed to decrease the fluid volume. Assay

development should be done to determine the volume transfer based on

removal speed.

Pause in Well Enter a duration (in seconds) to hold the pin tool in the source plate after full

insertion and before removal.

Aspirate Configuration Options for Pin Tool Use
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Dispense Configuration (Pin Tool)

Option Description

Target Plate Select the plate to receive the fluid dispense; typically, the Read Plate.

Height Enter the distance (measured in µL) from the bottom of the well to insert the tips. The

distance equivalent in millimeters displays to the right of the µL value.

Quadrant Select the quadrant of the target plate into which to dispense compound. Available

when you use a pipettor head of lower density to aspirate liquid from the plate, for

example, 1536-well plate using a 384 pin tool head.

Down Speed Enter the speed (in mm/s) at which to insert the pin tool into the target plate.

Removal

Speed

Enter the speed (in mm/s) at which to remove the pin tool from the target plate. The

speed of removal determines the volume of fluid that remains on the pins.

Pause in Well Enter the duration (in seconds) to hold the pin tool in the dispense plate after full

insertion and before removal.

Read Select this check box to link a Read process to the Transfer Fluid process. This adds a

Read with TF step to the protocol and displays the configuration page for that step. See

Read Process on page 89.

Note: This is required if you read a plate while transferring liquid during a kinetic cell-

based assay (for example, calcium mobilization).

Mix Fluid Select this check box to link a Mix Fluid process to the Transfer Fluid process. This adds

a Mix with TF step to the protocol and opens the configuration page for that step. See

Mix Fluid Process on page 87.

Unload Pin

Tool

Select this check box to unload the pin tool after the dispense.

Dispense Configuration Options for Pin Tool Use
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Mix Fluid Process

You add fluid mixing steps to protocols as independent protocol steps, Mix Fluid or linked to a
Transfer Fluid step, Mix with TF. You configure independent Mix Fluid steps to mix fluid in
source or read plates, while Mix with TF steps immediately follow the Transfer Fluid step to
which they are linked to mix fluid in the read plate where compound dispenses.

Different mix options are available for standard pipettors and the pin tool.

Mix Fluid (Standard Pipettor)

Fluid mixing with a standard pipettor consists of a series of aspirations and dispenses in and out
of the tips.

Option Description

Mix Plate Select the plate that contains the fluid to mix. Typically, it is a source plate

from which you transfer fluid.

Quadrant Select a quadrant from which to mix fluid. Available when you use a pipettor

head of lower density to aspirate liquid from the plate, for example, 1536-well

plate using a 384 pin tool head.

Volume Enter the volume (in µL) to mix.

Speed Enter the speed (in µL/s) to mix the fluid.

Height Enter distance (in µL) from the bottom of the well that the tips will insert prior

to mixing. Tips move up and down with aspirate and dispense commands.

These movements help prevent well overflow when the tips submerge.

Expel Volume Enter an additional volume (in µL) the pipettor dispenses, beyond the volume

you enter in the Volume field. This helps ensure that all fluid expels from the

tips after mixing.

Strokes Enter the number of times to aspirate and dispense mix volume. One stroke is

equal to one aspiration, and one dispense.

Removal Speed Enter the rate (in mm/s) at which to pull the tips from the well after the mix.

Adjust for fluid viscosity or fluid volume in the well.

Pause In Well Enter the time (in seconds) to pause with the tips in the well after mixing and

before the next pipettor head move.

Unload Tips After Mix Select this check box to unload the tips after the mix step.

Mix Fluid Options (Standard Pipettor)
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Mix Fluid (Pin Tool)

Fluid mixing with a pin tool consists of a sequence of up and down motions of the pin block.

Option Description

Mix Plate Select the plate that has the fluid to mix. Typically, it is a source plate from

which you transfer fluid.

Top Height Enter the height (in µL) for the top of the stroke during mixing.

Quadrant Select a quadrant in which to mix fluid. Available when you use a pipettor

head of lower density to aspirate liquid from the plate, for example, 1536-well

plate using a 384 pin tool head.

Bottom Height Enter the height (in µL) for the bottom of the stroke during mixing.

Strokes Enter the number of times the pins move within the mix step. One stroke is

equal to one up-stroke and one down-stroke.

Down Speed Enter the speed (in mm/s) of the down stroke.

Removal Speed Enter the rate (in mm/s) at which to pull pins from the well after the mix.

Adjusted for fluid viscosity or fluid volume in the well. The speed of removal

determines the volume of fluid remaining on the pins.

Up Speed Enter the speed (in mm/s) of the up stroke. This is not the rate which pins

remove from the well.

Pause in Well Enter a duration to hold the pin tool in the well plate once the mix completes,

before withdrawal.

Unload Pin Tool Select this check box to unload the pin tool after mixing.

Mix Fluid Options (Pin Tool)

Mix With TF

Fluid can be mixed immediately after the dispense to ensure proper mixing of agonists and
antagonists with the cell monolayer. This is necessary when you transfer fluids one-tenth or less
of the total fluid volume of a well.

To add a mix after the dispense, select the Mix After Fluid Dispense (Mix Fluid for the Pin Tool)
check box in the Transfer Fluid dialog. This inserts a mix step, and the Mix Fluid process icon
turns purple to indicate that mixing occurs immediately after the dispense and concurrently with
a Read process.

Note: Any expel volume you configure in the dispense step prior to a mix is locked if you
select Mix Fluid After Dispense. Tips are raised during expel volume which can lead to
inadequate mixing, so mixing occurs with the tips at the level at which they finish the
basic dispense and expel volume occurs after mixing completes.
Mixing parameters for a Mix with TF process are similar to a Mix Fluid process, however
you cannot configure Mix Plate, Quadrant, Hold Volume, and Tip Up Speed. These
options are available in the Transfer Fluid process to which you link the mix.
To remove a Mix with TF process, deselect it in the Transfer Fluid dialog.
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Read Process

You can add Read steps to protocols as independent protocol steps, read or linked to a
Transfer Fluid step Read with TF. Configuration options for the two types of steps are similar,
except Read with TF allows you to time the read precisely with the time that compound
dispenses, and it allows you to save the images used to measure the response. You can save
up to 6,000 images per experiment.

Note: When you use the HS EMCCD camera, depending on the Protocol > Settings > Edit
Read Mode > Camera Mode setting, when you use a fast read time interval value, the
plate matrix panel update might be delayed until the end of the data acquisition rather
than updating during the data acquisition.
Specifically, the following settings cause the plate matrix panel to update at the end of
the data acquisition:
For Camera mode High-Speed - A Read Time Intervals setting of 0.018 seconds or
shorter.
For Camera mode Normal or Sensitivity - A Read Time Intervals setting of 0.029 or
shorter.
For Camera Mode setting details, see Edit Read Mode on page 61.

Read

To add a Read process to a protocol that is independent of a liquid transfer, drag the Read
process icon from the Process Explorer to the Experiment window. The Read process page
displays when you release the icon. When you add a Read process to a protocol the icon is
orange to indicate it is an optics function and occurs in parallel with fluid processes during the
experiment.

A Read consists of a sequence of images taken at a predefined rate from which relative light
values for each well are measured. You can divide a single Read process into two intervals with
different read rates to take images at a high rate while compound is added, and shortly
thereafter, to best capture kinetic effects. Images can then be taken at a less frequent rate as
cells settle and less change occurs.

Note: The read rate you define for the Read process is the same for all the read modes
you select. For example, if you set the Read Interval at one second, and have two read
modes, two images are taken every second, one for each read mode.
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Option Description

First Interval Configure the first series of reads in the Read process.

Read Interval - Enter the time (in seconds) between reads. The software uses the

same interval for each read mode (for example, the instrument takes images twice as

fast if you select a second read mode).

Note: Time should be no less than exposure time plus read-out time. If it is less, the

experiment speed is determined by the capability of the computer. See Setup Read

Mode on page 61.

Number of Reads - Enter the total number of reads to take in the first interval.

Second Interval Configure the second series of reads in the Read process. To skip a second series

with a different read interval, enter zero for the Number of Reads.

Read Interval - Enter time (in seconds) between reads. Must be a multiple of the first

read time (for example, if read interval 1 is 1 second, then read interval 2 should be 2

seconds or 3 seconds).

Note: Time should be no less than exposure time plus read-out time. If it is less, the

experiment speed is determined by the capability of the computer. See Setup Read

Mode on page 61.

Number of Reads - Enter the total number of reads to take in the second interval.

Read Options

Read With TF

Plate reads concurrent with fluid transfer is necessary to collect data for kinetic cell-based
assays as the response time is very rapid. To link a Read process to a Transfer Fluid process,
select Read in the Transfer Fluid page. When you insert a read in the Transfer Fluid page, the
Read process icon turns purple to indicate that the read occurs concurrently with liquid
addition.

Read with TF configuration is similar to an independent Read process, but with the addition of
Number of Reads Before Dispense and Save Images.

Note: To remove a Read with TF process, deselect the Read option in the Transfer Fluid
process dialog.
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Option Description

Number of Reads

Before Dispense

Enter the number of reads to take before fluid is added to the plate. This

provides a cellular response baseline before the addition of agonist or

antagonist. Number of Reads Before Dispense is included in the total number

of first interval reads you enter in the Number of Reads field, for example, if the

Number of Reads is 60 and the number of Reads Before Dispense is five, there

are 55 reads after the dispense initiates.

Number of Reads After

Dispense

Enter the number of reads to take after fluid is added to the plate. This captures

the cellular response after the addition of agonist or antagonist. Number of

Reads After Dispense is included in the total number of first interval reads you

enter in the Number of Reads field

Save Images Select this check box to save up to 6,000 images an image file (*.tif) for the

experiment. Use these images for more than one dispense as long as the total

images saved do not exceed 6,000 for the experiment.

Number of Images Before Dispense - Enter the total number of images to save

prior to the dispense initiation.

Number of Images After Dispense - Enter the total number of images to save

after the dispense initiates.

By default, one image prior to and nineteen after the dispense save for review.

See Image Display on page 80.

Note: Use images to troubleshoot problems with the cell plate such as cells

detaching during fluid dispense.

Read With TF Options

Wash Tips or Pins Process

Use the Wash Tips or Pins process to eliminate unwanted agonist or antagonists prior to
another addition within an experiment or between experiments to reduce consumable costs
and downtime associated with tips replacement.

For standard pipettors, tips are inserted into the wash location and wash fluid aspirated and
dispensed. This can be done a number of times (strokes) in the same wash fluid, then the whole
process can repeat up to five times (wash cycle) with fresh wash fluid.

For the pin tool, up and down motion is used to force fluid in and out of the capillary slot of the
pins. A typical wash protocol uses an initial solvent to remove compound from the pins,
followed by a second solvent to remove the first solvent. You should blot pins at a blotting
station to remove excess liquid from the pins between washes.



FLIPR Penta High Throughput Cellular Screening System User Guide

92 5069582 G

Wash Tips (Standard Pipettor)

Option Description

Fluid Type Select the fluid in the wash reservoir during tip washing, from

wash fluid container A or B.

Pump Speed Select the pump speed (slow or fast) to fill and empty the wash

reservoir. Select Fast except with volatile solvents.

Wash Cycles Select the number of times that fluid cycles through the wash

reservoir. For each cycle, the pipettor executes the number in the

Strokes field.

Strokes Select the number of times to aspirate and dispense wash fluid.

Volume/Stroke Enter the volume (in µL) of fluid to aspirate and then expel for

each stroke.

Hold Time Enter the length of time (in seconds) to pause between aspirating

and expelling fluid.

Aspirate Speed Select the speed (in µL/s) to aspirate fluid.

Dispense Speed Enter the speed (in µL/s) to dispense fluid.

Expel Volume Select the volume to expel.

Unload Tips After Washing Select this check box to remove tips from the pipettor head after

the wash completes.

Wash Tips Options for Standard Pipettor Use
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Wash Pins (Pin Tool)

Option Description

Fluid Type Select the fluid in the wash reservoir during tip washing, from wash fluid

container A or B.

Pump Speed Select the pump speed (slow or fast) to fill and empty the wash reservoir.

Select Fast except with volatile solvents.

Wash Cycles Select the number of times that fluid cycles through the wash reservoir (up to

5). For each cycle, the pipettor executes the number in the Strokes field.

Strokes Select the number of times to raise and lower the pins. One stroke is equal to

one upstroke and one down stroke.

Down Speed Enter the speed of the pin tool during the down stroke.

Stroke Distance Enter the height of one stroke that the pin tool travels.

Up Speed Enter the speed of the pin tool during the up stroke.

Removal Speed Enter the speed of the pin tool withdrawal from the wash location. The faster

the withdrawal speed the more fluid remains on the pins.

Pause in Well Enter the time to hold the pin tool at the bottom of the wells in the wash

solution after the wash completes.

Unload Pin Tool After

Wash

Select this check box to remove the pin tool after the wash completes.

Wash Pins Option for Pin Tool Use
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Blot Pins Process

The Blot Pins process is only available for the pin tool to dry the pins between transfers or
washes, to prevent carry-over.

Option Description

Target Plate Select the plate.

Height Enter the distance (measured in µL) from the bottom of the well to place the

pins. The distance equivalent in millimeters is displays.

Select the Float Pins check box to move the pipettor down to a position at

which the pins would be 1 mm below the bottom of the wells. As pins come to

rest on the blotting surface additional downward motion of the tip block is

absorbed by the tips moving into the block. This ensures that all pins are in

contact with the blotting surface. The Height is designated as -1.00 mm.

Pause in Well Enter the duration during which the pin tool is held motionless at the set height.

Unload Pin Tool After

Blot

Select this check box to unload the pin tool once blotting completes.

Done with Plate After

Blot

Select this check box to indicate that you are done with the plate after blotting.

Blot Pins Options

Pause Pipettor Process

Include Pause Pipettor steps in a protocol to prevent future pipettor motion until the pause
completes. Read processes can continue to execute, unless stopped by the linked action read
with transfer. Use this to stop the pipettor from picking up compound if it sits for an extended
period in the air and to provide time for solvents (such as EtOH) to evaporate off the pins after a
wash.

Enter the duration of the pause in seconds.
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Wash Cell Reservoir Process

Use this process to prime the reservoir with cells prior to an assay or for cleaning purposes and
is recommended for use before and after you use cells in suspension. No pipetting is
associated with this process. This is available only when the cell reservoir is installed.

Option Description

Pre-coat Tubes Select to pump the fluid up to the sensor before filling the reservoir.

Fluid Source Select the fluid to use for the wash process. Fluid 1 – 4 bottles are

available as well as the cell flask.

Drain Reservoir Destination1 Select the drain destination for the fluid left in the reservoir after the wash.

Waste bottles, cell flask, or any of the fluid bottles are available.

Fill Reservoir Speed1 Select the pump rate to fill the cell reservoir (range 1 – 10).

Drain Reservoir Speed1 Select the pump rate to drain the cell reservoir (range 1 – 10).

Wash Cycles Enter the number of wash cycles to run.

Hold Time Soaks the reservoir in the pumped fluid by leaving the fluid in the reservoir

for this length of time (range 0 – 300 seconds or 0 – 5 minutes).

1. Available when the cell reservoir is installed and selected as the source plate for aspiration.

Wash Cell Reservoir Options

Finish With Source Process

In Remote mode, the Finish With Source process instructs the instrument to notify the robot
controller to remove the source plate. This is required when you use multiple plates in a single
source location.

Note: This process is not available in Manual mode or for the read plate position.
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Creating New Protocols

In the ScreenWorks Software, creating a protocol involves combining processes represented in
the protocol builder as colored block icons at the top of the Experiment window. The available
processes depend on your instrument configuration. See Instrument Configuration on page 58.

The color of the process icon depends on the function in the protocol. A red box around the
process in the protocol list indicates the process selection and indicates which configuration
settings dialog is open. See Protocol Process Icon Colors on page 59.

Protocols contain combinations of the following processes:

Settings - Required for every protocol, included at the beginning of every new protocol file,
and cannot be removed.
Analysis - Required for every protocol, included at the beginning of every new protocol file,
and cannot be removed.
Transfer Fluid - Included in new protocols and has the following linked processes:

Read with TF - Included in new protocols after Transfer Fluid and timed precisely to
coincide with compound addition to the read plate. You can deselect this setting from
the Transfer Fluid settings dialog.
Mix with TF - Optional selection within the Transfer Fluid settings dialog.

Mix Fluid
Wash Tips - Available with pipettor configuration.
Wash Pins - Available with pin tool configuration.
Blot Pins - Available with pin tool configuration.
Pause Pipettor
Finish with Source
Read
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To create a new protocol:

1. Select the Process tab. See Process Tab on page 59.
2. Do one of the following to add the assays steps:

To place the new process at the end of the protocol list, drag and drop the process
anywhere in the Experiment window.
To place the new process in the protocol list, drag and drop the process where you
want it. The software prompts you if the position is invalid.

3. When the Configuration screen displays, adjust the settings. See Understanding Processes
on page 60.

4. Repeat the previous steps until you finish building the protocol.
5. Click the Analysis process and define the analysis parameters See Analysis Process on

page 65:
Click Grouping to define grouping parameters.
Click Correction to define correction parameters.
Click Export to define export parameters.

6. Click on other process icons to open the Configuration screen and make changes.

Note: When you use the HS EMCCD camera with a fast read time interval value,
depending on the Protocol > Settings > Edit Read Mode > Camera Mode setting, the
plate matrix panel update may delay until the end of the data acquisition.
Specifically, the following settings cause the plate matrix panel to update at the end
of the data acquisition:
For Camera mode High-Speed with a Read Time Intervals setting of 0.018 seconds
or shorter.
For Camera mode Normal or Sensitivity with a Read Time Intervals setting of 0.029
or shorter.

7. Click the File menu and select Save to display the Save As dialog.
8. In the File Name field, enter the protocol name.
9. Click Save. Protocol files save as a *.fmp file. The default Save In location for the protocols

is C:\Documents\Molecular Devices\ScreenWorks\MyProtocols.
10. Run the experiment.

Refer to the FLIPR Penta High-Throughput Cellular Screening System Protocol Guide for details.
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Deleting Processes from Protocols

You can link Protocol processes to the Transfer Fluid process.

To delete processes that are not linked:

In the protocol list, select a non-purple process icon, and then on the keyboard, press
DELETE.

To delete a linked Transfer Fluid process:

1. In the protocol list, select the purple Transfer Fluid icon to display the settings dialog.
2. Deselect the linked process to delete, either Read or Mix Fluid.

Opening Protocols

To open a protocol file:

1. Click the File menu and select Open and then select Protocol File to display the Open
dialog.

2. Select the protocol file name and click Open.

Deleting Protocols

You cannot delete a protocol from within the ScreenWorks Software.

To delete a protocol:

1. In the Windows File Explorer navigate to where the protocols save. The default location is
C:\Documents\Molecular Devices\ScreenWorks\MyProtocols.

2. Select the *.fmp file to remove and on the keyboard, press DELETE.
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Saving Data Files as Protocol Files

You cannot edit or use the protocol information stored in data files (*.fmd) to run a new
experiment. You can extract the information to a protocol file. Experiments you run using the
new protocol file have the same protocol steps as the original data file.

Tip: When you use a protocol file (*.fmp), you can add, remove, or change processes and
then save the amended protocol to run it.

To store a data file as a protocol file:

1. Click the File menu and select Save As to display the Save As dialog.
2. In the File name field, enter the protocol name.
3. In the Save as Type field, select Protocol Files (*.fmp).
4. Click Save. The software strips the data from the new file and stores associated protocol

information in the protocol file.

Note: Saved changes only affect the protocol. The data file from which the protocol was
derived remains intact.
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Chapter 4: Calibrating and Signal Testing

Calibrating Optics

Adding Read Plates to Plate Library

The FLIPR Penta System has default plate masks for 96-well, 384-well, and 1536-well read plate
types. If you use a plate type that varies from the default formats, you must create new
dimensions and mask for that plate type. See Plate Process Definition on page 49.

To add a plate and mask to the software:

1. Prepare a 1 x 10-8 M fluorescein solution.
2. Ensure the plate bottom is clean and free of scratches and dust.
3. Dispense enough fluorescein solution into each well so as to cover the bottom. Dispensing

half of the total well volume is a safe volume. Use the FLIPR Penta System pipettor.
4. Place the plate that contains fluorescein in the read position
5. Click the Tools menu and select Plate Library.
6. From the Plate Process Definition list, select a plate with a similar well format.
7. Click Copy Plate.
8. Enter a Plate Name.
9. Click the Plate Type drop-down and select Read Plate.
10. Enter the plate dimensions.
11. Click Finish. The plate mask definition is complete when the green Assay Finished

(Unlocked) light illuminates on the instrument door.

Calibrating the Optics

The FLIPR Penta System identifies the serial number, wavelength range, and position of each
LED bank in the instrument. This information, in addition to the wavelength range for the
emission filters, is stored with the system calibration files. When you change LEDs or emission
filters you must recalibrate the Flat Field Calibration files for the new LED/Filter pairs.

Due to the improved light tightness, the background correction calibration in previous software
versions that used black bottom plates is no longer required.

Excitation LED

The Calibration dialog displays the list of the excitation/emission wavelength (LED/Filter)
combinations for the installed modules. The corresponding status for LED calibration displays
Done or Not Done. The status for the flat field calibration displays either Done or Not Done.

Use the excitation LED calibration only when the LED calibration status displays Not Done after
you select to use the 335–345 nm/475–535 nm (340 LED Module).

To run an excitation LED calibration:

1. Click the Instrument menu and select Calibration or click the Calibration icon to display the
Calibration dialog.

2. Select 335–345 nm/475–535 nm.
3. Click Excitation LED Calibration.
4. When the progress bar closes, continue with flat field calibration.

4
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Flat Field Calibration

An accurate flat field calibration is required before you adjust exposure settings. Use this to
correct for light falloff at the corners of the camera lens and to correct gradients or falloff in the
coverage of the light module. When you apply an accurate flat field correction, the well values
for all wells give the same count value for the same stimulus.

When you test for HS EMCCD saturation in the Signal Test dialog, keep the flat field correction
in mind because the central values hit saturation first, while the outer values continue to get
larger as the exposure increases to beyond the maximum camera sensor limit, because they
are being multiplied by the correction factor.

During a fluorescence assay, plate illumination results in imperfect, non-uniform excitation
distribution on the plate surface. Light distribution is more intense in the middle of the plate than
the edges. The software applies a flat field algorithm to the plate image to compensate for
variations in light intensity across the plate. LEDs are not used for luminescence assays so flat
field corrections do not require any adjustment.

The Calibration dialog displays the excitation/emission wavelength (LED/filter) combinations for
the installed modules. The calibration status for flat field calibration displays either Done or Not
Done and the LED calibration of the plate format. None indicates either no LEDs are illuminated,
or the instrument used a blank emission filter position to create the calibration file.

Note: Molecular Devices does not sell LEDs for this assay.

To run flat-field calibration:

1. Click the Instrument menu and select Calibration to display the Calibration dialog.
2. Select a Plate Format (96, 384, or 1536).
3. Select an Excitation/Emission Wavelength pair that displays the Not Done status.
4. Place the flat field calibration plate into the Read position. Use the provided yellow plate to

flat field calibrate the following excitation/emission wavelength pairs:
335–345 nm/475–535 nm
380–390 nm/475–535 nm
390–420 nm/515-575 nm
390-420 nm/565–625 nm
420–455 nm/475–535 nm
470–495 nm/515–575 nm
470–495 nm/565–625 nm
495–505 nm/526–586 nm
495-505 nm/565-625 nm
510–545 nm/565–625 nm
610–626 nm/646–706 nm

Use the following dye to calibrate the excitation/emission wavelength (LED/filter) pair:
360–380 nm with MQAE. See MQAE on page 103.
390–420 nm/440–480 nm with Coumarin. See Coumarin on page 103.

5. Click Flat-Field Calibration.
6. Wait for the Assay Finished (unlock) light to illuminate on the instrument and the

excitation/emission wavelength status to display Done in the Flat-Field Calibration column.
7. Click Close.
8. Place the yellow signal test plate with the correct well format into the instrument. Click the

Instrument menu and select Manual Operation and then select Yellow Plate Signal Test or

click . The yellow plate standard deviation should be 5% or less.
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Coumarin

Required material:

Black clear bottom plate with the correct format and brand for assay (96, 384, or 1536)
Coumarin (7-diethylaminocoumarin-3-carboxylic acid)

Catalog # 36799-100MG-F, Sigma-Aldrich
To run a Coumarin calibration:

1. Make a 0.02 M stock solution of Coumarin in Dimethyl Sulfoxide (DMSO). Mix by vortexing
tube.

2. Store small aliquots at -20°C ( -4°F).
3. Within one hour of calibration, thaw an aliquot and make 20 mL 10-5 M solution in the same

buffer to use for dye loading. Adjust pH to 7.4. Mix by vortexing.
4. Pipette a uniform quantity of the Coumarin solution into each well of the plate. The volume

must be adequate to cover the bottom of the well uniformly. Recommended quantities:
96-well plate, 100 µL/well
384-well plate, 40 µL/well
1536-well plate, 6 µL/well

5. Check the plate visually to make sure there are no bubbles or unfilled wells. Shake or tap
the plate to dislodge bubbles. Keep the Coumarin plate covered and in the dark until used.

6. Use the Coumarin plate as the flat field calibration plate. See Flat Field Calibration on page
102.

MQAE

Required material:

Black clear bottom plate with the correct format and brand for assay (96, 384, or 1536)
MQAE (N-(ethoxycarbonylmethyl)-6-methoxyquinolinium bromide)
Catalog # 46123-100MG-F, Sigma Aldrich

To run a MQAE calibration:

1. Make a 0.02 M stock solution of MQAE in distilled water. Mix by vortexing tube.
2. Store small aliquots at -20°C ( -4°F).
3. Within one hour of calibration, thaw an aliquot and make 20 mL 10-5 M solution in water or in

a chloride-free buffer to use for dye loading. Adjust pH to 7.4. Mix by vortexing.
4. Pipette a uniform quantity of the MQAE solution into each well of the plate. The volume

must be adequate to cover the bottom of the well uniformly. Recommended quantities:
96-well plate, 100 µL/well
384-well plate, 40 µL/well
1536-well plate, 6 µL/well

5. Check the plate visually to make sure there are no bubbles or unfilled wells. Shake or tap
the plate to dislodge bubbles. Keep the MQAE plate covered and in the dark until used.

6. Use the MQAE plate as the flat field calibration plate. See Flat Field Calibration on page 102.
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Signal Tests

Running the Yellow Plate Signal Test

Use the Yellow Plate Signal test once a day to verify that the system optics are calibrated.
Additionally use the Yellow Plate Signal test after you recalibrate or change the optics.

To run a Yellow Plate Signal test:

1. Place the yellow signal test plate on the stage in the read position.
2. Click the Instrument menu and select Manual Operation then select Yellow Plate Signal

Test or click Yellow Plate Signal Test.

3. Set the following parameters:
a. Click the Select Plate drop-down and select the correct plate.
b. Click the Reading Mode drop-down and select Fluorescence.

Note: Although both Fluorescence and Luminescence are available, there is no
easy way to test signal strength in the Luminescence read mode. Do not run
a Luminescence signal tests.

c. Click the Excitation/Emission Wavelengths drop-down and select the correct
wavelengths.

d. Click the Excitation Intensity drop-down and select 50.
e. In the Exposure Time field, enter 0.1 seconds.
f. Adjust the following variable camera settings:

For the EMCCD camera, set the Camera Gain to 80.
For the HS EMCCD camera:

In Camera mode Normal, set the Camera Gain to 1.5 and the Exposure Time to
0.005 seconds.
In Camera mode High-Speed, set the Camera Gain to 20 and the Exposure
Time to 0.001 seconds.
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4. Click Test Signal to take a picture. When you calibrate the instrument with the yellow test
plate for the appropriate plate format and optics, normal test plate results are a relative
standard deviation less than 5%.
If the test results are abnormal values, look at the image display for any anomalies on the
plate. See Troubleshooting on page 159.

5. Print the results and keep the printout in a folder by the instrument to track the standard
deviation of the yellow signal test plate over time or save the files on the hard drive in the
signal test directory (C:\Documents and Settings\[your_user_name]\My
Documents\Molecular Devices\ScreenWorks\MySignalTests) as a *.sig file to open in third-
party spreadsheet software.

Note: The Yellow Plate Signal test and image display results are not saved within a
data file.

Note: The relative standard deviation should be less than 5% if you perform the flat-field
calibration using the flat field calibration plate of the respective plate format (96-wells,
384-wells, or 1536-wells). See Flat Field Calibration on page 102.

Running Protocol Signal Tests

Use the Protocol Signal test to optimize the camera settings you use in florescence assay
protocols. You can save the adjustments made to the settings in this test within the protocol.
See Optimizing Optics Hardware on page 114.

Tip: For the HS EMCCD camera using the High-Speed or the Sensitivity camera mode,
run a Protocol Signal test to determine the saturation level for the biology and adjust the
exposure settings accordingly. This is important because, after a 4 times overexposure
increase, there are no over saturation warning messages from this camera. Start with
average RFU numbers 2,000 to 10,000. Any higher could risk saturation.

Note: Although both Fluorescence and Luminescence are available, there is no easy
way to test signal strength in the Luminescence read mode. Do not run a Luminescence
signal tests.

To run a fluorescence protocol signal test:

1. Place the cell plate on the stage in the read position.
2. Open the fluorescence assay protocol to test.

3. Click Protocol Signal Test.

4. Click Test Signal.
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5. Review the results and adjust the settings in the Protocol Signal Test dialog. Depending on
the camera and the read mode, different parameters are available to adjust the signal
strength. See Signal Test Dialog on page 45.

6. Depending on the range of values in the results, decide either to run the experiment or
change the Excitation Intensity, Exposure Time, or Camera Gain settings.

Tip: For a calcium mobilization assay, you should start between 200 to 1,500 counts.

Note: For the HS EMCCD camera, after a 4 times overexposure increase, there are
no warning messages.

7. Click Update to apply the new settings and click Test Signal to recheck them.
8. Click Save.

Determining Protocol Saturation Levels for the HS EMCCD Camera

When you use the HS EMCCD camera High-Speed camera mode and Sensitivity camera mode,
after about a 4x overexposure level increase, no saturation warning appears. This is a problem
to detect when the image measurements are saturated, and the system cannot give a reliable
saturation warning for grossly overexposed well signals. See Understanding
HS EMCCD Camera Protocol Saturation on page 32.

While you create a protocol that uses the HS EMCCD camera High-Speed camera mode or
Sensitivity camera mode, run a Protocol Signal test using a cells test plate to determine the
optimal exposure levels.

To determine the optimal exposures for the biology using High-Speed and Sensitivity camera
mode:

1. Prepare a test plate to check for saturation of the maximum signals with the Protocol Signal
test. See Running Protocol Signal Tests on page 105.

2. Start with an initial estimated exposure setting, based on experience or as recommended in
the FLIPR Penta High-Throughput Cellular Screening System Protocol Guide, then adjust
the exposure to keep the maximum signals below saturation.

Tip: The gain factors are approximately linear, so reducing the gain by half is similar
to reducing exposure time by half.

3. Click Test Signal to see the exposure setting results.
4. If a saturation message displays, reduce the exposure by a factor of 4x and test again.
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5. If a saturation message does not display, click Image Display, and do the following:
See if the image does not show bright wells, which confirms that you are below
saturation.

Tip: If you are not sure, reduce the exposure by 2x and test again to verify.

See if the image is blooming. If yes, reduce the exposure by a factor of 8x and test
again.

See if the image is reversing, showing wells with dark centers and bright outlines. If yes,
reduce the exposure by a factor of 4x and test again.

6. When the test which is below the saturation level, adjust the exposure linearly to give an
average value that matches the target exposure. Keep the maximum signal below 43,000
counts.

Tip: If the experiment could have brightness that exceeds the signal test sample
plate, then reduce the exposure accordingly so that the brightest signal does not
exceed 43,000 counts.

7. Leave enough room above the starting levels to measure the experiment without camera
saturation.

Tip: If you do not expect the signal to drop during the experiment, start as low as you
can to give enough room for the signal to rise without saturation.

8. Click Save.
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Chapter 5: Running Experiments

The following sections provide a starting point to set up and run a kinetic cell-based assay.
Refer to the FLIPR Penta High Throughput Cellular Screening System Protocol Guide for details.

Preparing Cells for Adherent Assays

Location of Cells in the Plate

The excellent signal-to-background noise ratio of the FLIPR Penta System is made possible by
the instrument’s bottom illumination and detection system. The read plate is illuminated by the
LED modules at an angle approximately 45. You should have cells located at the bottom of the
wells during an experiment. Adherent cells are typically grown overnight in the cell plate,
whereas non-adherent cells are seeded either the night before, on a coated plate, or the day of
an experiment and then centrifuged.

Cell Densities

Cell densities used in fluorescence assays vary because each cell type has different
requirements. Cell densities range from 20,000 to 80,000 cells per well for 96-well plates,
5,000 to 20,000 for 384-well plates, and 1,500 to 5,000 cells per well for 1536-well plates.
Non-adherent assays require higher cell densities.

It is necessary to optimize the cell seeding density so that a uniform, 80–90% confluent
monolayer is formed on the day of the experiment. Over confluent or under confluent cell
monolayer may result in reduced cellular response to the test compounds.

You should seed cells that are maintained in culture at sub-confluent levels at relatively low
densities. Depending on the individual cell line, attachment matrix-coated plates (such as the
poly D-lysine coated plate) might be required to improve adherence and minimize cellular blow-
off during compound addition. Perform assay development to determine the optimal seeding
density and plate environment for each cell line.

Cell Seeding

Use a multi-channel pipettor or a liquid dispensing system to seed cells in plates. Seed 96-well
plates by either manual or automatic methods. Use an automatic instrument to seed a 384-well
or 1536-well cell plate rather than seeding manually. Thin needles used in automatic liquid-
dispensing instruments prevent air bubble formation in well bottoms which is a problem
commonly encountered when cells are seeded with a manual pipettor.

Cells are seeded in clear, flat-bottom, black-wall or 96-well, 384-well, or 1536-well, tissue
culture treated plates. A flat plate bottom ensures that cellular fluorescence is localized to a
single horizontal plane. Adherent cells typically are seeded one day before an experiment.
Non-adherent cells are either plated one day before on a coated plate or the day of an
experiment. Carry out all steps in the black-wall 96-well, 384-well, or 1536-well plate.

Note: You can use flat-bottom, clear-wall tissue culture plates with the FLIPR® Calcium
Assay Kit and Membrane Potential Assay Kit. Depending on signal intensity, you can use
either black-wall or white-wall plates when you run aequorin assays.

5
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Starting the System

To ensure proper system function, power the instrument well before you begin an experiment.
The camera requires about five minutes to reach operating temperature. If you heat the plate
stage, click the Instrument menu and select Manual Operation and then select Temperature
Control. Allow 15 minutes for complete temperature equilibration. View the Instrument Status
panel for the stage temperature.

To start the system:

1. Verify that the appropriate pipettor head, wash reservoir, LED banks, and filters are in place
before you power on the instrument. See Exchanging Hardware Components on page 140.

CAUTION! Do not attempt to change pipettor heads, wash reservoirs, LED banks
and filters while the instrument is running. You must exchange all features in the
appropriate instrument mode. When the instrument is started for the first time after a
re-configuration of LEDs or emission filters, optics calibration is required.

2. Follow the procedure in Powering On the System on page 16.

Checking the System

A yellow signal test plate is provided with each corresponding pipettor head supplied with the
system. A signal test plate only needs to be run once a day unless you change system
components such as pipettor heads or LEDs.

CAUTION! To avoid damaging the yellow signal test plates. Avoid scratching the plate
bottom because scratches can affect the standard deviation. Store the plates in a safe
place away from bright light on an even surface.

Once a day, do the following system checks before you run the first assay plate:

1. Make sure that the system is turned on and the camera is cooled to proper operating
temperature.

EMCCD camera: -70°C (-94°F) ± 2°C
HS EMCCD camera: -70°C (-94°F) ± 2°C

2. Run a Yellow Plate Signal test to ensure the system is operating according to specifications.
See Running the Yellow Plate Signal Test on page 104.

Dye Loading Cells for Fluorescence Assays

Many cell-based responses require fluorescent dye loaded in cells to bind or change
conformation in the presence of a ligand. These changes are monitored through a shift in
emission wavelengths and captured by a CCD camera. Calcium sensitive dyes, such as the
ones used in the Molecular Devices FLIPR Calcium Assay kits, monitor intracellular calcium flux
assays, or environmentally sensitive for membrane potential assays. Depending on the
application evaluated, dye loading typically lasts from 30 minutes to 2 hours, at either room
temperature or 37°C (98.6°F).
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Dye Loading Duration and Temperature

Optimal dye load time depends on the cell type and presence of an anion exchange inhibitor.
For most cell lines, especially for calcium mobilization assay development, start with a 60
minute to 120 minute load time at 37°C (98.6°F).

CAUTION! Avoid exceeding the optimal load time. If anion exchange inhibition does not
enhance dye load conditions, it should not be used.

Tip: If loading for 30 minutes yields an acceptable fluorescence signal, as has been
observed for some cell lines, use a shorter load time. Incubation at room temperature
can work as well or better than 37°C (98.6°F).

Preparing Source and Compound Plates

Preparation Time for the Source Plate

Depending on assay complexity, source plate preparation time may vary. To avoid conflicts,
plan the experiment carefully to ensure source plates are ready before dye loading is complete.

Recommended Source Plates

Achieve compound conservation by reducing dead volumes and minimizing source plate
adherence. Reducing source plate adherence help to ensure proper compound concentrations
are delivered to a read plate. Use polypropylene plates for this purpose because they are
solvent-resistant, can withstand repeated freeze-thaws, and have a low retention. Proteins are
less likely to adhere to polypropylene plates rather than polystyrene surface.

Manufacturers offer a wide selection of plate bottom shapes (U-, V- or flat bottom) to lessen
dead volumes. Dead volumes decrease as you move from a flat to U- to V-bottom plates.
Contact the plate manufacturer for the dead volume in the plates you use.

Concentration of Compounds in the Source Plate

Compound concentrations are prepared based on ratio of addition to initial well volume of the
read plate. Common concentrations are 3X, 4X, or 5X because ratio of addition to read plate
volumes are 1:3, 1:4, or 1:5, respectively. Volume of addition is dependent on compound mixing
efficiency, cell adherence, and kinetics of cellular response. Perform assay development to
determine optimal addition volume and concentrations prior to screening.

Addition and Mixing of Compounds to the Cell Plate

Prompt mixing is required to initiate robust cellular kinetics associated with signal transduction
assays. Proper addition parameters (for example, dispense speed, height, and volume) initiate a
rapid response upon addition. Slow signal increases or variation in signal between wells may be
signs that mixing is too slow or not uniform. Optimal addition parameters typically consist of a
fast dispense speed, low pipettor height, and large addition volume. Assay optimization is
recommended to determine the proper assay conditions before you run a screen.
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If you do not optimize addition parameters, artifacts occur that affect data quality. One common
problem is adding compounds too rapidly. Weakly adherent cells may dislodge from the
monolayer, causing a decrease in fluorescence upon addition. you can reduce cell
displacement by slowing dispense speed while decreasing addition volume and increasing
height. Larger dispense volumes mix rapidly because they encounter less surface tension as
compared to smaller volumes. Small sample volumes are less disruptive to a cell monolayer and
reduce compound consumption. To avoid dislodging weakly adherent cells, add compounds in
small volumes and at relatively low dispense speeds.

Tip: Mixing is not typically used during addition in calcium or membrane potential assays.
Signal artifacts, such as additional noise in the fluorescent trace, can be attributed to cell
disruption induced by rapid pipettor movement. It is not uncommon to use mixing before
aspirating, to resuspend reagents that have fallen out of solution in the source plate.

For temperature-controlled assays, bring cell and source plates to temperature outside of the
instrument. It takes approximately 45 to 60 minutes in a 95% humid, CO2 incubator (15 minutes
in a heating block) to warm plates to equilibrium at 37°C (98.6°F).

Compound Plates for Suspension Assays

Unlike adherent assays, suspension cell assays require cell addition directly to the compound in
the read plates. Prepare compounds at 2X concentration in the same diluent you use for cells,
since equal volumes of cells are added to the read plate that contains the compound.

In 384-well assay add 25 µL cells to 25 µL 2X compound; in a 1536-well assay 2 µL add cells to
2 µL compound. Store plates covered to prevent evaporation.

Setting Up Assay Protocols

Pre-configure the protocol (*.fmp) files to reduce time and ensure consistent screening
parameters. Define and save protocol files for each cell line, project, or user. The ScreenWorks
Software lists the last 10 files (6 data and 4 protocol) in the bottom portion of the File menu.

A protocol file defines the following experiment parameters:

Instrument conditions, for example, read mode, plate positions, file names, and file storage
Assay steps, for example, fluid transfer and reads
Analysis options, for example, groups, corrections, and export parameters

To create a new protocol:

1. Select the Process tab. See Process Tab on page 59.
2. Do one of the following to add the assays steps:

To place the new process at the end of the protocol list, drag and drop the process
anywhere in the Experiment window.
To place the new process in the protocol list, drag and drop the process where you
want it. The software prompts you if the position is invalid.

3. When the Configuration screen displays, adjust the settings. See Understanding Processes
on page 60.

4. Repeat the previous steps until you finish building the protocol.
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5. Click the Analysis process and define the analysis parameters See Analysis Process on
page 65:

Click Grouping to define grouping parameters.
Click Correction to define correction parameters.
Click Export to define export parameters.

6. Click on other process icons to open the Configuration screen and make changes.

Note: When you use the HS EMCCD camera with a fast read time interval value,
depending on the Protocol > Settings > Edit Read Mode > Camera Mode setting, the
plate matrix panel update may delay until the end of the data acquisition.
Specifically, the following settings cause the plate matrix panel to update at the end
of the data acquisition:
For Camera mode High-Speed with a Read Time Intervals setting of 0.018 seconds
or shorter.
For Camera mode Normal or Sensitivity with a Read Time Intervals setting of 0.029
or shorter.

7. Click the File menu and select Save to display the Save As dialog.
8. In the File Name field, enter the protocol name.
9. Click Save. Protocol files save as a *.fmp file. The default Save In location for the protocols

is C:\Documents\Molecular Devices\ScreenWorks\MyProtocols.
10. Run the experiment.

Refer to the FLIPR Penta High-Throughput Cellular Screening System Protocol Guide for details.

Optimizing Optics and Fluid Dispensing

Optimizing Hardware Settings

Prior to screening, optimize the following hardware components for signal output and
detection:

Excitation intensity
Exposure time
Number of reads
Camera gain for EMCCD cameras
Pipettor height
Dispense speed
Dispense volume
Cell parameters for suspension assays
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Optimizing Optics Hardware

Optimization helps amplify weak signals or reduce saturation. Modifications to read settings
might not alter the quality of the data because it only regulates the amount of light emitted or
detected by the system. For instance, doubling the excitation intensity doubles the RLUs the
system detects, but the signal-to-noise ratio and Z-factor can remain the same.

To optimize the fluorescence signal:

1. Place the cell plates on the read positions.
2. For Camera mode Normal, start with the following excitation intensity, camera gain, and

exposure time settings to measure basal fluorescence signal. The read interval is 1.0
second.

Camera Type Calcium Assay Membrane Potential Assay

EMCCD HS EMCCD EMCCD HS EMCCD

Excitation wavelength (nm) 470–495 470–495 510–545 510–545

Emission Wavelength (nm) 515–575 515–575 565–625 565–625

Excitation Intensity (%) 50 40 50 50

Exposure Time (s) 0.4 0.05 0.4 0.02

Camera Gain 130 6.5 50 4.0

Basal Fluorescence Signal Camera Settings

3. Click Protocol Signal Test to evaluate the basal fluorescence signal. The fluorescence
signal for intracellular calcium assays varies depending on the camera and settings. Look
for the following fluorescence counts:

EMCCD camera: 200 – 1,200
HS EMCCD camera: 4,000 – 6,000

4. If the basal fluorescence signal is substantially out of these ranges, adjust the excitation
intensity, exposure time, or gain.

To adjust the basal fluorescence:

Basal fluorescence too low:

Increase the Excitation Intensity - During the assay, the excitation intensity ranges between
20% and 100%.
Increase the Exposure Time - When you increase the exposure time, you must increase the
read interval to a minimum of exposure time + 0.1 s. It takes 0.1 s to integrate the data.
Increase the Camera Gain

EMCCD camera: The gain varies between 1, extremely bright fluorescence, to 240,
luminescence.
HS EMCCD camera: The gain varies between 1 and 128.

Basal fluorescence too high:

Decrease the Excitation Intensity
Decrease the Exposure Time
Decrease the Camera Gain (EMCCD and HS EMCCD camera)
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Adjusting Pipettor Height

To ensure prompt compound delivery, adjust the pipettor height. Pipettor height is based on
pipettor mechanics and the physics of liquid. For fluorescence an air gap, called the hold
volume, is drawn into the tips after fluid aspiration from the source plate. This air gap ensures
fluid does not leak out during pipettor movement. The hold volume is the first item to leave the
pipette tip during dispense and enters the target well as a bubble. These bubbles can cause
random light reflections and spurious signals. To avoid bubbles, dispense fluid with tips just
above, but touching the initial well fluid level. This leaves the tips touching the meniscus after
the addition has been completed to ensure complete sample dispensing.

Note: For luminescence suspension assays, no hold volume is recommended along with
low and fast addition.

If pipette tips are in the air at the end of fluid delivery, a drop can form on the tip end due to
surface tension which results in reproducibility problems. Set the pipettor height to just above
but touching the starting fluid volume in the wells.

The fluid surface in a 384-well or 1536-well plate is a deeply curved meniscus. Set the pipettor
height somewhere below the starting fluid volume for the 384-pipettor. There is no air gap with
the 1536-pipettor.

Adjusting Fluid Dispensing Speed

Default dispense speed is 50 µL/s, 20 µL/s, and 2 µL/s when you dispense to 96-well, 384-well,
and 1536-well plates respectively.

Cell Conditions 96-Well Plate

(µL/s)

384-Well Plate

(µL/s)

1536-Well Plate

(µL/s)

Slow dispense speed for weakly adherent cells or

non-adherent cells.

10–50 5–20 1–6

Fast dispense speed for strongly adherent cells. 100–200 25–50 5–10

Recommended Fluid Dispense Speeds

You must determine these values for each cell type, but you should dispense as fast as possible
to enhance mixing of the compounds in the wells. The trade-off is that the pipetting speed must
not be so forceful that it dislodges cells from the well.

Optimizing Fluid Volume

The fluid volume parameters have the following range:

96-well plate = 5 – 200 µL
384-well plate = 1 – 25 µL
1536-well plate = 0.5 – 3 µL

Large volumes mix more rapidly into the wells than smaller volumes. Smaller sample volumes
cause less disruption to the cell layer and allow you to use the same source plate for multiple
cell plates. To avoid dislodging weakly adherent cells, you should add smaller compound
volumes to the cell plate and the pipettor should dispense the compounds at a relatively low
speed.
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Optimizing Pin Tool Delivery

To ensure proper transfer of compound using a pin tool to the target plate, evaluate the
following factors during assay development. Control and standardize these factors for an
application to help deliver reproducible volumes:

Pin diameter
Surface tension of the liquid being transferred
Surface tension of the pin
Speed of removal from source liquid
Speed of pin striking recipient plate
Depth to which the pin is submerged in the source plate
Depth to which the pin is submerged in the target plate
Volume of slot in pin
Surface tensions of plate and dwell time

Note: The FLIPR Penta instrument and the FLIPR Tetra instrument use the same pin tools.

For more information regarding optimization of pin tools, contact:

V&P SCIENTIFIC, INC. 9823 Pacific Heights Boulevard, Suite T San Diego, CA 92121

800.455.0644

sales@vp-scientific.com

Starting Assay Runs

To start the assay:

1. Check the Experiment screen to verify that the experiment summary is accurate and that
the correct protocol file is used.

2. Verify the plates and tips are loaded in the instrument.
3. Save the protocol.

4. Click Run on the toolbar to start.

CAUTION! The upper and lower doors lock before any part in the
FLIPR Penta System moves. These doors must remain closed until the end of the run,
including through the duration of the pipettor tip wash.
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Chapter 6: Exporting Data

You can automatically export data when a protocol runs, and export already acquired data. Data
exports as ASCII text format files with a separate file for each measurement configuration. You
specify the folder in which to write the output files. The default export folder is: C:\Documents
and Settings\[your_user_name]\My Documents\Molecular Devices\ScreenWorks\MyData

To configure the data export:

In protocol files, on the Analysis screen, click Configure Auto Export.

For data files, click the File menu and select Export, and then select either File or Batch
Export.

Note: Auto-Export and Batch Export do not support the ScreenWorks® Peak Pro™
Software Version 2.0.

The File Export dialog has the following tabs:

Files - Export directory setting or batch files selections.
Time Sequence - Exports time point measurements for each read mode. The measurement
values apply the corrections you configure in the Correction dialog. If there are two read
modes and you select ratiometric options in the Correction dialog, you can export the ratio
for each time point. Files have a *.seqn extension, where n increments for each export file.
Statistics - Exports averages, maximums, and other kinetic reduction values for the
numbers of reads for each well. Files have a *.statn extension, where n increments for each
export file.
Peak Pro 2.0 Statistics - You must run the analysis in the Peak Pro 2.0 software module
before the export. This export works the same way as statistics. See Exporting Data with
Peak Pro 2.0 Software Module on page 135.
Group Statistics - Exports the group statistical values for the numbers of reads for each
group and are based on the kinetic reduction settings you define. Files have a *.gstatn
extension, where n increments for each export file.
Peak Pro 2.0 Group Statistics - You must run the analysis in the Peak Pro 2.0 software
module before the export. After you run the analysis, this export works the same way as
Group Statistics. See Exporting Data with Peak Pro 2.0 Software Module on page 135.

CAUTION! Data you create in ScreenWorks Software Version 2.0 cannot be viewed or
exported by ScreenWorks Software Version 5.x.

6
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Exporting Time Sequence

Use the Export Time Sequence tab to configure parameters for export of time sequence data.
The export files contain a value for every read interval for each well, for the read mode or ratio
you select. This contrasts with the Statistics file, which contains one kinetic reduction per well.

Option Description

Enable Select this check box to create a time sequence export file.

File Name Options Select Use Name of Data File to export files with the data or protocol file name,

with *.seqn extension, where n is an integer.

Select Use User Defined Name to enter the name of the export files (maximum of

25 characters). Files have a *.seqn extension, where n is an integer.

Data Format Show Labels - Select this check box to include information about the processing

options you select (for example, name of *.fmd file and well labels). Any corrections

prior to export (e.g., negative control correction) are reported at the top of the

exported ASCII file.

Decimal Places - Select 2, 3, or 4 decimal places for the data export. This setting

applies only if that number of decimal places exist in the data.

Order of Well Data - Select Column to sequence data by column or select Row to

sequence data by row. Set this in accordance with the way the spreadsheet or

database handles well data.

Order Time Data - Select vertical or horizontal order of the data.

Misc. Parameters Select the check box for each parameter and group statistic to export with the data.

Number of Files Add Statistic - Adds a statistic file to create from the same data set. For data

created in 384-well or 1536-well formats.

Read Mode - Enter the read mode (or ratiometric data) from which to export data.

From Quadrant - Select the quadrant from which to export or select to export data

from all quadrants. This allows you to export data from one plate into four different

spreadsheet files.

Time Sequence Options
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Exporting Statistics

Use the Export Statistics tab to configure kinetic reductions, averages, maximum, and minimum
values, for the number of reads within each well. You can configure multiple kinetic reductions.
Each creates a separate export file where only one value reports per well.

Option Description

Enable Select this check box to create a statistic export file.

File Name Options Select Use Name of Data File to export files with the data or protocol file name,

with *.statn extension, where n is an integer.

Select Use User Defined Name to enter the name of the export files (maximum of

25 characters). Files have a *.statn extension, where n is an integer.

Data Format Show Labels - Select this check box to include information about the processing

options you select (for example, name of *.fmd file and well labels). Any corrections

prior to export (e.g., negative control correction) are reported at the top of the

exported ASCII file.

Decimal Places - Select 2, 3, or 4 decimal places for the data export. Your setting

applies only if that number of decimal places exist in the data.

Order of Well Data - Select column to sequence data by column or select Row to

sequence data by row. Set this in accordance with the way the spreadsheet or

database handles well data.

Misc. Parameters Select the check box for each parameter and group statistic to export with the data.

Number of Files Add Statistic - Adds a statistic file to create from the same data set. For data

created in 384-well or 1536-well formats.

Compute - Select a kinetic reduction type. See Kinetic Reduction Types on page 67

Start Read - Enter the first read number to be included in the kinetic reduction.

End Read - Select the last read to include in kinetic reduction. This can equal the

Start Read to extract values from a single read.

Read Mode - Enter the read mode (or ratiometric data) from which to process the

data.

From Quadrant - Select the quadrant from which to export or select to export data

from all quadrants. This allows you to export data from one plate into four different

spreadsheet files.

Statistics Options
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Exporting Group Statistics

Use the Export Group Statistics tab to configure a group statistics export report, for example,
average, standard deviation, and z-scores, based on the kinetic reduction types you define for
the number of reads you set up on the Analysis screen.

Note: If you do not define groups on the Analysis screen, an empty report exports.

Option Description

Enable Select this check box to create a group statistic file.

File Name Options Select Use Name of Data File to export files with the data or protocol file name,

with *.gstatn extension, where n is an integer.

Select Use User Defined Name to enter the name of the export files (maximum of

25 characters). Files have a *.gstatn extension, where n is an integer.

Misc. Parameters Select the check box for each experiment parameter to export with the data.

Number of Files Add Statistic - Adds a statistic file to create from the same data set.

Kinetic Reduction - Select the reduction to apply to the kinetic data traces to

export. See Kinetic Reduction Types on page 67.

Start Read - Enter the first read number to use to determine the kinetic reduction.

End Read - Select the last read to use to determine the kinetic reduction.

Read Mode - Select the read mode to apply the kinetic reduction.

Export Group Statistics Options
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Batch Exporting

Note: Batch export does not support the separately licensed analysis module
ScreenWorks Peak Pro Software Version 2.0.

Click the File menu and select Export and then select File or Batch Export. Manual export
allows you to export the same files you define above.

Option Description

Export Directory Define where to send export files. The default export folder is:

C:\Documents and Settings\[your_user_name]\My Documents\Molecular

Devices\ScreenWorks\MyData

Batch Export

Following Files

Click Add to display the Open File dialog to select the data files to export. Shift +

Click or Ctrl + Click to multi-select.

Correction Options Select Use Corrections Already Applied in Each Data File to apply the corrections

you save with each data file during export.

Select Use Same Corrections for All Files to apply and save new corrections to all

data files. Useful when you export all data files with same parameters or save the

same correction to multiple data files. See Corrections on page 75.

If an error occurs

when you export a

file, do the following

Select Put Up an Error Message and Let Me Decide What to Do to allow you to

decide how to proceed when an error occurs.

Select Skip the File to not include the data in the export and continue to export

data. The option to write the error to a log file is available.

Batch Export Options

When you batch export data, the export files vary depending on the options you select in the
individual export statistic, time sequence, and group statistic sections. For a single export file
from each data file to export, select Use Name of Data File in the section to export. Export files
you create with this method are labeled with the name of the data file from which it was created.
For a single export file that contains information from multiple data files, select Use User
Defined Name in the section. All exported information combines into one file labeled with the
name you enter. When you open the file the individual data file names from which the
information was exported display as the header for each data set within the export file.
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Chapter 7: ScreenWorks Peak Pro Software Version 2.0

The ScreenWorks Peak Pro Software Version 2.0 requires the purchase of a separate module
license after a 14-day trial, which adds advanced peak detection and event characterization
measurements and analysis functionality. This data analysis capability is useful with
cardiomyocyte and neuronal protocols. Contact your Molecular Devices Sales Representative
to purchase. Detect and measure the activity of biological events that exhibit several
components of interest, for example, multiple excitations, regular or irregular anomalous events
such as early after depolarization-like events (EAD), irregular amplitudes or frequencies, and
migrating threshold levels.

Note: For relatively fast events that you acquire with long sampling intervals, use
ScreenWorks Peak Pro Software Version 1.0. See Kinetic Reduction Types on page 67.

The Peak Pro 2.0 software module algorithm reduces false detections without the need to
condition the raw data. Use search vectors to optimize the lengths of the vectors for specific
data sets. They are generated with the midpoint of the vector at each point in the data set and
are fitted by linear regression such that the slope at each point is known and the ups and downs
of the adjacent noise events are dampened, which reduces the contribution of random noise to
the overall movement of the vector.

The following screen shots display how adjusting the search vector length and specifying the
minimum noise and amplitude values causes very few false events to appear.

In a moderately noisy data set with a search vector length of 3 the results display a lot of false
peaks.

Search Vector Length of 3 is Noisy

Each marker represents a peak. The first peak of each event is a blue dot, and the subsequent
peaks are green diamonds.

7
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Change the search vector length to 11 and run the analysis again for more precise data.

Search Vector Length of 11 Reduces Noise

The vector length did not need to be increased by much to see a substantial noise reduction
improvement. The major peaks and minor peaks now appear to be real biological events.

Interface Overview

When you start the ScreenWorks Peak Pro Software version 2.0, a dialog displays with the open
data file name in the title bar and three tabs.

To open the Peak Pro 2.0 Analysis dialog:

1. Click the File menu and select Open then select Data Files to display the Open dialog.
2. Select the data file name and click Open.
3. In the Multi-Well graph, select individual wells, rows, or columns to analyze.

4. Click to display the Peak Pro 2.0 Analysis dialog. See Running Peak Pro 2.0 Software
Module on page 130.

Options Tab

Use the Options tab to define peak detection search settings and data range settings.

Event Polarity - Specifies the direction of the signal for detection, either Positive or
Negative.

Tip: Negative polarity is rarely needed.

Set Default Levels - Resets the threshold, trigger, and baseline values to the default
positions.
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Search Vector Length - Determines the sensitivity of the peak detection. Long vector
lengths filter out noise. Short vector lengths detect lower amplitude transitions. The
software generates the search vector from a linear regression across forward and
backward points, centered on the mid-point of the vector, and computed for each data
point. This vector slides along the data to check the slope at each point and determines
peaks and valleys by noting the direction of the slope.

Tip: This is the most important variable for good peak detection. You can enter a
different vector length for each well.

Select Auto Assigned Length to use the sampling rate and an estimate of the noise
amplitude to compute a vector length for each data point. This determines the vector
length suitable for most data sets.
Select Same Length For All Wells to enter one set vector length for the analysis of all
the wells you select.
Select Well-By-Well to enter multiple set vector lengths for the analysis of wells. Each
well can use a different vector length setting.

Dynamic Threshold - Select this check box to set a lower limit for peak detection and reject
all events below this threshold. Amplitude is relative to the baseline.

Apply to All Wells - Select this check box to apply the threshold you enter to all wells.
Clear this check box to use the value for an individual well.

Trigger Level - Enter when detection starts, with the first crossing of the level, and when the
event ends, with the level re-crossing. By default, the level is positioned at 10% above the
baseline, relative to the data range. Events that peak below the trigger level are ignored.
You can set this for each well. The signal values are relative fluorescence units (RFU).

L - Enter the left end of the trigger level line.
R - Enter the right end of the trigger level line.
Lock L/R - Select this check box to lock the left and right ends so the level line moves
as a unit when you change the left or right value.

Note: An event is the signal crossing the trigger level in both directions. The
amplitude of the event is measured relative to the baseline. The detection of the left
and right antipeaks of the event is not limited by the trigger level and these
measurements can extend as far as the baseline. The event duration is measured as
the distance between the two antipeak positions.

Baseline Level - Enter the absolute end of the detection range. Amplitudes are measured
relative to the baseline level and not the antipeak value. The signal values are relative
fluorescence units (RFU). The algorithm adapts to sloping baselines. In software version 5.1,
the new estimation algorithm takes into account the general slope of the baseline by
detecting and fitting presumptive baseline points from several segments of the data. The
new detection algorithm assigns a search vector length that is based on a number of
characteristics of the data.

L - Enter left end of the baseline level line.
R - Enter the right end of the baseline level line.
Lock L/R - Select this check box to lock the left and right ends so the level line moves
as a unit when you change the left or right value.
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Data

Well - Lists the wells you select in the plate matrix from the Analysis dialog. This selects the
graph that displays in the Detail Graph pane.
Process All Selected Wells - Select this check box to include the analysis of the wells you
select in the Well list. Clear this check box to analyze only the well visible in the Well field.
Select wells in the Well list and click Exclude for exceptions before you analyze all wells.
Full - Select this check box to select the whole data range. Clear this check box to analyze
the data in the wells listed between the From and To fields.
From - Enter the beginning point of the data range to analyze.
To - Enter the end point of the data range to analyze.
Apply to All Selected Wells - Select this check box to apply the data range you enter to all
wells in the list.

Event Rejection

Use Event Rejection to have the software reject the amplitudes relative to the baseline that are
lower than what you specify. The software also rejects events with trough-to-trough times that
are shorter than the duration you specify.

Apply to All Selected Wells - Select this check box to apply the amplitude and duration
values you enter to the data from all the wells you select. Clear this check box to use the
value for each individual well.
Min Amplitude - Select this check box to enter the lowest amplitude RFU value, measured
from the baseline, for the acceptance of an event.
Min Duration Select this check box to enter the shortest duration ms value, duration, as
measured between the left and right antipeak values.

Noise Rejection

Use noise rejection to have the amplitude that is relative to the right trough on the rising phase
and the left trough on the decay phase. The software rejects events with amplitudes lower than
what you specify and events with right to left trough times that are less than the noise duration.

Auto - Select this check box to have the software measure the noise level of the data and
average the difference between sequential amplitude values of all amplitudes within a
distance of 10% of the baseline. The software rejects outliers using interquartile ranges. The
software uses noise estimate to determine an approximate default noise level.
Apply to All Selected Wells - Select this check box to apply the amplitude and duration
values to the data from the wells you select. Clear this check box to use the value for each
individual well.
Min Amplitude - Select this check box to enter the lowest amplitude RFU value before the
software rejects an event as noise. The measurement is taken between the lowest antipeak
amplitude and the peak amplitude.
Min Duration - Select this check box to enter the lowest duration time value before the
software rejects an event as noise. The measurement is taken between the antipeak time at
the lowest antipeak and the time at the equivalent amplitude opposite the peak.
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Measurements Tab

Use the Measurements tab to define the properties of an event that you can display in the Peak
Pro 2.0 Statistics pane.

Peak Pro 2.0 Statistics Pane After Analysis With Expanded Group Data

When you run an analysis, the following measurements are calculated:

Mean Peak Amplitude - The average amplitude of the main peaks of the events detected in
the well data, measured from the peak to the baseline and expressed in relative
fluorescence units (RFU).
Number of Peaks - The total number of peaks.
Mean Peak Rate - The number of peaks per minute (PpM). For cardiac data, this is
equivalent to beats per minute (BPM).
EAD Like Count - The early after depolarization like event (EAD like) in an event. Includes
number of EAD like events, mean number of EAD like events, and number of EAD like
events S.D.
Mean EAD Like Rate - The average rate of early after depolarization like event of the events
detected in the well data, expressed in peaks per minute (PpM).
10-90% CTD - The Calcium Transient Duration is the width of a peak in seconds at various
peak heights between 10% at the top and 90% at the bottom.
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10-90% CTDP - The Calcium Transient Duration from peak position measured as a straight
line from the peak to a percentage of the distance from the peak.

Area - The area below the event measured from the baseline to the start and end of the
event as defined by the left and right antipeaks, expressed in relative fluorescence unit
seconds.

Peak Spacing - The approximate regularity of the peak spacing, expressed in seconds. The
measurement reports either uniform spacing of peaks (OK), or irregular spacing (IRREG).
Rise Slope - The rate of rise over the range, expressed in relative fluorescence units per
second.
Decay Slope - The rate of decay over the range, expressed in relative fluorescence units
per second. Computed on if there is no early after depolarization like event.
Rise Time - The time to rising phase over the range.
Decay Time - The time to decay over the range.
Linear Run Decay Slope - The slope of a straight line from the peak to a percentage of the
peak, expressed in relative fluorescence units per second.
Linear Run Slope Time - The run slope time from the peak, expressed in seconds.
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The following illustrates the measurement options and terminology:

Item Description

A Main peak amplitude

B Linear decay slope

C Main peak interval used to calculate the peak rate, expressed in peaks per minute (PpM)

D Early after depolarization like event (EAD like) intervals used to calculate the EAD like event

rate, expressed in peaks per minute (PpM)

E Rise slope

F EAD like event amplitude

G Decay slope

H Calcium transient duration (CTD)

I Calcium transient duration from peak position (CTDP90)

J Start of an event

K End of an event

L Main peak

M Early after depolarization like event (EAD like)

Measurement Terminology Illustrated
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Configuration Tab

Use the Configuration tab to display one kinetic reduction value in the Multi-Well graph for the
wells you select.

Running Peak Pro 2.0 Software Module

After you save experiment data files you can run an analysis with the ScreenWorks Peak Pro
Software version 2.0 license. The Peak Pro 2.0 software module functionality is best suited for
cardiomyocyte, neuronal and similarly fluxing assay data.

To run the Peak Pro 2.0 software module:

1. Click the File menu and select Open and then select Data Files to display the Open dialog.
2. Select a data file and click Open.
3. In the Multi-Well graph, select the wells, rows, or columns to analyze.
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4. Click to display the Peak Pro 2.0 Analysis dialog where you collate the data, compute
baselines, thresholds, optimal search vector length, and format the results for subsequent
analysis, sorting, and recording.

5. Select the Options tab to run the default settings or adjust the settings. See Options Tab on
page 124.

6. Select the Measurements tab to adjust ranges. See Measurements Tab on page 127.
7. Select In the Configurations tab and then select a statistic to Display Kinetic Reduction

Value in the Multi-Well graph for the wells, for example, display Number of Peaks.

8. Click Analyze to start the analysis.
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9. Review the results in the Detail graph. Each major peak displays a blue dot. Secondary
peaks display a green diamond.

Tip: When there are many green diamonds the secondary markers are questionably
significant. Adjust the settings so there is one major peak and few secondary peaks
per event. The major peak is the first peak in an event above the trigger level. An
event is that portion of a signal that crosses the trigger level in both directions.

Use the arrow keys to scroll through each well graph or select wells in the Well list to
examine the result.
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10. If the first marked event is a partial signal that you want to skip adjust the analysis data time
range.
a. Do one of the following:

Move the vertical start time range line in the graph.
On the Options tab, in the Data section, clear the Full check box and enter the
From starting value.

b. On the Options tab, click Analyze.

11. To reduce the number of secondary peaks, which are likely noise and not biologically
significant, adjust settings on the Options tab, click Analyze, and review the results again in
the Detail graph.

12. After you reduce the noise and identify the real biological events, you are finished with the
analysis. Click Save Settings to save the settings with data file. When you reopen the Peak

Pro 2.0 Analysis dialog, click to display the last settings as long as the data file stays
open.

13. View the results in the Peak Pro 2.0 Statistics pane where the results sort by group name.
See Grouping on page 72.

Note: Group Statistics graph functionality is not supported in ScreenWorks Software
version 5.1.
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14. Expand the Group rows and the Mean rows to display the Event rows of data.

Each main row contains the average of measurements of each event and each event row
contains the metrics of the individual peaks and measurements.

15. click Select Statistics to display the Select Statistics dialog where you select the
statistics to display and in which sequence.

Note: The Peak Pro 2.0 Statistics pane data does not save with the data file you use
for analysis.

16. To save the analysis data, do one of the following:

In the Multi-Well graph, click Export. See Exporting Data with Peak Pro 2.0
Software Module on page 135.

In the Statistics pane, click Copy Table Data to Clipboard and then paste the
delimited data into a different software application.
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Exporting Data with Peak Pro 2.0 Software Module

Exporting data from the Peak Pro 2.0 software module is similar to the standard the
ScreenWorks Software export process, except that you must run an analysis before you can
export the Peak Pro 2.0 software module data. For the standard export process, see Exporting
Data on page 117.

Note: A message displays when you click Export before you run the analysis in the Peak
Pro 2.0 software module.

CAUTION! Because this analysis is a manual process Auto-Export and Batch Export are
not supported.

To export data with the Peak Pro 2.0 software module:

1. Run the analysis. See Running Peak Pro 2.0 Software Module on page 130.

2. Click to display the File Export dialog.

3. Select the tab for the type of data export to do, Peak Pro 2.0 Statistics or Peak Pro 2.0
Group Statistics.

4. Select Enable.

Note: After the 14-day trial expires, if you did not install the ScreenWorks Peak Pro
Software Version 2.0 license, the Peak Pro 2.0 Statistics and Peak Pro 2.0 Group
Statistics tab are not available.

5. Configure the data export on the tab. See Exporting Peak Pro 2.0 Statistics on page 136 or
Exporting Peak Pro 2.0 Group Statistics on page 137.

6. Click Export to generate the data files from the active tabs.
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Exporting Peak Pro 2.0 Statistics

After you run the analysis in the Peak Pro 2.0 software module, use the Peak Pro 2.0 Statistics
tab to configure kinetic reductions for the numbers of reads within each well.

Option Description

Enable Select this check box to create a statistic file.

File Name Options Select Use Name of Data File to export files with the data or protocol file name,

with *.statn extension, where n is an integer.

Select Use User Defined Name to enter the export file name (maximum of 25

characters). Files have a *.statn extension, where n is an integer.

Data Format Show Labels - Select this check box to include information about the processing

options you select (for example, name of *.fmd file and well labels). Any corrections

prior to export (e.g., negative control correction) are reported at the top of the

exported ASCII file.

Decimal Places - Select 2, 3, or 4 decimal places for the data export. This applies

only if the number of decimal places exist in the data.

Order of Well Data - Select column to sequence the data by column or select Row

to sequence data by row. Set this in accordance with the way the spreadsheet or

database handles well data.

Misc. Parameters Select the check box for each experiment parameter and group statistic to export

with the data.

Number of Files Add Statistic - Adds a statistic file to create from the data set. For data created in

384-well or 1536-well formats.

Compute - Select a kinetic reduction type. See Measurements Tab on page 127.

Start Read - Enter the first read number to use to determine the kinetic reduction.

End Read - Select the last read to use to determine the kinetic reduction. This can

equal the Start Read to extract values from a single read.

Read Mode - Select the read mode (or ratiometric data) from which to process the

data.

From Quadrant - Select the quadrant from which to export or select to export data

from all quadrants. This allows you to export data from one plate into four different

spreadsheet files.

Peak Pro 2.0 Statistics File Export Options
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Exporting Peak Pro 2.0 Group Statistics

After you run the analysis in the Peak Pro 2.0 software module, in the File Export dialog, use the
Peak Pro 2.0 Group Statistics tab to configure group statistics, for example, average and
standard deviation, based on the kinetic reduction you define for a number of reads.

Option Description

Enable Select this check box to create a group statistic file.

File Name Options Select Use Name of Data File to export files with the data or protocol file

name, with *.gstatn extension, where n is an integer.

Select Use User Defined Name to enter the export file name (maximum

of 25 characters). Files have a *.gstatn extension, where n is an integer.

Misc. Parameters Select the check box foe each experiment parameter to export with the

data.

Number of Files Add Statistic - Adds a statistic file to create from the data set. For data

created in 384-well or 1536-well formats.

Kinetic Reduction - Select the reduction to apply to the kinetic data traces

to export. See Measurements Tab on page 127.

Start Read - Enter the first read to use to determine the kinetic reduction.

End Read - Select the last read used to determine the kinetic reduction.

Read Mode - Select the read mode to apply the kinetic reduction.

Peak Pro 2.0 Group Statistics File Export Options
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Chapter 8: Maintaining the Instrument

Do only the maintenance tasks this guide describes. Maintenance procedures other than those
specified in this guide must be done by Molecular Devices. See Obtaining Support on page 176.

Before you operate the instrument or perform the following maintenance procedures, make
sure you are familiar with the safety information in this guide. See Safety Information on page 7.

Washing Pipettor Tips and Pin Tools

The Wash Tips or Wash Pins process in the ScreenWorks Software protocols controls the
washing of the pipettor tip and pin tool you perform between fluid transfers within an
experiment, or after the last fluid transfer, to prepare tips for the next experiment. You can wash
disposable tips, as well as the 1536-tip head, and 384- and 1536-pin tools.

The washer consists of a reservoir top for the pipettor format that mounts over a wash basin.
The wash basin is connected to two solvent supply carboys and two waste carboys located on
the floor beneath the computer monitor. A basin beneath the tip washer base drains to a waste
carboy to safely remove any solvent that overflows from the reservoir. See Uninstalling Wash
Reservoir Top on page 145.

Wash solution fills the reservoir for a calibrated amount of time. Solvent then drains from the
reservoir after each wash cycle. You can configure up to five wash cycles within a single wash
process. For tips, the volume of solvent is drawn up, held for a time, and then expelled, up to 20
times. For pins, vertical motion of the tip block is used to agitate the wash solvent around the
pins. You can wash tips or pins in up to two solutions before you reuse the tip washer. When
you require additional wash solutions, use the Mix Fluid process to wash tips or pins in a boat or
reservoir, located in one of the source plate positions.

WARNING! High volumes of volatile, flammable solvents in the read chamber may
cause explosive conditions. Use of 100% isopropanol, etc., in the tip washer is
discouraged without additional ventilation. Consult your facilities expert to determine
the appropriate ventilation to avoid explosive conditions.

Pin tools are supplied with blotting stations that you load into one of the plate positions.
Configure blot pin steps in the protocol to remove fluid from the pins.

Note: A waste bottle sensor override (P/N 0700-0827) is available in the
FLIPR Penta System accessory kit to bypass the waste sensor and dispose waste in
containers other than the waste carboys.

8
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Exchanging Hardware Components

The following topics describe how to exchange hardware components in the
FLIPR Penta System.

Exchanging Pipettor or Pin Tool Head

A certified Molecular Devices Field Service Engineer does the initial installation of all pipettor
and pin tool heads. After the initial installation and calibration, you can exchange the pipettor
and pin too heads on the instrument for which they were calibrated.

Note: If you have any questions or concerns regarding the procedures, contact
Molecular Devices Technical Support support.moleculardevices.com/.

Uninstalling Pipettor or Pin Tool Heads

The following procedure uninstalls a 384 pipettor head as an example.

To uninstall a 384 pipettor head:

1. In the ScreenWorks Software, click the Instrument menu and select Manual Operation and
then select Unload Tips to unload the tips on the pipettor.

2. Click the Instrument menu and select Manual Operation and then select Change Head to
instruct the pipettor head to move over the Read Plate position.

CAUTION! Do not click Done in the dialog that opens until you complete the work on
the pipettor.

3. Open the upper front door to access the pipettor head.
4. Turn the D-Axis Knurled Nut counterclockwise until it loosens and can be lifted.

For 1536 pipettor heads only: After you loosen the D-Axis Knurled Nut, install the Pipettor
Head Guard that seats over the 1536 pipettor head plungers, by tightening the two thumb
screws. This guard protects the plungers from being damaged when you handle the
pipettor head outside the instrument.

http://www.moleculardevices.com/service-support
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5. Turn the Head Clamp Knob counterclockwise until the head is loose and can be lifted off its
mounting position.
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6. To remove pipettor head, grasp the pipettor head silver Guide Shaft, lift upward (to unseat
from Alignment Pins and to lower plunger pins allowing a lift gap) and then slide to the left
off the pipettor mount.

Note: If the pipettor head does not easily slide off, try grabbing the D-axis knurled
nut receiver and press it downward to give the pipettor head additional clearance
from the D-axis knurled nut prior to trying again.

7. Store the pipettor head in a safe location. A recommended safe location should include
placing the pipettor head in its plastic storage bag to guard for particulates.

CAUTION! Do not place pipettor heads on nose cone surfaces because this can
damage the nose cones. Store pipettor heads inverted, resting on the pipettor head
top that seat on the pipettor mount position.
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Installing the Pipettor or Pin Tool Head

The following procedure installs a 1536-pipettor head as an example.

CAUTION! Only install a head that has been calibrated for the instrument by a Molecular
Devices Field Service Engineer.

To install a 1536-pipettor head:

1. Hold the pipettor head by its silver Guide Shafts and slide it to the right over the Pipettor
Mount.
When the pipettor head is in position, it should be seated on the Alignment Pins and should
not slide off the pipettor mount without lifting upwards.

2. Tighten the Head Clamp knob by turning it clockwise.
3. For 1536-pipettor heads, remove the guard covering the 1536-pipettor head plungers by

loosening the two thumb screws.
This allows the D-axis to move freely so it can be attached to the D-axis knurled nut in the
next step.

CAUTION! If the guard is not removed before you reset the instrument, the
1536-pipettor head can be damaged.



FLIPR Penta High Throughput Cellular Screening System User Guide

144 5069582 G

4. Tighten the D-Axis Knurled Nut by turning it clockwise until tight.
If the nut does not reach its receiver threads, lift the D-axis receiver to engage the threads
and tighten the nut.

5. After the head is fastened, exchange the tip wash reservoir top to match the head format.
See Exchanging Pipettor Tips and Pin Tool Wash Reservoir Top on page 145.
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Exchanging Pipettor Tips and Pin Tool Wash Reservoir Top

After exchanging the pipettor tips or pin tool head, exchange the wash reservoir to match the
new head format.

CAUTION! Failure to match head format and wash reservoir top causes damage during
instrument operation.

Uninstalling Wash Reservoir Top

The following procedure uninstalls a 384-wash reservoir top as an example.

To uninstall a wash reservoir top:

1. Loosen both Captive Thumb Screws on reservoir top.

2. Lift the reservoir top off of the washer base.
3. Ensure the Blue O-Ring on the washer base remains properly seated. If not, reinstall the O-

ring into its O-ring groove.
4. Store the reservoir top in a safe location.
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Installing Wash Reservoir Top

The following procedure installs a 384 wash reservoir top as an example.

To install a wash reservoir top:

1. Align the appropriate format reservoir top so the Connector matches the washer base
connector. When aligned correctly, the reservoir top name (96, 384 or 1536) is located
towards the front of the instrument.

2. When aligned, use the Alignment Pins to guide the placement of the top and press the top
into position.

3. Tighten both Captive Thumb Screws to ensure the reservoir top is fastened to the base.
4. Reset the instrument.

Resetting the System After Exchanging Pipettor or Pin Tool Heads

To reset the FLIPR Penta System after exchanging a head and a wash reservoir top:

1. Make sure the head and tip wash reservoir top formats match before continuing.

CAUTION! If there is a head and wash reservoir top format mismatch, the instrument
faults and prevents all experiment runs until corrected.

2. To finish the exchanges, click DONE in the software dialog that opens when you begin the
head exchange. The instrument resets itself.

3. When the reset cycle is complete, the green Assay Finished (Unlock) light is the only
indicator light illuminated on the front of the instrument.
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Exchanging Pipettor Tips

The 96 pipettor head and the 384 pipettor head both use disposable plastic tips to transfer
fluid. The 1536 pipettor head uses a stainless-steel tip block with a disposable 1536 tip gasket to
transfer fluid. See Exchanging the 1536 Microplate Tip Gasket on page 149.

Each pipettor head is compatible only with the tip racks of matching format. The pipettor head
can only pick up a matching tip rack. For example, the 384-well pipettor head should not try to
pick up pipettor tips from a 96-well tip rack.

CAUTION! Verify that there is a matching tip rack in the Tip Load position on the
instrument deck before you run the experiment. A mismatched pipettor head and tip
rack causes a fatal error and can damage the equipment.

CAUTION! The FLIPR Penta System is only validated for use with the Molecular Devices
tips. Instrument performance and troubleshooting is not guaranteed with any other tips.

To automate pipettor tip loading for 96-well and 384-well pipettor tips:

In the protocol configuration, click the Settings menu select Assign Plate to Position and
then select Load Tips Position. See Settings Process on page 60 and Creating New
Protocols on page 96.

To load pipettor tips for 96-well and 384-well pipettor tips:

In the ScreenWorks Software, click the Instrument menu and select Manual Operation and
then select Load Tip and Unload Tip. The pipettor tips attach to the pipettor head and the
pipettor tips rack stays on the stage in Position 1.

To unload pipettor tips for 96-well and 384-well pipettor tips:

In the ScreenWorks Software, click the Instrument menu and select Manual Operation and
then select Unload Tip. The pipettor tips are removed from the pipettor head in to the
pipettor tip rack on the stage in Position 1.
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Exchanging Pin Tools

Pin tools are blocks of pins that load onto a pin tool head to transfer fluid.

Two pin tool heads, 384-well and 1536-well formats, are available for the FLIPR Penta System.
Each pin tool head is compatible only with the pin tool blocks of matching format. The pin tool
head only picks up a matching pin tool block according to the attached magnetic ID. For
example, the 384-well pin tool head does not pick up a 1536-well pin tool block. This is
designed for the component safety.

To automate pipettor tips or a pin tool block loading:

In the protocol configuration, click the Settings menu and select Assign Plate to Position
and then select Load Tips Position. See Settings Process on page 60 and Creating New
Protocols on page 96.

To load a pin tool block:

In the ScreenWorks Software, click the Instrument menu and select Manual Operation and
then select Load Tip and Unload Tip. The pin tool block is picked up and clamped to the
head using pin tool block grippers.

To unload a pin tool block:

In the ScreenWorks Software, click the Instrument menu and select Manual Operation and
then select Unload Tip. The pin tool block is placed in Position 1 of the stage and
unclamped from the pin tool head grippers.

Alternating Position 1 Use

Stage Position 1 is primarily for tip loading and unloading, but you can use this position as a
source plate position after tips are removed.

Note: Sensors indicate only the presence of an object in plate position and do not
indicate whether it is a source plate or tip rack.

Use the following procedure in both manual and robotic modes.

To use a source well plate in the stage Position 1:

1. Load tips or pins manually.
2. Remove the tip rack before you start an experiment and place a source plate in Source 1.
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Exchanging the 1536 Microplate Tip Gasket

Replace gaskets approximately every 200 cycles (1 cycle = 1 stroke down + 1 stroke up). Monitor
the gasket lifetime because it varies on the number of aspirate and dispense steps you run in
the experiment.

Installing the Gasket

To install the 1536 tip gasket:

1. Remove the gasket from its package and discard the gasket backing.

2. Place the lubricated side of the gasket down on the tip block, using the gasket recess to
guide the frame position.
When aligned, the tip block and gasket are sandwiched together until the tip block grippers
clamp into place.
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Removing the Tip Block and Gasket

During the unloading, the tip block grippers unclamp and release the gasket and tip block into
the rack assembly. When unloaded, dispose the gasket and use a new one the next time the
block is loaded. See Consumables and Accessories on page 179.

To load from Position 1 for a source well plate:

Load tip block manually and then remove the tip block before you start the experiment.
When loaded, you can place a source plate placed in Source 1 in both manual and robotic
modes.

Note: Sensors indicate only the presence of an object in plate position and do not
indicate whether it is a source plate or tip block.

Exchanging LED Modules

WARNING! During the LED exchange procedure, you have access to precision optical
components. Do not touch the surfaces of the LED filters with your bare fingers or
other objects because you can damage them.

Uninstalling LED Modules

To uninstall LED modules:

1. Open the lower front door of the instrument. When the lower door is open, power to the
LEDs is disabled.

2. Loosen the two silver Latching Clamps that secure the excitation optics module to the left
light pipe.
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3. Pull the excitation optics module down and away from light pipe to disengage the Power
Connectors on the LED modules from the light pipe. Be careful not to scratch the bandpass
filters when you pull the LED modules out of the instrument.
Remove the Foam Insert found on the rear side of the excitation optics module.

4. Loosen the two Captive Thumb Screws that hold the LED modules together and then pull
the modules apart so you can exchange them for new wavelengths.

5. Repeat for the LED module mounted to the right light pipe.
6. When separated, use the Installing LED Modules procedure to exchange LED modules. See

Installing LED Modules on page 152.
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Installing LED Modules

To install LED modules:

1. To create an excitation optics module, combine two LED banks of different wavelengths.
Align the mating pins to the respective mating hole in the LED modules you secure to each
other.

2. When aligned, push the two LED banks of different wavelengths together and tighten the
two Captive Thumb Screws with firm finger pressure.

3. Place the Foam Insert on the rear end of the excitation optics module.

Note: Make sure that the foam piece fits inside the LED Frame.
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4. Open the lower front instrument door and slide the left Excitation Optics Module into place.
Each module is coarsely self-aligning but observe engagement of the two Power
Connectors and confirm they are aligned before you apply mating pressure.

5. After you mate the connectors, engage and tighten the two Latching Clamps that secure
each module to the Light Pipe.

6. Repeat this procedure for the right Excitation Optics Module, being sure the same
wavelength modules occupy the corresponding position (upper/lower) on each side.

7. If finished, close the lower front door. If you also change filters, continue to Exchanging
Filters on page 154.

8. When you close the lower front door, a message displays "The lower door has been
opened, do you want to update optics?" Click Yes. The instrument and software:

Identifies filters and LEDs
Tests LEDs
Updates the instrument status configuration
Closes the Progress dialog when the process finishes
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Exchanging Filters

The instrument senses the filters and the Instrument Configuration window in the software
displays the filter configuration.

Three custom filter holders are available for purchase if you use filters from an outside vendor.
See Consumables and Accessories on page 179. When installed, these filters appear as 1_1, 2_
2, and 3_3 in the software protocol.

Uninstalling Filters

To uninstall a filter:

1. Open the lower front door of the instrument. When the lower front door is open, system
power is disengaged.

2. Remove the Filter Cover, located below the left LED module.

3. Use the filter tab that protrudes slightly from the filter tray to push the filter up out of its
position and remove it from the instrument. Grasp the filter by the tab.

CAUTION! DO NOT touch the filter surface.

4. Repeat Step 3 to remove the remaining emission filters.
5. After you remove the emission filters replace the Filter Cover.
6. Install new emission filters into the system. See Installing Emission Filters on page 155.
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Installing Emission Filters

The system automatically identifies the emission filter wavelengths you can select from the
ScreenWorks Software menu.

To install an emission filter:

1. Open the lower front door of the instrument and remove the Filter Cover located below the
left LED module.

2. Grasp the filter by the tab located where the filter table is and place the filter into the filter
position. Typically, this is the rightmost position 1 in the slider. Insert the rear of the filter first
to make sure it fits into the filter position. Push the tab down until the filter indexer clicks into
the position. A notch on front of the tab should align with one of the lines on the Filter Tray.

CAUTION! DO NOT touch the filter surface.

3. Repeat to install subsequent filters into positions 2 and 3.

Note: If a filter is not available, you can purchase three custom filter cassettes. See
Optics Consumables on page 181. When installed, these filters appear as 1_1, 2_2, 3_
3 in the software protocol.

4. The system identifies the emission filter wavelengths and passes the information to the
ScreenWorks Software for you to select.

CAUTION! When you use all 3 filter positions, do not duplicate wavelengths because
this causes a fault in the software.

5. After you install emission filters replace the Filter Cover.
6. Close the lower front door when you finish.
7. When you close the lower front door, a message displays: The lower door has been

opened, do you want to update optics? Click Yes. The instrument and software:
Identifies filters and LEDs
Tests LEDs
Updates the instrument status configuration
Closes the Progress dialog when the process finishes
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Exchanging the Plate Hold Down Devices

The plate hold down devices, part numbers 2300-1631 and 2300-1633, keep plates or tip racks
from lifting after aspirating, dispensing, and tip loading. Each device has an overhang that
extends over the skirt of a plate to prevent upward movement when the pipettor is removed
from the plate. The provided devices fit three different plate hold down gap sizes, 2 mm,
2.5 mm, and 6 mm, which correspond to three plate skirt thicknesses.

The 2.0 mm and 2.5 mm are incorporated in one device that rotates 90 degrees.

A second plate hold down device in the accessory kit has a 6.0 mm gap. Numbers that
correspond to the plate skirt thickness are marked on the top of the device. The device is
properly oriented when you can read the digits upright from the instrument service door.

Selecting Plate Hold Down Devices

Most plates and tip racks use the 2.5 mm device setting. Exceptions among approved plates
are the Corning/Costar plates that have a very thick 6.0 mm plate skirt and the thin 2.0 mm plate
skirt of the Greiner 1536-well plates. To determine which hold down device is most appropriate,
use the lowest hold down device that allows the plate skirt to slide under the overhang feature
freely. It is important that the overhang feature is clearly above the skirts on all plates and tip
racks that you use in a plate position or a misalignment with the pipette tips can occur.

Test the configuration after installation.
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Removing Plate Hold Down Devices

To remove a plate hold down:

1. Clear the system of plate or tips that can interfere with the position from which to remove
the plate hold down device.

2. Use a Phillips #2 or #3 screwdriver to loosen and remove the screws from the center of the
device.

3. Remove the plate hold down device.

Installing Plate Hold Down Devices

To install or reposition the plate hold down:

1. Place the device in the orientation so that the numbers appear upright when you look
through the main user access door.

2. Insert the flat head screw that originally secured the device (or a screw included in the
accessory kit) through the hole in the device and into the screw threads on the left side of
the plate retaining pockets. Tighten the screw firmly. The device is self-locating so no
additional alignment is necessary.

3. If you use plates or tip blocks with different flange heights in the same position, use the
device with the largest flange thickness.

4. Test the plates or tip blocks to use by inserting them into the plate pockets at the location in
which they are used.

5. Observe that when the plate releases it pushes to the left under the retaining device. It
should come to rest against the edge locating surfaces on the left and nearest the door.

6. Pull up on the plate gently.

Tip: You should feel a definite retaining force. A sideways movement during lifting
can cause the plate to slide out from under the retaining device and lift upward
without retention. This does not happen during instrument operation but might
require attention to avoid when you lift a plate by hand.
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Chapter 9: Troubleshooting

This chapter contains tables of symptoms and solutions to help you diagnose and correct
problems with the FLIPR Penta System. To contact Molecular Devices Technical Support. See
Obtaining Support on page 176.

Instrument Status Colors

The ScreenWorks Software handles most errors that occur when you run the
FLIPR Penta System. The status of the system is displays in the Instrument Status panel. See
Software Status Tabs on page 19.

Depending on the state of the instrument, a color icon displays at the bottom right of the
Instrument Status window.

Status Color Indication

Green Proper and open communication.

Yellow Minor communication error. To clear the error, click the Instrument menu and select Clear

Error.

Red Instrument failure. Instrument must be reset. Click the Instrument menu and select Reset.

Black No instrument communication available. This typically displays when you work in Offline

mode.

Instrument Status Colors

9
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Troubleshooting Start Up

Symptom or Error Message Possible Causes Solutions

Failed to connect to the instrument Embedded computer is not

communicating with the host

computer

Restart the instrument

Connecting to the instrument, please wait.

Will enter offline if the instrument is not

connected or if you close this dialog.

Dialog may not close immediately when

you press the Close button while the

connection is attempted.

The ScreenWorks Software is waiting

for the FLIPR Penta System to

complete initialization prior to

connecting.

Wait until the Assay Finished

(Unlocked) light is the only light

illuminated on the front instrument

panel before the software and

instrument connect.

Camera chiller subsystem not functional.

Please contact Technical Support. Can't

communicate with chiller.

Instrument cannot communicate with

the chiller.

Make sure the chiller is turned on.

Contact Technical Support.

409: Initialization halted because tips are

loaded. Please verify that the appropriate

tip rack (96 or 384 tip rack, 1536 tip block,

or 384, 1536 pin tool holder) is loaded and

select RESET.

Tips are on the pipettor head and

need to be unloaded during

instrument initialization/reset.

Place tip rack in source 1/tip loading

position to unload tips. Click the

Instrument menu and select Reset.

410: Initialization halted. Either the upper or

lower door is open. Please shut both doors

and select RESET.

The door is open during instrument

initialization/reset.

Close the upper and lower doors.

Click the Instrument menu and select

Reset.

411: Front Panel Interrupt button was

pushed while initializing. Initializing was

not completed. Select Reset when ready to

continue.

The front panel interrupt button was

pushed, stopping instrument

initialization.

Click the Instrument menu and select

Reset.

Disconnected displays in the bottom of the

Instrument Status Window.

The ScreenWorks Software is in

Offline Mode.

Click the Instrument menu and select

Go Online.

Multiple software copies are open. Close all versions of the ScreenWorks

Software before you start the

software.

Instrument timed out. Click the Instrument menu and select

Go Online.

Instrument Configuration does not show

correct components installed on

instrument.

Instrument does not have proper

components installed.

Install proper components and restart

the system.

The ScreenWorks Software is in

Offline Mode.

Click the Instrument menu and select

Go Online.

Camera Temp not in its operating

temperature range

EMCCD camera: -70°C (-94°F) ± 2°C

HS EMCCD camera: -70°C (-94°F) ± 2°C

Camera is not cooled down to

temperature.

Allow 10 minutes for the camera

temperature to cool. Make sure the

chiller is working properly.

Contact Technical Support.

Start Up Error Messages
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Symptom or Error Message Possible Causes Solutions

Chamber Temp not at correct temperature. Heated stage is not warming to

temperature.

Allow 15 minutes for the chamber to

warm to the temperature.

Contact Technical Support.

Temperature control is not ON. Turn on heated stage. Click the

Instrument menu and select Manual

Operation and then select

Temperature Control ON.

Pipettor head is in the plate after the

instrument initializes.

Instrument did not initialize properly. Click the Instrument menu and select

Reset.

Contact Technical Support.

Start Up Error Messages (continued)

General Troubleshooting

Symptom or Error Message Possible Causes Solutions

201: Upper door open Upper door (outer) is not closed. Close outer (upper) door.

202: Both upper and lower doors open Both upper (outer) and lower doors

are not closed.

Close outer (upper) and lower doors.

203: Lower door open Lower door (outer) is not closed. Close lower door.

204: Read plate position empty No plate is present in the Read

position.

Place a plate in the Read position.

205: Source 1 plate position empty No plate is present in the Source 1

position.

Place a plate in the Source 1 position.

206: Source 2 plate position empty No plate is present in the Source 2

position.

Place a plate in the Source 2 position.

207: Source 3 plate position empty No plate is present in the Source

position.

Place a plate in the Source 3.

229: Attempting to read a source only

plate. Please assign a read plate to the

read position, or if it is a read plate, go to

TOOLS, PLATE LIBRARY and define the

mask positions using the appropriate

yellow plate.

The plate selected for the read

position cannot be read because no

mask has been identified.

Use the Plate Library to convert the

plate from a source plate to a read

plate.

100: Command not found Input command is not valid. See

appended string on the error

message for details.

Contact Technical Support.

101: Invalid argument Input argument is not valid. See

appended string on the error

message for details.

Contact Technical Support.

General System Error Messages
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Symptom or Error Message Possible Causes Solutions

102: Invalid number of arguments Number of input arguments is not

valid. See appended string on the

error message for details.

Contact Technical Support.

103: Invalid start of command Start of command is not valid. See

appended string on the error

message for details.

Contact Technical Support.

104: Command invalid, system busy The system cannot act upon the

command, as the system is busy. See

appended string on the error

message for details.

Contact Technical Support.

Data buffer full The data buffer is full. See appended

string on the error message for

details.

Contact Technical Support.

106: Option not installed, command

unavailable

Pipettor head, LED, Emission Filter or

FLIPR Cycler is not installed.

Install the option to use.

Change the protocol to use the

available instrument options.

107: Command failed General failure. Contact Technical Support.

108: Command failed, system in an error

state

Minor communication error occurred. Click the Instrument menu and select

Clear Error.

109: Command failed, system not initialized Communication failed between

software and instrument.

Click the Instrument menu and select

Reset.

Turn the instrument power switch off

then on to cycle power.

Password does not match User password is incorrect. Contact your instrument administrator

for the username and password.

Input not accepted Input value is not valid (e.g., select

greater than 16 time sequence files in

the Export menu). See appended

string on the error message for

details.

Change the input value so it is within

the specified range.

302: Temperature system not functional.

Please contact Technical Support. You will

not be able to run protocols with

temperature control until it is repaired.

Can’t read the temperature sensors

for the heated stage.

Click the Instrument menu and select

Reset to see if communication can be

reconnected.

Contact Technical Support.

General System Error Messages (continued)
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Symptom or Error Message Possible Causes Solutions

Data files cannot be found Use Windows’ Find utility to search for

file names and determine where files

were saved. Default location for

ScreenWorks files is C:\Program

Files\Molecular

Devices\ScreenWorks\ Data

Hard drive fills up with data files Files unnecessarily saved with *.tif file. Discard unwanted *.tif files.

Data not archived. Create free space on the hard drive.

Image option in Experiment window is

grayed out.

Save Images not selected in Read

with TF process.

Save subsequent data with Save

Images selected in protocol.

*.tif files not found (deleted or moved)

in data folder.

You must save *.tif files in same folder

as the data to display the Image

button.

309: Unable to modify or delete selected

plate. It does not exist.

Plate does not exist. Contact Technical Support.

401: Input/Output PCB not functional.

Please contact Technical Support. You will

not be able to run protocols until it is

repaired.

Input/Output PCB not functional. Contact Technical Support.

402: Motion reports a fatal error. Please

select Reset. If this error repeats, please

contact Technical Support.

Motion reports a fatal error. Contact Technical Support.

403: Motion timeout waiting for done.

Please select Reset. If this error repeats,

please contact Technical Support.

Instrument motion timed out prior to

receiving “done” command from

instrument.

Click the Instrument menu and select

Reset.

Contact Technical Support.

404: Motion timeout waiting for echo.

Please select Reset. If this error repeats,

please contact Technical Support.

Instrument motion timed out while

waiting for an echo.

Click the Instrument menu and select

Reset.

Contact Technical Support.

405: Motion communication fault. Please

select Reset. If this error repeats, please

contact Technical Support.

Motion communication fault. Click the Instrument menu and select

Reset.

Contact Technical Support.

406: Invalid DONE response from motion.

Please select Reset. If this error repeats,

please contact Technical Support.

Invalid DONE response from motion. Turn the instrument off. Wait 15

seconds. Turn instrument on.

Contact Technical Support.

407: LCB read/write test failed. Please

select Reset. If this error repeats, please

contact Technical Support.

LCB read/write test failed. Click the Instrument menu and select

Reset.

Contact Technical Support.

General System Error Messages (continued)
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Symptom or Error Message Possible Causes Solutions

408: Plate format file fault. Please contact

Technical Support. You will be unable to

use this plate until repaired.

Plate format file fault. Click the Instrument menu and select

Reset.

Contact Technical Support.

ScreenWorks indicates the user-defined

name of the data file is invalid.

Illegal characters were used in the file

name.

Remove illegal characters from the file

name (for example, “ , ’ : ? ; ) .

User defined name includes too many

characters.

Enter 25 characters or less in the file

name.

Saturation detected One or more wells in the microplate

saturated the camera.

A saturation warning in either the

signal test dialog or on a plate prevent

you from reading the plate. You

decide whether to address the

saturation warning or proceed

forward. If multiple wells within a plate

are saturating the camera, decrease

the Excitation Intensity, Exposure

Time, or Camera Gain to prevent

saturation.

General System Error Messages (continued)
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Troubleshooting Pipettors

Symptom or Error Message Possible Causes Solutions

Cannot uninstall pipettor head The D-Axis Knurled Nut is caught on

the D-Axis receiver.

Grasp the D-axis knurled nut receiver

and press downward to give the

pipettor head additional clearance

from the D-axis knurled nut.

Pipettor head is caught on the

alignment pins.

Lift the pipettor head up prior to

moving left to lift the pipettor head off

of the pipettor mount alignment pins.

Cannot install pipettor head The Head Clamp Knob is not

tightening all the way down.

Slide the pipettor head all the way to

the right over the pipettor mount.

When installed properly on the

alignment pins, the pipettor head

should not slide left without lifting.

D-Axis Knurled Nut does not reach

receiver threads.

Lift D-axis receiver to engage threads

and then tighten the D-axis knurled
nut.

231: Pipettor head not detected. Please

verify proper installation and select Reset.

No pipettor head is present on

pipettor mount.

Install the correct pipettor onto

instrument.

Pipettor head is not installed properly. Head clamp knob may not be secured

tightly for instrument to identify

pipettor head. Reinstall pipettor head.

The open protocol may not use the

pipettor on the instrument.

Install the correct pipettor onto

instrument.

Change plate format you select in the

software to match the pipettor head.

208: Unable to load tips. Tips are already

on pipettor.

Tips are already present on pipettor. To change tips, click the Instrument

menu and select Manual Operation

and then select Unload Tips.

Exchange the tips. Then click the

Instrument menu and select Manual

Operation and then select Load Tips.

Clear the error and proceed with the

experiment if want to keep the

present tips on.

209: Unable to unload tips. There are no

tips loaded on the pipettor.

No tips are present on the pipettor

head.

Clear the error.

Pipettor Error Messages
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Symptom or Error Message Possible Causes Solutions

233: Unable to dispense. No tips loaded

on pipettor.

No tips are present on the pipettor

head.

Click the Instrument menu and select

Manual Operation and then select

Load Tips.

Change the protocol to include

loading of tips at the beginning of the

experiment.

234: Unable to aspirate. No tips loaded on

pipettor.

No tips are present on the pipettor

head.

Click the Instrument menu and select

Manual Operation and then select

Load Tips.

Change the protocol to include

loading of tips at the beginning of the

experiment

235: Unable to place tips in well. No tips

loaded on pipettor.

No tips are present on the pipettor

head.

Click the Instrument menu and select

Manual Operation and then select

Load Tips.

Change the protocol to include

loading of tips at the beginning of the

experiment

236: Unable to mix. No tips loaded on

pipettor.

No tips are present on the pipettor

head.

Click the Instrument menu and select

Manual Operation and then select

Load Tips.

Change the protocol to include

loading of tips at the beginning of the

experiment

237: Unable to wash. No tips loaded on

pipettor.

No tips are present on the pipettor

head.

Click the Instrument menu and select

Manual Operation and then select

Load Tips.

Change the protocol to include

loading of tips at the beginning of the

experiment

246: Unable to change head. Please

unload tips and select Change Head again.

“Change Head” action cannot be

performed unless tips are removed.

Click the Instrument menu and select

Manual Operation and then select

Unload Tips.

Some tips are left in the tip rack after

loading the tips.

Pipettor calibration failure. Contact Technical Support.

Some tips are left on the pipettor after

unloading.

Pipettor calibration failure. Contact Technical Support.

Pipettor Error Messages (continued)
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Symptom or Error Message Possible Causes Solutions

The tip rack is attached to the tips. Tip box failure. Remove tip box from tips. Click the

Instrument menu and select Manual

Operation and then select Unload

Tips.

Contact Technical Support.

242: The selected read plate has fewer

wells than the pipettor head. Please select

a plate with a matching format.

The pipettor head and read plate

format is incompatible (e.g., 1536

pipettor head with 96-well plate).

Load the correct pipettor head type.

Change the protocol to include a read

plate format that is compatible with

pipettor head.

243: The selected source 1 plate has fewer

wells than the pipettor head. Please select

a plate with a matching format.

The pipettor head and Source 1 plate

format is incompatible (e.g., 1536

pipettor head with 96-well plate).

Load the correct pipettor head type.

Change protocol to include Source 1

plate format that is compatible with

pipettor head.

244: The selected source 2 plate has

fewer wells than the pipettor head. Please

select a plate with a matching format.

The pipettor head and Source 2 plate

format is incompatible (e.g., 1536

pipettor head with 96-well plate).

Load the appropriate pipettor head

type.

Change protocol to include Source 2

plate format that is compatible with

pipettor head.

245: The selected source 3 plate has

fewer wells than the pipettor head. Please

select a plate with a matching format.

The pipettor head and Source 3 plate

format is incompatible (e.g., 1536

pipettor head with 96-well plate).

Load the correct pipettor head type.

Change the protocol to include

Source 3 plate format that is

compatible with pipettor head.

Volume is too large Volume is too large for the pipettor

head or plate format you are using.

See appended string on the error

message for details.

Reduce the aspirate/dispense volume

to within the specified range.

Volume is too small Volume is too small for the pipettor

head or plate format you are using.

See appended string on the error

message for details.

Increase the aspirate/dispense

volume to within the specified range.

Speed is too large Speed is too large for the pipettor

head or plate format you are using.

See appended string on the error

message for details.

Reduce the aspirate/dispense speed

to within the specified range.

Speed is too small Speed is too small for the pipettor

head or plate format you are using.

See appended string on the error

message for details.

Increase the aspirate/dispense speed

to within the specified range.

Pipettor Error Messages (continued)
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Symptom or Error Message Possible Causes Solutions

Height is too large Height is too large for the pipettor

head or plate format you are using.

See appended string on the error

message for details.

Reduce the aspirate/dispense height

to within the specified range.

Height is too small Height is too small for the pipettor

head or plate format you are using.

See appended string on the error

message for details.

Increase the aspirate/dispense height

to within the specified range.

Done with plate after aspiration is not

present.

FLIPR Cycler is not present on

instrument.

Must install FLIPR Cycler on

instrument for command to be

available.

Done with plate after dispense is not

present.

FLIPR Cycler is not present on

instrument.

Must install FLIPR Cycler on

instrument for command to be

available.

Dialog does not appear because you

are dispensing to the Read plate

position.

Read plate automatically changes at

the end of an experiment when in

Remote mode.

Mix Fluid After Dispense is not present. Command is not available when

Single Aspirate – Multiple Dispense

fluid transfer type is selected.

Select either Single Aspirate – Single

Dispense or Multiple Aspirate – Single

Dispense fluid transfer types.

Pipettor Error Messages (continued)
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Troubleshooting Optics

Symptom or Error Message Possible Causes Solutions

240: Attempting to use a LED module that

is not installed. Please install the correct

LED banks.

Specified LED module in protocol is

not installed.

Install the correct LED banks.

Select the correct LED module that is

installed on the instrument.

241: Attempting to use an emission filter

that is not installed. Please install the

correct emission filter.

Specified emission filter in the

protocol is not installed.

Install the correct emission filter.

Select the correct emission filter that

is installed on the instrument.

210: Unable to read plate. Calibration not

valid for emission/excitation pair.

A calibration file is not available for

the LED/emission filter combination

selected.

Calibrate instrument for LED/emission

filter pair.

214: The 2 upper LED banks are not

identical wavelengths. Please install

identical wavelengths to both upper

positions.

The upper pair of LED banks has

mismatched LED module

wavelengths.

Make sure LEDs of the same

wavelength are located in the upper

LED bank position on either side of

the read plate.

215: The 2 lower LED banks are not

identical wavelengths. Please install

identical wavelengths to both lower

positions.

The lower pair of LED banks has

mismatched LED module

wavelengths.

Make sure LEDs of the same

wavelength are located in the lower

LED bank position on either side of

the read plate.

217: One or more LED banks not detected.

Please verify all four banks firmly installed.

Cannot detect one of the LED

modules.

Make sure LED module is properly

connected.

Contact Technical Support.

216: LED module configuration/position

has changes. Please recalibrate.

LED module position changed from

where it was flat-field calibrated.

Calibrate instrument for current LED

configuration.

Place LEDs in previous calibrated

position.

303: LED modules not calibrated None of the installed LED banks have

been flat-field calibrated.

Calibrate instrument with installed

LED banks.

A LED inside the LED bank burned

out.

Calibrate instrument with installed

LED banks.

Replace LED bank if you cannot

recalibrate the LED bank.

Contact Technical Support.

306: Flat field calibration failed. Please

verify that the correct plate is loaded.

Please repeat flat field calibration.

Flat Field calibration failed; see

appended string on the error

message for details.

Calibrate using the correct flat field

calibration plate in the Read position.

Contact Technical Support.

Optics System Error Messages



FLIPR Penta High Throughput Cellular Screening System User Guide

170 5069582 G

Symptom or Error Message Possible Causes Solutions

218: Unable to define plate mask. Please

install 515–575 nm emission filter.

The 515–575 nm emission filter is not

installed. Thus, mask alignment

cannot be performed.

Install the 515–575 nm emission filter

to match the calibration file.

Calibrate instrument with new

emission filter.

219: Unable to define plate mask. Please

install 470–495 nm LED banks.

The 470–495 LED banks are not

installed. Thus, mask alignment

cannot be performed.

Install the 470–495 nm LED banks to

match the calibration file.

Calibrate the instrument with the new

LED bank.

307: Unable to complete plate mask

definition. Incorrect number of wells found.

Please verify that the correct plate is

loaded and repeat.

Mask alignment failed because it

didn’t find the correct number of wells

(e.g., must find 384 wells for a 384

well plate).

Correct read plate format must be in

Read position.

308: Unable to complete plate mask

definition. Found overlapping wells. Please

contact Technical Support. You will not be

able to run protocols using this plate until

the instrument is repaired.

Plate is tilted/popped out of position. Make sure the read plate is properly

aligned in Read position.

310: Unable to perform gain curve. Please

insert 515–575 nm emission filter.

515–575 nm emission filter is not

installed on system.

Install the 515–575 nm emission filter

prior to performing gain curve.

Contact Technical Support.

311: Unable to perform gain curve. Please

insert 470–495 nm LED banks.

470–495 nm LED banks are not

installed on system.

Install the 470–495 nm LED banks

prior to performing gain curve.

Contact Technical Support.

304: Gain calibration failed. Please contact

Technical Support.

Contact Technical Support.

Excitation/Emission wavelength is not

available in the edit read mode dialog.

Instrument was not calibrated for the

excitation/emission pair for which you

are looking.

Calibrate instrument for the correct

excitation/emission pair.

Exposure time is too large The exposure time for the camera is

too large. See appended string on the

error message for details.

Decrease the exposure time to within

the specified range.

Exposure time is too small The exposure time for the camera is

too small. See appended string on the

error message for details.

Increase the exposure time to within

the specified range.

200: Read interval too short Read interval is shorter than the sum

of exposure lengths for each read

interval in addition to the camera

processing time.

Set a longer read interval.

Optics System Error Messages (continued)
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First interval is too small The time for the first interval is too

short. Interval time must always be

longer than the sum of all selected

read modes plus the computer

processing time. See appended string

on the error message for details.

Increase the read interval to within the

specified range.

First interval is too large The time for the first interval is too

large. See appended string on the

error message for details.

Decrease the read interval to within

the specified range.

First interval number of reads is too large The number of reads in the first

interval is too large. See appended

string on the error message for

details.

Decrease the number of reads to

within the specified range.

Number of reads before dispense are too

large

Number of reads prior to dispense are

larger than the number of reads in the

first interval. See appended string on

the error message for details.

Decrease the number of reads before

the dispense to within the specified

range.

400: Camera is not functional. Please

contact Technical Support. You will not be

able to run protocols until it is repaired.

Camera is not functional. Contact Technical Support.

Optics System Error Messages (continued)
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Troubleshooting Yellow Plates

Symptom or Error Message Possible Causes Solutions

Saturation detected, data may be

invalid

Incorrect settings. Set excitation intensity to 80%, exposure length

to 0.1 s and for EMCCD gain to 80. If condition

repeats, lower excitation intensity.

Incorrect LED and/or emission filter

choice.

Select the correct LED and emission filters.

Emission optics are dirty. Make sure no dust is on emission filters.

Bottom of Read plate is dirty. Make sure no dust or fluorescent compounds

are on the bottom of the Read plate.

Wells are cut off in Image Viewer Plate not properly placed in Read

position

Make sure plate is properly placed and indexed

in the Read position.

Dirty/misaligned optics. Contact Technical Support.

Fluorescence counts are 0 LED power is off. Increase excitation intensity of LEDs.

Make sure excitation/emission wavelength in

the read mode does not have NONE for the

excitation wavelength.

Camera failure. Contact Technical Support.

Signal test was not initiated. Select Test Signal in the Signal Test dialog.

Standard deviation for the signal

test is greater than 5% and

fluorescence counts may or may

not be in the correct range.

Instrument was calibrated with

yellow boat.

If you use the yellow boat to calibrate the

instrument, the standard deviation can be 5% or

less.

Camera not fully cooled down. Wait approximately 10 minutes for the camera

temperature to cool down.

Optical correction out of

specifications

Perform flat field calibration.

Plate is not aligned properly in

Read position.

Make sure plate is properly aligned and indexed

in the Read position.

Optics is dirty or failing. Contact Technical Support.

Calibration plate failure— plate is

dirty or scratched.

Clean the calibration plate with lens paper. DO

NOT use lab wipes. If cleaning does not work,

replace the calibration plate.

Yellow Plate Testing Error Messages
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Troubleshooting Tip Washers

Symptom or Error Message Possible Causes Solutions

221: Tip wash reservoir format

(96/384/1536) does not match pipettor

head. Please install matching reservoir and

select Reset.

Pipettor head and tip washer

reservoir top do not match (e.g., a 384

Pipettor head with a 96-well reservoir

top).

Install the correct pipettor head to

match tip wash reservoir top.

Install the correct tip wash reservoir

top to match pipettor head.

222: Tip wash reservoir top not detected.

Please install matching reservoir and

select Reset.

No reservoir top is installed. Install the correct tip wash reservoir

top.

Tip wash reservoir top is not properly

installed.

Tip wash reservoir top connectors

may not be properly connected.

223: Check Waste Bottle A - sensor

indicates full.

Waste bottle A is full of tip wash

solvent.

Empty tip wash solvent from waste

bottle A.

224: Check Waste Bottle B - sensor

indicates full.

Waste bottle B is full of tip wash

solvent.

Empty tip wash solvent from waste

bottle B.

225: Check Tip Washer - sensor indicates

overflow.

Waste bottles are full. Empty tip wash solvent from waste

bottles A and B and select Reset.

Fluid level sensor malfunction. Contact Technical Support.

226: Tip Washer: Check Wash Fluid Bottle

A - fill sensor dry.

Fill Bottle A is empty. Place tip wash solvent into fill bottle A.

227: Tip Washer: Check Wash Fluid Bottle

B - fill sensor dry.

Fill Bottle B is empty. Place tip wash solvent into fill bottle B.

250: Tip Washer: Check Wash fluid. Fill

sensor dry during fill after prime.

The selected wash bottle might be

running low on fluid.

Check the wash bottles.

251: Tip Washer: Check Wash fluid. Fill

sensor dry after fill.

The selected wash bottle might be

running low on fluid.

Check the wash bottles.

252: Tip Washer: Check Wash Fluid Bottles

A and B - sensor indicates empty.

Both of the wash bottles are detected

empty.

Add fluid to both wash bottles.

254: Tip Washer: Check tubing at Fill Pump

- fill sensor wet after draining line.

Fluid sensor is detecting fluid when it

should not.

Check for unconnected tubing.

Contact Technical Support.

301: Tip wash module not functional.

Please contact Technical Support. You will

not be able to run protocols with tip

washing until it is repaired.

Cannot communicate with the Tip

Washer.

Click the Instrument menu and select

Reset.

Tip Washer System Error Messages
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Troubleshooting Data

Symptom or Error Message Possible Causes Solutions

Negative control wells show a response. Wash buffer components are different

from the compound buffer.

Make sure wash buffer and

compound buffer are the same.

Check for a DMSO stimulation, if

present.

Statistical results do not conform to the

expected results.

Data analysis has not been optimally

set up.

See Data Processing Algorithms on

page 197.

Data parameters need to be reset (subtract

bias, spatial uniformity correction, positive

control, etc.) for each experiment.

*.vamp file parameters not set up

correctly.

Click Grouping or Correction to adjust

the parameters.

False negative wells. Tip problem. Contact Technical Support.

Data Processing Error Messages
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Troubleshooting Robotic Integration

Symptom or Error Message Possible Causes Solutions

220: Unable to load plate. No plate on

landing pad.

Plate present on plate landing pad,

but plate presence was not detected.

Contact Technical Support.

If plate not positioned properly by

robot, contact robot manufacturer

Technical Support.

No plate was delivered to landing pad

by 3rd party robot.

Contact robot manufacturer Technical

Support.

221: Unable to load plate. Plate already

detected at requested location.

Plate already at requested position. Unload plate currently in the position

prior to delivering new plate.

If robot attempts to load multiple

plates to one position without

retrieving plates, contact robot

manufacturer Technical Support.

222: Unable to unload plate. Plate already

detected at landing pad.

Plate already present on landing pad. Remove plate on landing pad prior to

unloading a new plate.

223: Unable to unload plate. No plate

detected at requested position.

No plate present in position. Clear error and proceed with

experiment.

Plate may have popped out of

position.

Clear plate that is out of position prior

to resuming experiment.

Bar code reader misreads the bar code

and file name reads Bad_bar_code.

Misplacement of bar code or incorrect

type of bar code.

Bar code must be on the side of the

plate where the bar code is read.

Place label as low as possible. Use

labels with numbers on top.

Robotic Integration System Error Messages
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Obtaining Support

Molecular Devices is a leading worldwide manufacturer and distributor of analytical
instrumentation, software, and reagents. We are committed to the quality of our products and to
fully supporting our customers with the highest level of technical service.

Our Support website—support.moleculardevices.com/—describes the support options offered
by Molecular Devices, including service plans and professional services. It also has a link to the
Molecular Devices Knowledge Base, which contains documentation, technical notes, software
upgrades, safety data sheets, and other resources. If you still need assistance, you can submit a
request to Molecular Devices Technical Support.

Please have your instrument serial number or Work Order number, and your software version
number available when you call.

WARNING! BIOHAZARD. It is your responsibility to decontaminate components of
the instrument before you return parts to Molecular Devices for repair. Molecular
Devices does not accept items that have not been decontaminated where it is
applicable to do so. If parts are returned, they must be enclosed in a sealed plastic bag
stating that the contents are safe to handle and are not contaminated.

http://www.moleculardevices.com/service-support
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Appendix A: Technical Specifications

The following table lists the technical specifications for the FLIPR Penta High-Throughput
Cellular Screening System.

Item Description

Instrument Dimensions

Size Centimeters - 99 (W) x 178.44 (H) x 69 (D)

Inches - 39 (W) x 70.25 (H) x 27 (D)

Weight (approx.) 386 kg (850 lbs.)

Throughput

Temperature control Ambient, +25°C to 40°C

Throughput 20 plates/hour (2-minute read time)

96-well 1,920 data points/hour

384-well 7,680 data points/hour

1536-well 30,720 data points/hour

Bar code manual mode 1 Keyboard entry

Bar code manual mode 2 Short or long side

EMCCD Camera Option

Camera type EMCCD

Detection Fluorescence

Mode Cooled CCD camera

Fluorescence sensitivity with Z' ≥ 0.5 (whole plate) 1.25 nM Fluorescein

Data acquisition rate 7 Hz

Ratiometrics Up to 4 EX/EM pairs per experiment

Data acquisition rate for ratiometric emission 2 Hz (2EX/EM pairs)

HS EMCCD Camera Option

Camera type HS EMCCD

Detection Luminescence and Fluorescence

Mode High Speed, High Sensitivity CCD Camera

Fluorescence sensitivity with Z' ≥ 0.5 (whole plate) 0.625 nM Fluorescein

Luminescence sensitivity 4.1 nM ATP (Promega Cell Titer Glow Assay)

Data acquisition rate 100 Hz

Technical Specifications

A
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Item Description

Ratiometrics Up to 4 EX/EM pairs per experiment

Data acquisition rate for ratiometric emission 2 Hz (2EX/EM pairs)

Excitation LEDs and Emission Filters

Wavelength range 335-626 nm 400-750 nm

Calcium (default) 470-495 nm 515-575 nm

Membrane potential 510-545 nm 565-625 nm

Voltage sensor probes
390-420 nm

440-480 nm

565-625 nm

Fura-2 335-345 nm

380-390 nm
475-535 nm

Instrument holds 2 pairs of LEDS, one for each side to cross-illuminate the bottom of the plate

Instrument has a 3 position filter slider that identifies the filter to the instrument

Custom filter holders are available

Fluidics

Simultaneous transfer 96, 384 and 1536

Range-96 pipettor head 5-200 µL

Precision @75 µL 3% CV

Pipetting increments-96 pipettor head 1 µL

Range - 384-Well pipettor 1-25 µL

Precision @ 25 µL 4% CV

Pipetting increments - 384-Well pipettor 0.5 µL

Range - 1536-Well pipettor 0.5-3 µL

Precision @ 3 µL 6% CV

Precision @ 1 µL 10% CV

Pipetting increments - 1536-Well pipettor 0.1 µL

96 pipettor head - Quadrant transfer 384-well plate

384 pipettor head - Quadrant transfer 1536-well plate

Technical Specifications (continued)
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Appendix B: Consumables and Accessories

System Accessories

Optional Software Modules

Supplier: Molecular Devices, call +1-800-635-5577.

Item Part Number

ScreenWorks® Peak Pro™ 1.0 Software

(For ScreenWorks Software Versions 3.2 and 4)

5016900

ScreenWorks® Peak Pro™ 1.0 Software

(For ScreenWorks Software Version 5)

5075630

ScreenWorks® Peak Pro™ 2.0 Software

(For ScreenWorks Software Version 5)

5074843

Optional Software Modules

Field Installations

Supplier: Molecular Devices, call +1-800-635-5577.

Item Part Number

FLIPR® Camera Conversion Kit or EMCCD to HS EMCCD 5069580

Windows 10 Host PC with ScreenWorks® Software Version 5 for select*

EMCCD Systems

5075062

Windows 10 Host PC with ScreenWorks® Software Version 4.2 for select*

EMCCD Systems

5074979

FLIPR® Cycler 5074848

* Contact Molecular Devices to identify applicable kit

Field Installations Kits

B
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Pipetting Accessories

Supplier: Molecular Devices, call +1-800-635-5577.

Item Part Number

FLIPR® 1536 Tip Block 0200-6112

1FLIPR® Pin Tool, 384 5075203

1FLIPR® Pin Tool, 1536 5075194

1FLIPR® Pin Tool Kit, 384 and/or 1536 FLIPR PIN TOOLS OC

1. Contact your Molecular Devices Sales Representative for details regarding this configure-to- order

item.

Pipetting Accessories

Pipetting Consumables

Supplier: Molecular Devices, call +1-800-635-5577.

Item Part Number

FLIPR® pipette tips, black, non-sterile, 96-well, 50 racks/case 9000-0762

FLIPR® pipette tips, clear, non-sterile, 96-well, 50 racks/case 9000-0761

FLIPR® non-sterile, black, 384-well, 50 racks/case 9000-0764

FLIPR® pipette tips, clear, non-sterile, 384-well, 50 racks/case 9000-0763

FLIPR® 1536 tip gasket, nonsterile, 40 racks/case 9000-0746

Pipetting Consumables

Pipettor Heads

Supplier: Molecular Devices, call +1-800-635-5577.

Item Part Number

FLIPR® Pipettor Head Kit, 96 0200-6071

FLIPR® Pipettor Head Kit, 384 0200-6072

FLIPR® Pipettor Head Kit, 1536 0200-6073

Pipettor Head Kits
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Optics Consumables

Supplier: Molecular Devices, call +1-800-635-5577.

Item Part Number

FLIPR® Calcium Optics Kit 0200-6206

FLIPR® Membrane Potential Optics Kit 0200-6207

FLIPR® Voltage Sensor Probes (VSP) Optics Kit 0200-6208

FLIPR® Fura-2 Optics Kit 5302739

FLIPR® LED Module, 335–345 nm (UV) 5201196

FLIPR® LED Module, 360–380 nm 0200-6178

FLIPR® LED Module, 380–390 nm (UV) 0200-6273

FLIPR® LED Module, 390–420 nm (VSP) 0200-6135

FLIPR® LED Module, 420–455 nm 0200-6148

FLIPR® LED Module, 470–495 nm (Calcium) 0200-6128

FLIPR® LED Module, 495–505 nm 0200-6175

FLIPR® LED Module, 510–545 nm (Membrane Potential) 0200-6127

FLIPR® LED Module, 610–626 nm 0200-6150

FLIPR® Emission Filter, 400–460 nm 0200-6213

FLIPR® Emission Filter, 440–480 nm (VSP) 0200-6205

FLIPR® Emission Filter, 475–535 nm 0200-6211

FLIPR® Emission Filter, 515–575 nm (Calcium) 0200-6203

FLIPR® Emission Filter, 526–586 nm 0200-6212

FLIPR® Emission Filter, 565–625 nm (Membrane Potential and VSP) 0200-6204

FLIPR® Emission Filter, 646–706 nm 0200-6214

FLIPR® Custom Filter Set (3) 0200-6221

FLIPR® Single Custom Filter Holder (1) 0200-6276

Optics Kits
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Plates

The following conforming plates can be purchased from Molecular Devices.

96-Well Read Plates

96-Well Read Plates Part Number Suggested Supplier Phone Number

Black, clear, tissue culture

treated, sterile

353948 Becton Dickinson +1-800-343-2035

3603 Corning/Costar +1-800-492-1110

655090 Greiner (distributed by

E&K)

+1-408-378-2013

165305 Nalge/Nunc +1-800-766-7000

Black, clear, tissue culture

treated, sterile, poly-D-lysine

coated

356640 Becton Dickinson +1-800-343-2035

3667 Corning/Costar +1-800-492-1110

Black, clear, tissue culture

treated, sterile, collagen coated

356649 Becton Dickinson +1-800-492-1110

White, clear, tissue culture

treated, sterile

353947 Becton Dickinson +1-800-343-2035

3903 Corning/Costar +1-800-492-1110

655098 Greiner (distributed by

E&K)

+1-408-378-2013

165306 Nalge/Nunc +1-800-766-7000

96-Well Read Plates

96-Well Read Plate Masks Made by Molecular Devices

96-Well Read Plate

Masks

Part Number Plate Manufacturer

96-well slit mask 0200-6143 Becton Dickinson

2300-1362 Corning/Costar

0200-6142 Nalge/Nunc

0200-6144 Greiner

96-Well Read Plate Masks Made by Molecular Devices
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96-Well Source Plates

96-Well Source Plates Part Number Suggested Supplier Phone Number

V-bottom plate, 96-well 353263

polypropylene

Becton Dickinson +1-800-343-2035

651201

polypropylene

Greiner (distributed

by E&K)

+1-408-378-2013

249944 Nalge/Nunc +1-800-766-7000

U-bottomed plate, 96-well 351190

polypropylene

Becton Dickinson +1-800-343-2035

3365 polypropylene Corning/Costar +1-800-492-1110

267245 Nalge/Nunc +1-800-766-7000

650201

polypropylene

Greiner (distributed

by E&K)

+1-408-378-2013

Deep-well plate, 96-well 353966

polypropylene

Becton Dickinson +1-800-343-2035

780270

polypropylene

Greiner (distributed

by E&K)

+1-408-378-2013

278752

polypropylene

Nalge/Nunc +1-800-766-7000

96-Well Source Plates

384-Well Read Plates

384-Well Read Plates Part Number Suggested Supplier Phone Number

Black, clear, tissue culture

treated, sterile

353262 Becton Dickinson +1-800-343-2035

3712 Corning/Costar +1-800-492-1110

781091 Greiner with lids

(distributed by E&K)

+1-408-378-2013

MGB101-1-2 Matrical +1-509-343-6225

MGB101-1-3

0.17 mm-thick

glass

Matrical +1-509-343-6225

142761 Nalge/Nunc +1-800-766-7000

Black, clear bottom, tissue

culture treated, sterile, poly-D-

lysine coated

356663 Becton Dickinson +1-800-343-2035

3664 Corning/Costar +1-800-492-1110

Black, clear, tissue culture

treated, sterile, collagen coated

356667 Becton Dickinson +1-800-343-2035

384-Well Read Plates
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384-Well Read Plates Part Number Suggested Supplier Phone Number

White, clear, tissue culture

treated, sterile

353963 Becton Dickinson +1-800-343-2035

3707 Corning/Costar +1-800-492-1110

781098 Greiner (distributed by

E&K)

+1-408-378-2013

142762 Nalge/Nunc +1-800-766-7000

Low volume black, clear, tissue

culture treated, sterile

3542 Corning/Costar +1-800-492-1110

788092 Greiner (distributed by

E&K)

+1-408-378-2013

384-Well Read Plates (continued)



Appendix B: Consumables and Accessories

5069582 G 185

384-Well Source Plates

384-Well Source Plates Part Number Suggested Supplier Phone Number

Flat bottom plate 353265

polypropylene

Becton Dickinson +1-800-343-2035

3702 polystyrene Corning/Costar +1-800-492-1110

781201

polypropylene

Greiner (distributed

by E&K)

+1-408-378-2013

265496 polystyrene Nalge/Nunc +1-800-766-7000

U/V-bottom plate 3657 polypropylene Corning/Costar +1-800-492-1110

781280

polypropylene

Greiner (distributed

by E&K)

+1-408-378-2013

264573

polypropylene

Nalge/Nunc +1-800-766-7000

Deep-well plate 353996

polypropylene

Becton Dickinson +1-800-343-2035

3965 polypropylene Corning/Costar +1-800-492-1110

781270

polypropylene

Greiner (distributed

by E&K)

+1-408-378-2013

MP102 polypropylene Matrical +1-509-343-6225

384-Well Source Plates 

1536-Well Read Plates

1536-Well Read Plates Part Number Suggested Supplier Phone Number

Black/Clear, tissue culture treated,

sterile

783092 Greiner with lids

(distributed by E&K)

+1-408-378-2013

White/Clear, tissue culture

treated, sterile

781098 Greiner (distributed

by E&K)

+1-408-378-2013

1536-Well Read Plates 

1536-Well Source Plates

1536-Well Source Plates Part Number Suggested Supplier Phone Number

Deep-well plate 782270

polypropylene

Greiner (distributed

by E&K)

+1-408-378-2013

1536-Well Source Plates

Source Reservoirs

Source Reservoirs Part Number Suggested Supplier Phone Number

Omni tray 2428110 polystyrene Nalge/Nunc +1-800-786-7000

Source Reservoirs
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Assays

Calcium Flux Consumables and Accessories

Item Part Number Suggested Supplier Phone Number

FLIPR® Calcium 6 Assay Kit:

Bulk Kit

Explorer Kit

Express Kit

R8190

R8191

R8195

Molecular Devices +1-800-635-5577

+1-408-747-1700

FLIPR® Calcium 6 QF Assay Kit:

Bulk Kit

Explorer Kit

Express Kit

R8192

R8193

R8196

Molecular Devices +1-800-635-5577

+1-408-747-1700

FLIPR® Calcium 5 Assay Kit:

Bulk Kit

Explorer Kit

Express Kit

R8186

R8185

R8187

Molecular Devices +1-800-635-5577

+1-408-747-1700

FLIPR® Calcium 4 Assay Kit:

Bulk Kit

Explorer Kit

Express Kit

R8141

R8142

R8143

Molecular Devices +1-800-635-5577

+1-408-747-1700

FLIPR® Calcium 3 Assay Kit:

Bulk Kit

Explorer Kit

Express Kit

R8090

R8091

R8108

Molecular Devices +1-800-635-5577

+1-408-747-1700

FLIPR® Cardiocytoxicity Assay Kit:

Bulk Kit

Explorer Kit

R8211 (10 plates)

R8210 (2 plates)

Molecular Devices +1-800-635-5577

+1-408-747-1700

FLIPR® Fura-2 QBT Calcium Assay

Kit:

Bulk Kit

Explorer Kit

R8197

R8198

Molecular Devices +1-800-635-5577

+1-408-747-1700

FLIPR® Penta System Calcium

Optics Kit:

LED Module, 470-495 nm

Emission Filter, 515-575 nm

0200- 6206 Molecular Devices +1-800-635-5577

+1-408-747-1700

FLIPR® Penta System Fura-2 Optics

Kit:

LED Module 333-345 nm

LED Module 380-390 nm

Emission Filter 475-535nm

5302739 Molecular Devices +1-800-635-5577

+1-408-747-1700

Hank’s Balanced Salt Solution (10X

stock)

14065- 056 Thermo Fisher 1-800-828-6686

Calcium Flux Consumables and Accessories
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Item Part Number Suggested Supplier Phone Number

HEPES buffer solution 1X 9319 Irvine Scientific +1-800-437-5706

Probenecid, crystalline P8761 Sigma +1-800-325-3010

Carbachol (receptormediated

positive control)

C4382

UTP, Na salt (receptormediated

positive control)

U6625

Ionomycin (positive control) 407950 CalBiochem +1-800-854-3417

Calcium Flux Consumables and Accessories (continued)

Membrane Potential Assay Kit Consumables and Accessories

Item Part Number Suggested Supplier Phone Number

FLIPR® Membrane Potential

Assay Kit

R8034 (BLUE)

R8123 (RED)

Molecular Devices +1-800-635-5577

+1-408-747-1700

FLIPR® Penta System Membrane

Potential Optics Kit:

FLIPR® Penta System LED

Module, 510–545 nm

FLIPR® Penta System Emission

Filter, 565–625 nm

0200-6207 Molecular Devices +1-800-635-5577

+1-408-747-1700

Hank’s Balanced Salt Solution

(10X stock)

14065-056 Thermo Fisher 1-800-828-6686

HEPES buffer solution 1X 9319 Irvine Scientific +1-800-437-5706

Carbachol (receptor-mediated

positive control)

C4382 Sigma +1-800-325-3010

Membrane Potential Assay Kit Consumables and Accessories
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Potassium Assay Kit Consumables and Accessories

Item Part Number Suggested Supplier Phone Number

FLIPR® Potassium Assay Kit

Evaluation Kit

Explorer Kit

Bulk Kit

R8330

R8222

R8223

Molecular Devices +1-800-635-5577

+1-408-747-1700

FLIPR® Penta System Calcium

Optics Kit:

FLIPR® Penta System LED Module,

470-495 nm

FLIPR® Penta System Emission

Filter, 515-575 nm

0200-6206 Molecular Devices +1-800-635-5577

+1-408-747-1700

Hank’s Balanced Salt Solution

(10X stock)

14065-056 Thermo Fisher 1-800-828-6686

HEPES buffer solution 1X 9319 Irvine Scientific +1-800-437-5706

DMSO D8418 Sigma +1-800-325-3010

Probenecid P8761 Sigma +1-800-325-3010

Potassium Assay Kit Consumables and Accessories

Recommended Assay Equipment and Supplies

The following recommended assay equipment and supplies are not available through
Molecular Devices:

5 mL, 10 mL, 25 mL sterile serological pipettes
Rechargeable pipettor for 2–25 mL pipettes
Sterile tissue culture water
Gloves
Culture medium to grow cells
EDTA and Trypsin/EDTA to lift cells
Hemacytometer and counter
Sterile test tubes 15 mL and 50 mL or smaller tubes for compounds dilutions
1 N NaOH solution to dissolve probenecid
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Appendix C: FLIPR Penta Plate Dimensions

Note: Molecular Devices is not responsible for instrument malfunctions if the provided
dimensions are incorrect.

The following dimensions derive from specifications distributed by the individual vendors.

Plate Type Part # Rows Columns Type Well

Volume

(µL)

A1

Column

Offset "Y" 

(mm)

A1 Row

Offset

"X" 

(mm)

Bottom

(MM)

Top

(MM)

Well

Offset

(mm)

96-well

Black/Clear

353948 8 12 read 349 14.28 11.23 3.50 14.53 9.01

96-well

Black/Clear,

Collagen-Coated

356649 8 12 read 349 14.28 11.23 3.50 14.53 9.01

96-well

Black/Clear,

PDL-Coated

356640 8 12 read 349 14.28 11.23 3.50 14.53 9.01

96-well

White/Clear

353947 8 12 read 349 14.42 11.19 3.50 14.66 9.00

96-well U

bottom,

polypropylene

351190 8 12 source 340 14.23 11.33 2.49 14.62 8.99

96-well V

bottom,

polypropylene

353263 8 12 source 340 14.24 11.35 3.70 14.61 8.99

96-well 2mL

Deep Well,

polypropylene

353966 8 12 source 2000 13.88 10.62 — 44.24 9.04

384-well

Black/Clear

353962 16 24 read 120 12.21 9.05 2.90 14.32 4.49

384-well

Black/Clear,

Collagen-Coated

356667 16 24 read 120 12.21 9.05 2.90 14.32 4.49

384-well

Black/Clear,

PDL-coated

356663 16 24 read 120 12.21 9.05 2.90 14.32 4.49

Becton Dickinson Plate Dimensions

C
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Plate Type Part # Rows Columns Type Well

Volume

(µL)

A1

Column

Offset "Y" 

(mm)

A1 Row

Offset

"X" 

(mm)

Bottom

(MM)

Top

(MM)

Well

Offset

(mm)

384-well

White/Clear

353963 16 24 read 120 12.26 9.06 2.90 14.34 4.49

384-well flat

bottom

polypropylene

353265 16 24 source 140 12.15 9.27 2.90 14.40 4.50

384-well Deep

Well,

polypropylene

353996 16 24 source 400 11.83 8.83 — 43.69 4.51

1536-well

Black/Clear

353255 32 48 read 12 11.04 7.85 3.80 10.41 2.25

1536-well

White/Clear

353258 32 48 read 12 11.03 7.84 3.80 10.42 2.25

Becton Dickinson Plate Dimensions (continued)
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Plate Type Part # Rows Columns Type Well

Volume

(µL)

A1 Column

Offset "Y" 

(mm)

A1 Row

Offset

"X" (mm)

Bottom

(MM)

Top

(MM)

Well

Offset

(mm)

96-well

Black/Clear

3603 8 12 read 360 14.30 11.20 3.57 14.22 9.00

96-Well

Black/Clear,

PDL-Coated

3667 8 12 read 360 14.30 11.20 3.57 14.22 9.00

96-well

White/Clear

3903 8 12 read 360 14.30 11.20 3.57 14.22 9.00

96-well U bottom,

polypropylene

3365 8 12 source 360 14.30 11.20 2.92 14.22 9.00

384-well

Black/Clear

3712 16 24 read 112 12.12 8.99 2.79 14.22 4.50

384-Well

Black/Clear,

PDL-coated

3664 16 24 read 112 12.12 8.99 2.79 14.22 4.50

384-well

White/Clear

3707 16 24 read 112 12.12 8.99 2.79 14.22 4.50

384-well flat

bottom

polystyrene

3702 16 24 source 112 12.12 8.99 2.79 14.22 4.50

384-well U

bottom,

polypropylene

3657 16 24 source 95 12.12 8.99 2.65 14.20 4.50

384-well block,

polypropylene

3965 16 24 source 180 12.12 8.99 2.69 27.80 4.50

Corning/Costar Plate Dimensions
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Plate Type Part # Rows Columns Type Well

Volume

(µL)

A1

Column

Offset "Y" 

(mm)

A1 Row

Offset

"X" (mm)

Bottom

(MM)

Top

(MM)

Well

Offset

(mm)

96-well

Black/µClear

655090 8 12 read 392 14.38 11.24 3.50 14.40 9.00

96-well

White/µClear

655098 8 12 read 392 14.38 11.24 3.50 14.40 9.00

96-well U

bottom,

polypropylene

650201 8 12 source 310 14.38 11.24 3.70 14.60 9.00

96-well V

bottom,

polypropylene

651201 8 12 source 340 14.38 11.24 3.70 14.60 9.00

96-well 2mL

Deep Well,

polypropylene

780270 8 12 source 2420 14.38 11.24 3.00 44.00 9.00

384-well

Black/µClear

781091 16 24 read 138 12.13 8.99 2.90 14.40 4.50

384-well

White/µClear

781098 16 24 read 138 12.13 8.99 2.90 14.40 4.50

384-well flat

bottom

polypropylene

781201 16 24 source 152 12.13 8.99 2.90 14.40 4.50

384-well V

bottom,

polypropylene

781280 16 24 source 145 12.13 8.99 2.90 14.40 4.50

384-well Deep

Well,

polypropylene

781270 16 24 source 240 12.13 8.99 2.70 22.00 4.50

1536-well

Black/µClear,

Low Base

783092 32 48 read 13 11.01 7.87 1.80 10.40 2.25

1536-well Deep

Well,

polypropylene

782270 32 48 source 18 11.01 7.87 2.50 10.10 2.25

Greiner Plate Dimensions
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Plate Type Part # Rows Columns Type Well

Volume

(µL)

A1

Column

Offset "Y" 

(mm)

A1 Row

Offset

"X" 

(mm)

Bottom

(MM)

Top

(MM)

Well

Offset

(mm)

384-well

Black/.17mm-

thick glass

MGB101-1-

2

16 24 read 120 12.13 8.99 2.85 14.40 4.50

384-well

Black/Clear

polystyrene

MGB101-1-

3

16 24 read 120 12.13 8.99 2.85 14.40 4.50

384-well Deep

well

polypropylene

MP102 16 24 source 225 12.13 8.99 4.90 27.40 4.40

Matrical Plate Dimensions

Plate Type Part # Rows Columns Type Well

Volume

(µL)

A1

Column

Offset "Y" 

(mm)

A1 Row

Offset

"X" (mm)

Bottom

(MM)

Top

(MM)

Well

Offset

(mm)

96-well

Black/Clear

165305 8 12 read 400 14.48 11.20 2.30 14.80 9.00

96-well

White/Clear

165306 8 12 read 400 14.48 11.20 2.30 14.80 9.00

96-well U

bottom

267245 8 12 source 500 14.30 11.30 2.20 14.30 9.00

96-well V

bottom

249944 8 12 source 450 14.48 11.20 3.40 14.40 9.00

96-well 2mL

Deep Well,

polypropylene

278752 8 12 source 2000 14.30 11.30 2.50 44.00 9.00

384-well

Black/Clear

142761 16 24 read 120 12.10 9.00 2.70 14.40 4.50

384-well

White/Clear

142762 16 24 read 120 12.10 9.00 2.70 14.40 4.50

384-well flat

bottom

polystyrene

265196 16 24 source 120 12.10 9.00 2.70 14.40 4.50

384-well U

bottom

264573 16 24 source 120 12.10 9.00 2.70 14.40 4.50

Nalge/Nunc Plate Dimensions
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Appendix D: FLIPR Penta Instrument LED and Filter
Combinations

Target Assay LED (nm) LED Part # Emission

Filter (nm)

Penta Filter Part # Penta Kit Part

#

Fura-2 335-345 and

380-390

(UV)

5201196

0200-6273

475-535 0200-6211 5302739

MQAE 360-380

(UV)

N/A N/A N/A N/A

Voltage Sensor Probe (VSP) 390-420

(UV)

0200-6135 440-480

565-625

0200-6205

0200-6204

0200-6208

Tango™ GPCR Assay System (FRET) 390-420

(UV)

0200-6135 440-480

515-575

0200-6205

0200-6203

N/A

CFP, eCFP/YFP 420-455 0200-6148 475-535 0200-6211 N/A

FLIPR Calcium Assay Kits 470-495

(Blue)

0200-6128 515-575 0200-6203 0200-6206

Calcium, Fluo-4 470-495

(Blue)

0200-6128 515-575 0200-6203 0200-6206

Calcium, Fluo-3 495-505 0200-6175 526-586 0200-6212 N/A

JC-1 495-505 0200-6175 565-625 0200-6204 N/A

FLIPR Membrane Potential Assay Kits 510-545

(Green)

0200-6127 565-625 0200-6204 0200-6207

Rhod-2 & Rhod-4 510-545 0200-6127 565-625 0200-6204 N/A

Alexa 633 & Bodipy 610-626 0200-6150 646-706 0200-6214 N/A

BRET 2 luminescence assay with

HSEMCCD Camera

N/A N/A 440-480

526-586

0200-6205

0200-6212

N/A

Three Custom Filter Holders N/A N/A N/A 0200-6221 N/A

FLIPR Penta Instrument LED and Filter Combinations

D
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Appendix E: Data Processing Algorithms

This appendix uses results of a hypothetical experiment to describe the algorithms you use to
adjust data. Apply these options from the Correction dialog.

Hypothetical Experiment

Consider the results from an experiment that consists of wells A1–A9. The wells are classified
into three groups:

A1–A3: Negative Control Wells (–Ctrl). These wells contain the same dye-loaded cells and
buffers as the other wells yet are not exposed to a stimulus.
A4–A6: Experimental Wells (Exp). These cells receive the experimental stimulus.
A7–A9: Positive Control Wells. (+Ctrl). These cells either (1) receive a stimulus known to elicit
a predetermined response or (2) demonstrate the maximal activity from an agonist.

In the following experiment, six samples, also known as pictures, readings, or frames, were
taken at five second intervals. After Sample 3 was taken, buffer, with or without stimulus, was
added to the wells.

Note: The longer time between readings 3 and 4 includes the time necessary for the 96-
well pipettor to transfer liquids from the source plate to the cell plate and is automatically
corrected for by the FLIPR Penta System.

The data presented is in the same format as the export data files you generate from the
FLIPR Penta System software. In this example, nine wells are considered.

The results of the experiment are presented without Spatial Uniformity Correction, Negative
Control Correction, Positive Control Scaling, or Subtract Bias Value.

Sample Time Well

A1 –

Ctrl

A2 –

Ctrl

3 –

Ctrl

A4 Exp A5 Exp A6 Exp A7 +

Ctrl

A8 +

Ctrl

A9 +

Ctrl

1 0 8000 8500 9500 8200 9200 8800 1000 9500 8700

2 5 8200 8600 9400 8300 9000 9000 9500 9700 9000

3 10 8400 8500 9200 8500 9000 9100 9700 9700 9400

4 20 8600 8400 9200 45000 50000 42000 57000 52000 54000

5 25 8600 8800 9200 37000 42000 35000 53000 50000 50000

6 30 8800 8500 9500 30000 25000 29000 50000 51000 50000

Hypothetical Experiment

An inspection of the fluorescence counts taken at Sample 1 (time = 0) shows some inter-well
variability (range 8000–10000). Variability is the result of differences in cell density or well
positions (so-called edge effects where cells on the outside of the plate are less dense than
their internal neighbors), dye loading, non-uniform illumination, buffer variations, or any other
effect which is constant throughout the experiment run. These variations can complicate data
interpretation.

E
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Determining Spatial Uniformity Correction

The spatial uniformity correction algorithm compensates for of the variations using a correction
factor applied to all plate wells and samples. The correction factor is derived by calculating the
mean fluorescence counts of all wells at Sample 1, for example:

Sample Time Well

A1 –

Ctrl

A2 –

Ctrl

A3 –

Ctrl

A4 Exp A5

Exp

A6

Exp

A7 +

Ctrl

A8 +

Ctrl

A9 +

Ctrl

1 0 8000 8500 9500 8200 9200 8800 10000 9500 8700

Mean (A1-A9) 8933

Spatial Uniformity Correction Factor Calculation (Mean/Well)

Well- Specific

Correction

Factor

A1 A2 A3 A4 A5 A6 A7 A8 A9

1.12 1.05 0.94 1.09 0.95 1.02 0.89 0.94 1.03

Correction Factor

Note: Data from all 96 wells are included in the calculations, but the table displays data
from nine wells to simplify the example.

The software calculates each well-specific spatial uniformity correction factor by dividing the
mean fluorescence counts of all wells by the fluorescence counts of each well (taken at Sample
1.) The table above presents the correction factor for wells A1–A9.

The software multiplies all samples taken from a particular well by their well-specific correction
factor. For example, all samples from A1 are multiplied by 1.12, A2 by 1.05, and so on.

The following table displays the results of applying the spatial uniformity correction factor. Note
the decreased variability range of wells A1–A9 in Sample 1 (8900–8976) as compared to the
same data prior to applying the correction algorithm (8000–10000).

Sample Time Well

A1 –

Ctrl

A2 –

Ctrl

3 –

Ctrl

A4 Exp A5 Exp A6 Exp A7 +

Ctrl

A8 +

Ctrl

A9 +

Ctrl

1 0 8960 8925 8930 8938 8924 8976 8900 8930 8961

2 5 9194 9030 8836 9047 8730 9180 8455 9118 9270

3 10 9408 8925 8648 9265 8730 9282 8633 9118 9682

4 20 9632 8820 8648 49050 48500 42840 50730 48880 55620

5 25 9632 9240 8648 40330 40740 35700 47170 47000 51500

6 30 9856 8925 8930 32700 33950 29580 44500 47940 51500

Spatial Uniformity Correction factor

If the software applies the spatial uniformity correction factor to plates with empty wells, non
dye-loaded cells, or a panel of cells that contain different dyes and/or dye concentrations, the
well-specific fluorescence counts are skewed by the correction factor. The EC50 of the agonists
tested are not affected.
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Determining Negative Control Correction

The negative control correction algorithm corrects for changes in fluorescence that occur in all
wells over the course of the experiment. Causes for these changes in fluctuations in
fluorescence include dye leakage from cells, fluid addition artifacts, changes in illumination
power, dye photo-bleaching, and temperature drifts.

The software derives the negative control correction factor by first calculating the mean
fluorescence of each of the samples of the negative control wells.

Sample Time Well

A1 – Ctrl A2 – Ctrl 3 – Ctrl Mean Correction Factor

1 0 8960 8925 8930 8938 1.00

2 5 9194 9030 8836 9017 0.99

3 10 9408 8925 8648 8994 0.99

4 20 9632 8820 8648 9033 0.99

5 25 9632 9240 8648 9173 0.97

6 30 9856 8925 8930 9237 0.997

The software divides the mean of Sample 1 by the mean of each of the samples to give the
sample-specific correction factor. The software multiplies each sample by its sample-specific
correction factor.

Sample Time Well

A1 –

Ctrl

A2 –

Ctrl

3 –

Ctrl

A4 Exp A5 Exp A6 Exp A7 +

Ctrl

A8 +

Ctrl

A9 +

Ctrl

1 0 8960 8925 8930 8938 8924 8976 8900 8930 8961

2 5 9194 8940 8748 8957 8643 9088 8370 9027 9177

3 10 9314 8836 8562 9172 8643 9189 8547 9027 9585

4 20 9536 8732 8562 48560 48015 42412 50223 48391 55064

5 25 9343 8963 8389 39120 39518 34629 45755 45590 49955

6 30 9560 8657 8662 31719 32932 28693 43165 46502 49955

For example, A1 Sample 1 is multiplied by 1.00.

Note: The negative control correction factor wells contain the same cells and dyes as the
experimental and positive control wells.



FLIPR Penta High Throughput Cellular Screening System User Guide

200 5069582 G

Determining Positive Control Scaling

The positive control algorithm compares the percent change in fluorescence counts of the
positive control wells with all wells. This algorithm facilitates comparisons of results between
data runs, such as different plates, by controlling factors such as cell density, cell response,
laser power, or exposure time. This algorithm makes EC50 comparisons easier.

Calculate the means of all samples of the positive control wells.

Sample Time Well Mean Difference from Sample 1S

A7 + Ctrl A8 + Ctrl A9 + Ctrl

1 0 8900 8930 8961 8930 0

2 5 8370 9027 9177 8858 -72

3 10 8547 9027 9053 9053 123

4 20 50223 48391 55064 51226 42296

5 25 45755 45590 49955 47100 38170

6 30 43165 46502 49955 46541 37610

The software calculates the difference in fluorescence counts between Sample 1 and all of the
samples. The software determines the greatest difference. 100 is divided by the greatest
difference in fluorescence counts to give the positive control correction factor, for example,
100/42296 = 0.0024. The software multiplies all samples by the correction factor 0.0024.

Sample Time Well

A1 –

Ctrl

A2 –

Ctrl

A3 –

Ctrl

A4

Exp

A5

Exp

A6

Exp

A7 +

Ctrl

A8 +

Ctrl

A9 +

Ctrl

1 0 21 21 21 21 21 21 21 21 21

2 5 21 21 21 21 20 21 20 21 23

3 10 22 21 20 22 20 22 20 21 23

4 20 23 21 20 115 113 100 119 114 130

5 25 22 21 20 92 93 82 108 108 118

6 30 23 20 20 75 78 68 1021 110 118

Note: All wells, at samples 1–3, range from 20 to 23%. The positive control wells at
Sample 4 range from 114 to 130% while the negative control wells remain at around 20%
throughout the experiment.
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Determining Subtract Bias

The subtract bias algorithm determines the change in fluorescence over background
fluorescence. You determine the sample number chosen as background. This algorithm, by
default, is always switched on and subtracts from Sample 1. The choice in the sample number to
use as background depends on the assay conditions. For example, the addition of agonist can
dilute the fluorescence signal in the supernatant, which would appear as a drop in fluorescence.
In this case, the best choice for background is the sample taken at the bottom of this drop in
fluorescence.

In the example, the percent positive fluorescence at Sample 1 is around 20% for all wells.
Subtracting the background at Sample 1 makes the data easier to interpret.

Sample 1 (or any sample chosen by the operator) from each well is subtracted from the samples
from the same well.

Sample Time A1 –

Ctrl

A2 –

Ctrl

A3 –

Ctrl

A4 Exp A5

Exp

A6

Exp

A7 +

Ctrl

A8 +

Ctrl

A9 +

Ctrl

1 0

2 5 1

3 10 1 1 1

4 20 1 94 92 79 98 93 109

5 25 1 71 72 61 87 87 97

6 30 1 54 57 47 81 89 97

The results show numbers above zero. The subtract bias algorithm places the data in a readily
interpretable form. The positive control wells at Sample 4 range from 93–109% positive. In
contrast, the negative control wells remain close to zero percent positive throughout the
experiment. The experimental wells show two wells with about 90% activity and one with 79%
activity at Sample 4.
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Determining Response Over Baseline

The response over baseline correction algorithm compensates for variations within a single
well.

The software derives the correction factor by calculating the mean fluorescence counts in each
well between the baseline start and end samples.

Sample Time Well

A1 –

Ctrl

A2 –

Ctrl

A3 –

Ctrl

A4 Exp A5 Exp A6 Exp A7 +

Ctrl

A8 +

Ctrl

A9 +

Ctrl

1 0 8000 8500 9500 8200 9200 8800 10000 9500 8700

2 5 8200 8600 9400 8300 9000 9000 9500 9700 9000

3 10 8400 8500 9200 8500 9000 9100 9700 9700 9400

Mean 8200 8533 9367 8333 9067 8967 9733 9633 9033

Note: Data from all 96 wells are included in the calculations, but the table displays data
from nine wells to simplify the example.

The software divides all samples taken from a particular well by their well-specific mean
baseline correction factor. For example, all samples from A1 are divided by 8200, A2 by 8533,
and so on.

The following table displays the results of applying the response over baseline correction
factor. Note the data displays as a fold increase of the response compared to the baseline with
Sample values that range in the single digits (0–6).

Sample Time Well

A1 –

Ctrl

A2 –

Ctrl

A3 –

Ctrl

A4 Exp A5 Exp A6

Exp

A7 +

Ctrl

A8 +

Ctrl

A9 +

Ctrl

1 0 0.98 1.00 1.01 0.98 1.01 0.98 1.03 0.99 0.96

2 5 1.00 1.01 1.00 1.00 0.99 1.00 0.98 1.01 1.00

3 10 1.02 1.00 0.98 1.02 0.99 1.00 0.98 1.01 1.00

4 20 1.05 0.98 0.98 5.4 5.51 4.68 5.86 5.40 5.98

5 25 1.05 1.03 0.98 4.44 4.63 3.90 5.45 5.195 5.54

6 30 1.07 1.00 1.01 3.60 2.76 3.23 5.14 5.29 5.54
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Appendix F: Robotic Integration

This section describes the interface between the FLIPR Penta System and a robotic instrument.
The intention is to provide a general overview of the interface between the instrument and
robot and a description of the communication protocol between the ScreenWorks Software,
which run on the host computer of the FLIPR Penta System instrument, and the robotic control
software.

The following Information might change as new development occurs. Check with your
Molecular Devices sales representative for updated information.

Conventions

Bold text is used for commands
Italic text is used for parameters
Parameters in bracket [parameter1] are optional
Parameters are separated by comma
<CR> is the ACSII code for ‘carriage return’ which indicates end of the command or end of
the response
<TAB> represents a tab
<SP> represents a space
| represents OR

Interface Versioning

As of version 1.1 of the automation interface, the interface is versioned separately from the
ScreenWorks Software and the FLIPR Penta System firmware. The interface now provides a
command to query the version number.

F
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Instrument Overview

Basic Function

The FLIPR Penta System is a fluorescence microplate reader you use for kinetic live cell-based
fluorescence and luminescence assays. A typical assay involves the following steps:

Introduction of a read plate that contains cells in solution or compounds into the instrument.
Acquisition of a baseline read (or series of reads) to determine the background
fluorescence or luminescence signal from the read plate.
Introduction of a potentially activating (or potentially inactivating) compound into the well or
cells in suspension.
Monitoring the changes in the fluorescence or luminescence signal from the read plate for
a period of time immediately following the introduction of the compound.
Further additions of different compounds to the well are typical in an assay on a
FLIPR Penta System. Between additions, you can replace or wash the pipette tips you use
for fluid transfer.

Cell response typically begins within 2 seconds of fluid addition and is monitored for 1–3
minutes. The software monitors the fluorescence or luminescence signals at the wavelengths
and frequencies you select within the physical constraints of the instrument.

Hardware Introduction

The instrument includes the following subsystems to accomplish the assays described:

Embedded Control System - The instrument contains an embedded control system to
control the instrument. Access this system with the ScreenWorks Software, which is
supplied with the instrument.
Plate Reader - The optics subsystem includes an illumination source with excitation filters,
emissions filters in a three-position filter changer, and a CCD camera. Use this system to
read both fluorescence and luminescence assays.
Pipettor - The instrument contains a pipettor to add fluids to the read plate during a series of
reads for kinetic assays. Equip the pipettor with a 96-well, 384-well, or 1536-well head for
general purpose fluid transfer between the plates in the instrument. Each head type uses
pipette tips or pin tools. The 96-well pipettor heads and 384-well pipettor heads use a
disposable plastic pipette tip. The 1536-well pipettor heads use a metal tip block. The 384-
well and 1536-well pin tool heads have replaceable pin tools.
Tip and Pin Washer - Each instrument includes a washer to wash tips or pins between fluid
transfers. The washer consists of a washer control module and a wash reservoir. The
sensors and control valves are installed on the right side of the instrument and connect to
the wash reservoir located in position 5 of the system stage.
FLIPR Cycler Plate Handler - A plate handler is available to move plates from a location
outside of the instrument to any of the first four stage positions and vice versa. The second
component of the FLIPR Cycler Plate Handler is an automated door system that allows
plates to be exchanged while an assay is in progress.
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Layout

The following displays the basic layout of the instrument subsystems:

The top instrument compartment contains the pipettor and plate platform (stage). Plates are
placed in the read position of the 5-position platform to be read by the plate reader, which is
located in the optics compartment below the platform.
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Plate Layout

The stage has 4 positions where you place plates and/or tips:

Position 1: Source Plate 1 or Tip-loading
Position 2: Source Plate 2
Position 3: Read Plate
Position 4: Source Plate 3

A tip wash reservoir for tips or pins is available in position 5.

Place either tip racks or plates in the tip-loading position (position 1) and the source plates in
position 4. The wash reservoir is not disposable, but you can replace the wash reservoir when
you change the head type.
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Plate Handling System

Manually place plates or tip racks in the instrument or use a robot or stacker to deliver plates
automatically.

In manual mode, you access the plate stage through a large, manually operated door. This door
opens on a vertical hinge, mounted to the left side of the door.

At the start of an assay, the door latches to prevent interruption of the assay in progress or
injury. The door latches for most instrument actions not associated with an assay, for example,
load tips, unload tips, and signal test. This latch remains engaged throughout the assay or
operation. In manual mode, this latch disengages at the end of the assay.

For robotic integration, plates are delivered to a single location outside of the instrument. The
placement area for robotic delivery of plates to the instrument is to the left of the instrument.
The following image shows the locations for manual and robotic access to the instrument:

A further illustration of this arrangement shows the relation of the plate handler to the pipettor
system.

Terminology

The manual access door side of the instrument is the front of the instrument.
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Robotic Plate Loading

Plates can shuttle into the instrument by a plate handling subsystem called the FLIPR Cycler
Plate Handler. The robotic access doors and the FLIPR Cycler plate handler can exchange
plates and tips while an assay runs to lessen dead time between assays and to handle more
source plates in an assay than the plate stage can accommodate.

The following diagram illustrates the steps to load plates in robotic mode:

A reverse process is used when unloading plates in Remote mode.

Optics Access Door

The plate reader optics are mounted to the plate stage directly below the read plate position. A
door to the optics compartment allows you to change emission filters and LED modules. This
door latches when an assay is in progress to prevent users assay interruption or injury.

Washer Placement

A tip/pin washer is located on the lower right side of the instrument, towards the front. Plumbing
for the washer is isolated from the optical and power components. Access is provided for the
washer tubing.

Other Instrument Access Areas

The following diagram illustrates the instrument access areas.
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AC power enters on the right rear of the instrument. Directly above this entry is the main power
switch. The power switch is accessible in both robotic and manual modes. There are three
indicator lamps near the power switch. View these indicators to debug instrument power
problems. The main communication connection from the instrument to the host computer is
located above the power indicators.

The instrument status panel is located next to the upper door handle to indicate whether or not
the instrument is running and safe to open. It includes an emergency Interrupt button to stop
processes.

The panel has two lights and the Interrupt button:

Assay Running (Locked) yellow light - The FLIPR Penta System is performing a task. The
upper and lower doors lock until the task finishes or is halted using the Interrupt button.
Assay Finished (Unlocked) green light - No tasks are being run and it is safe to open the
upper and lower instrument doors.

The Interrupt button is an override button to halt all tasks. When you press the Interrupt button,
the yellow light flashes until the system reaches a safe state to open the doors, then the green
light comes on.
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CAUTION! The Interrupt button immediately ends the experiment and should only be
used in emergencies. Interrupting the instrument while an assay in progress almost
always results in the loss of the plate being run. The yellow light flashes until the
instrument is safely unlatched. You may need to reinitialize the system by clicking the
Instrument menu and selecting Reset before you resume normal instrument interactions.

Monitor and Keyboard Placement

The host computer for the FLIPR Penta System mounts to the instrument right side. This
computer provides the user interface and path to control the instrument. The computer monitor
and keyboard mount to an adjustable arm on the instrument front right.

You can move the host computer, keyboard, and monitor to a different location but it must be
directly connected to the instrument. It is not possible to communicate between the host
computer running the ScreenWorks Software and the instrument across a network.

Required Access Areas

The system dimensions for the FLIPR Cycler Plate Handler is approximately 1346 mm (53
inches) wide by 737 mm (29 inches) deep by 1787 mm (70 inches) tall. The FLIPR Penta System
has rolling castors to move for adjustments and to perform maintenance. Leveling feet are
installed on the lower instrument chassis to stabilize the instrument and to establish a uniform
instrument deck level where the lab floor is not flat.

The computer and monitor mount to the right front side of the instrument and require a
minimum space of 2159 mm (85 inches) wide by 1549 mm (61 inches) deep. The tip wash bottles
and chiller require a minimum 711 mm (28 inch) square footprint on the right side of the
instrument. This space allows access to the main power switch, washer tubing, and
communication connections.

The cabinet should have access space of 1219 mm (48 inches) in front to exchange tips, plates,
and reservoirs. An additional 610 mm (24 inches) behind and 254 mm (10 inches) to the left
should be left available to service the instrument.

WARNING! The FLIPR Penta System can weigh as much as 390 kg (860 lbs.). Ensure
adequate personnel are present when you install or move the system. Follow all safety
precautions and use proper move techniques.
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The following drawings illustrate these requirements:
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FLIPR Penta System Control Architecture

General Description

The FLIPR Penta System consists of a host computer and a stand-alone instrument.

The ScreenWorks Software installs on the host computer supplied with the instrument. This
software is the primary user interface. Use the ScreenWorks Software to setup protocols, run
assays, analyze data, and export data. The ScreenWorks Software communicates to the
instrument with a dedicated connection using a communication protocol proprietary to
Molecular Devices. The status of the instrument and assay is monitored by the ScreenWorks
Software, which then displays data as it is collected.

The instrument has all the hardware and firmware components required to perform an assay
and report the results. It does not have the ability to display the results of experiments directly
to a user. The user may not directly communicate with the stand-alone instrument in order to
obtain data or to configure and run assays.

The host computer has two Network Interface Cards (NICs). The first NIC communicates with
the instrument using a fixed IP address and cannot be used for any other purpose. The second
NIC connects the host to the Local Area Network (LAN) or to other devices (for example, router,
hub, scheduling workstation).

The ScreenWorks Software and the instrument have two operating modes: Manual mode and
Remote mode. Place the ScreenWorks Software Remote mode for control by third-party
software via the automation interface.

Manual Mode

By default, the instrument starts in Manual mode.

In Manual mode, configure assays in the ScreenWorks Software and manually load plates and
tips into the instrument. The following simple diagram illustrates this interaction:

In Manual mode, a second network connection on the host computer is not monitored. It is
provided primarily to connect to your network to transfer data from the FLIPR Penta System host
computer for storage or analysis elsewhere.
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Remote Mode

Remote mode allows the ScreenWorks Software to communicate with external devices such as
robots and stackers supplied by third parties. Use these devices to supply plates and tips to the
FLIPR Penta instrument.

When in Remote mode, third-party software has full control over the FLIPR Cycler plate handler.
The FLIPR Penta System software does not initiate any plate handling events. Third-party
software monitors the assay through the ScreenWorks Software automation interface and
provides additional plates and tips to the instrument as needed.

Interact with the third-party software to select a protocol or preload a protocol in the
ScreenWorks Software before you enter Remote mode. The automation interface does not
create assay protocols. Interact with ScreenWorks Software while assays run remotely to QA
data and monitor progress.

You can configure the control system to communicate between the ScreenWorks Software and
robotic controller in several ways. The following illustrate a range of options but are not
exhaustive.

Third-Party Software via Network
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Third-Party Software on the FLIPR Penta System Host Computer

Direct Connection From a Third-Party Software Host to the FLIPR Penta System host

Communication Protocol and Address

Communication between third-party software and the ScreenWorks Software uses the TCP/IP
protocol. The third-party software can be resident on another computer outside of the
FLIPR Penta System or on the instrument host computer.

If the third-party software is remote to the host computer, the ScreenWorks Software receives
communication through the IP address of the host computer on which it is running.

If the third-party software is run on the instrument host computer, the ScreenWorks Software
receives communication through IP address 127.0.0.1 (localhost).

In all cases, the ScreenWorks Software sends and receives commands through TCP/IP port 7.
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General Remote Mode Use

This section provides an overview to run the FLIPR Penta System in Remote mode.

Instrument Startup

When the instrument is powered on, it performs a series of initialization steps which can take
several minutes.

Configure the camera
Initialize the pipettor
Initialize the plate handler and automatic door
Determine and check the installed LEDs
Determine the installed emission filters
Initialize the tip washer
Communicate with the chiller

By default, the instrument is in Manual mode upon startup. The main manual access door is
unlocked, the outer automated door is closed, and the FLIPR Cycler plate handler is moved
outside the instrument, above the automation landing pad. When the instrument is in Manual
mode, the outer automated door and plate handler do not move from these positions, except
during an instrument reset.

Software Startup

To use the instrument, the host computer must be started, and the ScreenWorks Software must
be run. The ScreenWorks Software establishes communication with the instrument and
determines the instrument status and configuration which displays in the Instrument Status
toolbar. This toolbar has an Instrument Status tab that displays the instrument status including
the status of assays in progress and an Instrument Config tab that displays which LED modules,
emission filters, and heads are installed.

Protocol Creation

You create assay protocols in Manual mode. You do not need to load the protocols prior to
placing the instrument into Remote mode, but any protocol you use in Remote mode must be
created and saved with a valid protocol file name before you enter Remote mode.

Test protocols in Manual mode prior to running them in Remote mode.

Instrument Setup

You can load tips or plates into the instrument before you place the instrument in Remote
mode. These actions can be done in Remote mode but in certain conditions you should do this
through the main manual door before you start Remote mode.

If you use tips for an extended period of time and the tips/source 1 position is used as a source
position, you should load the tips manually before you place the instrument in Remote mode.

If you use boats or reservoirs as source plates, you should load these by hand in Manual mode.
Do not use the FLIPR Cycler plate handler to load reservoirs because the plate handler moves
rapidly and large wells spill liquid within the instrument.
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Instrument Mode Setting

Prior to running an assay in Remote mode, click the Instrument menu and select Set Remote
Mode to place the instrument in Remote mode.

After the you start Remote mode, the instrument locks the main manual doors, moves the plate
handler inside of the instrument, closes the inner automated door, and opens the outer
automated door. At the end of any plate handling operation, the instrument returns to this
position. The outer manual doors remain locked as long as the instrument is in Remote mode.

The instrument assumes that any plates in the instrument when you start Remote mode are
acceptable for use until a protocol runs and the plate is no longer needed.

Loading Protocols

The openprotocol command loads protocols when the instrument is in Remote mode. This
command loads the protocol and closes any other open files. Protocols open regardless of
whether they are valid.

Running Protocols

After you place the instrument in Remote mode and a protocol opens, the protocol may be run
by sending the runprotocol command. When a protocol begins to run in Remote mode, open
data files close.

Instrument Status Updates

The status command queries the instrument at any time for instrument status, even when in
Manual mode.

Plate Status Tracking

The most important information in the status command is the status of the plates in the
instrument. From the status response, four possible information items may be determined about
the plates in each of the four plate positions.

The first item is the plate assigned to the plate position for the protocol. This is the plate name
you assign in the ScreenWorks Software for the plate type, and you assign to a position for the
protocol. A robot can use this information to confirm that the correct plate type is delivered to
the required position. The ScreenWorks Software and the FLIPR Penta System instrument have
no method to determine whether the plate delivered is of the required type and always
assumes that the plate type delivered is correct.

The status response indicates whether a plate is present in each location. This is a direct
readout of the status of the plate presence sensors in the instrument. This readout does not
depend on whether a plate is required in the position or if the plate present is the correct plate.

The REMOVEPLATES line in the status signals that the plates have completed. Plates complete
in different ways. If the plates are source plates, the ScreenWorks Software indicates that they
are finished when an aspiration from the plate is complete, and that aspiration is checked to
show that the plate is finished after the aspiration. For tip racks, they are marked complete as
soon as tips load or unload to/from the rack. Read plates are marked as complete at the end of
the last read in the assay in which they are used.

The NEEDPLATES line indicates plates that are needed for the assay in progress to continue.
The instrument indicates that it needs a plate if it gets to an operation that requires a plate in a
particular location and that location is either empty or contains a plate that was marked as
finished.
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Bar Code Tracking

The bar code can be supplied to the software by the robot controller when the robot controller
instructs the ScreenWorks Software to load a plate. The software records the bar code values of
the plates delivered in the data file in which they are used.

The instrument can attempt to read a bar code for the plates it loads using the plate handler. If
this value is not overridden by one supplied by the robot controller, this bar code is recorded in
the data file when the plate is used.

Regardless of the method used to deliver bar code information to the instrument, bar code
information might not be present when an assay starts, since all required plates might not be
present in the instrument. You can configure the software to name the data file based on the
bar codes of the plates used, so the data file name can change as the assay completes.

Setting Up Protocols for Remote Control Use

You must create protocols in Manual mode before you start Remote mode, and you should test
protocols in Manual mode to ensure that they work as expected.

The user guide describes how to set up protocols and you should be familiar with this process
before you read further in this section. See Setting Up Assay Protocols on page 112.

The following sections describe items you should be aware of when you set up the protocols
you plan to run in Remote mode.

Settings Screen

Read Mode Settings

In the settings screen, configure the read modes. The settings for the read mode depend on the
assay dye, plate type, cell type, and condition. You determine these settings during assay
development and no changes are required when you switch to Remote mode.

Note: It is not possible to vary these settings based on the cell plate you load.

Assign Plate Settings

Assign plates to the required positions for the assay in the Assign Plate to Position field. The
assignment of plates is critical to the smooth functioning of the assay.

You can assign only one type of plate to a position throughout an assay. For example, you
cannot assign a normal plate to a position for the first part of an assay and then assign a deep-
well plate to that position for the rest of the assay.

Always assign the read plate to the read position. There are no special suggestions in Remote
mode for this assignment.

Carefully consider the assignment of source plates and tips. The pipettor and the plate handler
are both used in remote assays and must share the space above the plate locations. The
instrument monitors the locations of the pipettor and the plate handler and moves them to
prevent collisions. The pipettor and plate handler are never allowed to be above the same plate
position at the same time. You should arrange plates to minimize potential interactions between
the plate handler and the pipettor.

Use the following guidelines to assign plate positions for automation:
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The plate handler cannot handle open reservoirs with very large wells. You must place these
plates in the instrument manually prior to entering Manual mode. You must halt remote control
to replace these plates and place the instrument in Manual mode to replace or refill the
reservoir. Deep well plates are a good alternative to these plates.

If tips load in the experiment, you must assign the tips to the Source Plate 1 location. When you
assign tips to this position, you cannot use the position for source plates. Unless the tips are to
be changed for every plate, you should load the tips before you place the instrument in Remote
mode. Alternatively, if you create a tip configuration protocol that loads and washes the tips,
you can run the assay and the empty tip rack can be removed by the robot to allow you to use
the source 1 position for other plates. As of v1.1 of the automation interface, tip loading and tip
washing is available.

You should place plates that switch frequently closer to the left side of the instrument (near the
automated landing pad) than plates which do not switch frequently.

Place deep well plates (or reservoirs) that you use for an entire series of assays in the source 3
location to minimize the interaction between the pipettor and the plate handler when switching
plates during the assay.

You can only RESET the instrument if a tip rack is present in the instrument. A RESET is required
if the instrument enters a fault condition. If the system requires an automated recovery from
fault conditions, use the tips/source 1 position for tips only and leave an empty tip rack in this
position at all times.

Data File Name Settings

Configure the data file name in the Data File Name field.

If you select Include Bar Code, the bar codes for all of the plates you require are included in the
data file name. Bar codes are separated by an underscore (_). If a bar code cannot be read, or
one has not been provided during the loadplate command, the software records Bad_bar_
code.

The settings for the data file name are ignored in Remote mode when the data file name is
included with the runexperiment command line. Take care when you use this command to
ensure that data file names are unique to prevent the overwriting of data files.

If you allow the ScreenWorks Software to create the data file name, it ends in _###.fmd, where
### is the plate number with this base name. Use this option to ensure that no data is lost due
to file overwriting.

Folder Settings

Use this to assign the directories in which to save the data and export files. There is no
difference between settings for these directories in Remote mode and in Manual mode.

Remote mode can produce large amounts of data. The ScreenWorks Software does not allow
new assays to begin if less than 50MB of hard disk space is available.

Saving data across a network connection is not recommended. If a protocol saves data across a
network connection, you cannot run the protocol if the network connection is unavailable. If a
protocol that saves across the network runs when the network connection is interrupted, data
can be lost, and the software can encounter problems.
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Temperature Control Settings

Use temperature control settings to set the temperature for the protocol. The instrument must
be at the set point before you run the assay.

If you load a protocol that requires temperature control and the runexperiment command is
sent, the software confirms that the instrument has achieved this temperature. If the instrument
has not reached the temperature, the software displays a message. If the temperature has been
reached, the experiment runs.

Auto Print Options Settings

Problems with the printer can disrupt the operation of the system. You should not use automatic
printing in Remote mode.

Analysis Screen

There are no special notes regarding the Analysis screen in Remote mode. Setup this screen as
you would for a manual assay.

Set up groups, display, and reduction settings prior to running a large number of plates. Define
these in the protocol so that they are automatically replicated in each data file as the data file is
created.

Transfer Fluid Processes

Settings to transfer fluids in Remote mode are the same as Manual mode, with three exceptions.
These are in aspiration height over multiple plates, and the Pause In Well field.

Aspiration Height over Multiple Plates

When you run in Remote mode, you should use a common addition source plate over a series
of plates. The simplest way to do this is to create a single protocol which aspirates from the
lowest allowed point in the source well. You need to determine the maximum amount of liquid
in the well so that the liquid displaced during insertion of the tip into the well is not pushed out
of the well. This limits the amount of liquid that you can use in the source well. Alternatively, you
can choose to create a series of protocols at successively lower aspiration start levels.

To provide an example of this situation, consider using a 384-well plate with a 250 µL well. This
source plate is used to add a common agonist to all wells. In the assay, 20 µL of this agonist is
added. Leave the plate in the instrument for a series of plates before you replace it. The
FLIPR Penta System allows protocols that begin aspiration as low as 8 µL for this plate. Inserting
a 384-well tip all the way to the bottom of this plate displaces 50 µL of liquid.

In the simple method described above, do not start with more than 190-200 µL of liquid in the
plate because any more can spill liquid when the tip is fully inserted. The single protocol begins
aspiration at 8 µL height. Run this assay 9 times before you replace the plate, leaving 10-20 µL
of liquid in the wells after the source plate is removed.

In the more complex method, fill the wells to 230–240 µL. Then, set up an assay that starts
aspiration at ~240 µL in height, a second assay to start at ~220 µL, and a third assay to start at
~200 µL. Continue to create separate assays at different heights or use the third assay for the
remaining plates. In this case, you can run 11 plates before you need to change the plates.

The simple method is simpler to setup and run. The more complex method allows you to switch
the source plates less often. It also decreases the proportion of wasted common reagents.
Finally, it can decrease carryover of compounds sticking to the outside of the tips, especially if
you create the protocols to retrieve liquid from progressively lower heights all the way through
the well height.
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Pause in Well Edit Box

The Pause in Well field in the Edit Dispense dialog allows you to have the pipettor remain in the
well after the dispense. This pipettor operation leaves the tips in the well for the time you
specify. When the tips are in the well, it might prevent the exchange of plates from any position,
and certainly not from the read or source 3 positions. For this reason, you should not use this
option in Remote mode.

Wash Tips Processes

No special requirements are needed for the Wash Tips process for Remote mode. The pipettor
and the plate handler do not share the tip reservoir position. For this reason, plate handling can
proceed unhindered during wash operations.

Mix Fluid Processes

The Mix Fluids process does not require any special changes for Remote mode. The same
warning that applies to Pause in Well for dispensing also applies here. Mixing in any well can
interfere with plate handling, so use of this function might require some experimentation.

Read Processes

No special requirements are needed for the Read processes in Remote mode.

Finish with Source Processes

This notifies the plate handler to remove the plates in Remote mode.

Command Set

Command Syntax

All commands and parameters must be sent in lower case and end with <CR>.

All responses are given in lower case and end with <CR>.

Response from the ScreenWorks Software has one of the following forms:

ok<CR>

errorcode, error string<CR>

status<CR>

ok<CR> - Command started successfully or command executed successfully.
errorcode, error string<CR> - Command failed because of either an indicated condition or
an instrument error. Error codes are followed by a comma, a space, and then a string that
describes the error of up to 300 characters. Error strings are entirely lower case.
status<CR> - The formatted status text which was requested.
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Version <CR>

Command Description

This command returns the version string for the automation interface command set. This
command is supported for versions 1.1 and newer. Older versions return the error c69, badly
formed or unrecognized command in response to this command.

Command Parameters

There are no parameters with this command.

Example Command Line

version<CR>

Example Response

1.1<CR> or c69, badly formed or unrecognized command.<CR>

Suggested Steps in Command Usage

This should be the first call you make to the instrument after making a TCP/IP connection to
ScreenWorks Software. To ensure problem free operation of the application for
FLIPR Penta System customers, the robotic integrator must consider limiting use of the
application to interface versions they have tested.

Status <CR>

Command Description

The status command returns the status of the instrument. The status response is an ASCII text
string which includes:

Information about the instrument type and firmware version.
Whether the instrument is functioning normally, or an error occurred. If an error occurs, this
field contains an error code and an error string of less than 300 characters. The error code
and error string are separated by a comma and space.
The instrument status field reports a summary of status information including whether the
instrument is busy, faulted, error, resetting, aborted, or idle. It reports whether the
instrument is in Remote mode or Manual mode. In Manual mode, only status information is
available. All other commands do not function. This line reports whether the software is
online (connected to the instrument) or not.
Whether an experiment is running or not. Do not open or start another experiment until the
first finishes.
Name of the plates assigned to each position.
Whether plates are present or not on plate locations.
Whether plates need to be loaded or removed.
Whether the plate handler is busy or idle.
Whether the landing pad has a plate or not.
Chamber temperature. Status reports not_ok while chamber is not at setpoint temperature
(typical factory tolerance of ±0.5 °C/± 41°F, fault if sensor does not return a reading, off if
chamber temperature control has been disabled, or ok otherwise.
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Camera temperature. Status returns not_ok while camera CCD temperature cycles and/or
out of range as defined by factory firmware settings, off if camera temperature control is
disabled, or ok otherwise. The factory setpoint depends on the camera:
EMCCD camera: -70°C (-94°F) ± 2°C
HS EMCCD camera: -70°C (-94°F) ± 2°C
Also returns actual CCD temperature and setpoint.
Waste/fill bottle status.
Tips on|off.
Outer auto door, open/closed. If the door is closing, it reports as closed.

Example Command Line

status<CR>

Response Format

instrument <SP>instrument name<TAB>

version<SP>mm/dd/yyyy<TAB>

function<SP>ok|errorcode|fatalcode,[errorstring]<TAB>

inst_status<SP>busy|fault|error|resetting|abort|idle,remote|manual,o

ffline|online<TAB>

exp_running<SP>yes|no<TAB>

readplate<SP>platename|none,have|empty<TAB>

sourceplate1<SP>platename|none,have|empty<TAB>

sourceplate2<SP>platename|none,have|empty<TAB>

sourceplate3<SP>platename|none,have|empty<TAB>

loadplates<SP>re[,s1,s2,s3,ti]|none<TAB>

removeplates<SP>re[,s1,s2,s3,ti]|none<TAB>

platehandler<SP>idle|busy_load|busy_remove<TAB>

plate_on<SP>yes|no<TAB>

camera_temp<SP>ok|not ok|off,temp,setpoint<TAB>

chamber_temp<SP>ok|not_ok|fault|off<TAB>

waste_bottlea<SP>ok|full<TAB>

waste_bottleb<SP>ok|full<TAB>

fill_bottlea<SP>ok|empty<TAB>

fill_bottleb<SP>ok|empty<TAB>

tips<SP>on|off<TAB>

outer_auto_door<SP>open|closed<CR>

Example Response

instrument<SP> tetra<TAB>

version<SP> sep 30 2004<TAB>

function<SP> d70, initialization halted because tips are loaded. please

verify that the appropriate tip rack (96,384,1536)is loaded and select

reset <TAB>

inst_status<SP> idle,remote,online<TAB>

exp_running<SP>no<TAB>
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readplate<SP> default384,have<TAB>

sourceplate1<SP>default384,have<TAB>

sourceplate2<SP>none,have<TAB>

sourceplate3<SP>none,have<TAB>

loadplates<SP>none<TAB>

removeplates<SP>none<TAB>

platehandler<SP>idle<TAB>

plate_on<SP>no<TAB>

camera_temp<SP>ok,-35,-35<TAB>

chamber_temp<SP>off,0,0<TAB>

waste_bottlea<SP>ok<TAB>

waste_bottleb<SP>ok<TAB>

fill_bottlea<SP>ok<TAB>

fill_bottleb<SP>ok<TAB>

tips<SP>on<TAB>

outer_auto_door<SP>closed<CR>

Suggested Steps in Command Usage

Send status command.
Response is the instrument status.

Loadplate<TAB>Location, Last Plate[, BAR CODE] <CR>

Command Description

Loads plate or tips to the location you specify from landing pad. The plates or tips must be
placed on the instrument landing pad prior to issuing the command. You can use up to 13 plates
(1 source plate, 12 compound plates) in a single experiment.

Additional parameters are available to provide the bar code for the plate and to identify the final
plate for an assay.

The bar codes of up to 5 plates can be recorded in the data file.

Command Parameters

There are four parameters with this command.

The parameters are location, bar code, and last plate. The location parameter is required. The
bar code and last plate parameters are optional. If you use the bar code parameter, you must
also use the plate order parameter.

Location parameter must be one of following:

re – Read plate location
s1 – Source plate 1 location
s2 – Source plate 2 location
s3 – Source plate 3 location
ti – Tips loading location

The tips and source 1 location are the same position. Use either the ti or s1 parameter to indicate
this position.
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Bar code parameter must be:

String up to 20 characters.
String can have letters, numbers, underscore, and spaces.

The instrument always attempts to read a bar code while loading a plate. If a bar code is
supplied through the loadplate command, any bar code found on the plate loaded is ignored.

The last plate parameter indicates whether or not the plate being loaded is the last plate in the
experiment. This parameter must be yes or no. The last plate parameter is no longer used by
the FLIPR Penta System and ScreenWorks Software but continues to be required for
compatibility reasons.

Example Command Line

loadplate<TAB>re, no, abcd1234<CR>

Example Response

ok<CR> or c10, error string<CR>

Suggested Steps in Command Usage

1. Check if instrument status is acceptable, such as no error state, no plate on landing pad, no
plate in target location, plate handler is idle.

2. Put plate on landing pad.
3. Send loadplate command.

Response is OK that confirms the command executed or a Condition code that confirms the
command did not execute.

4. Monitor plate handler status for completion or errors.

Command Specific Error Responses

C00 - Instrument is not functionalCondition
C05 - Invalid plate locationCondition
C10 - Plate handler busyCondition
C20 - Landing pad does not have a plateCondition
C15 - Plate location already has a plateCondition

Removeplate<TAB>location <CR>

Command Description

Removes plate or tips from the location you specify. If you set the source plate3 location for tips
in the experiment, the instrument assumes tips are present in that position.

Command Parameters

There is one parameter, location, for this command.

Location parameter must be one of following:

re – Read plate location
s1 – Source plate 1 location
s2 – Source plate 2 location
s3 – Source plate 3 location
ti – Tips loading location

The tips and source 1 location are the same position. Use either the ti or s1 parameter to indicate
this position.
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Example Command Line

removeplate<TAB>s1<CR>

Example Response

ok<CR> or c20, error string <CR>

Suggested Steps in Command Usage

1. Check if instrument status is acceptable (no error state, no plate on landing pad, plate
present in target location, plate handler is idle).

2. Send removeplate command.
Response is OK that confirms the command executed or a Condition code that confirms the
command did not execute.

3. Monitor plate handler status for completion or errors.

Command Specific Error Responses

C00 - Instrument is not functionalCondition
C05 - Invalid plate locationCondition
C10 - Plate handler busyCondition
C21 - Landing pad has a plateCondition
C16 - Plate location doesn’t have plateCondition

Openprotocol<TAB>File Name<CR>

Command Description

This command opens the protocol you specify. Any documents that are open before you send
this command close automatically. Only one protocol can be open at the time.

Command Parameters

There is one parameter, file name, for this command.

The filename parameter is the complete file name of the protocol to open, including path and
file type identifier (*.fmp).

Example Command Line

openprotocol<TAB>c:\screenworks\protocols\myprotocol.fmp<CR>

Example Response

ok<CR> or c30, error string <CR>

Suggested Steps in Command Usage

1. Make sure experiment is not running.
2. Send openprotocol command.

Response is OK that confirms the command executed or a Condition code that confirms the
command did not execute.

Command Specific Error Responses

C25 - Experiment is runningCondition
C30 - Protocol not foundCondition
C35 - Protocol could not be openCondition
C36 - Invalid protocol nameCondition
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Findprotocols<TAB>Folder<CR>

Command Description

This command returns all the protocols in the folder you specify. The command returns a
comma-delimited list that contains all *.fmp type files saved in the folder. These files are not
checked to confirm that the protocols are valid for the current instrument configuration.

Command Parameters

There is one parameter, folder, for this command.

The folder parameter identifies the folder for which a list of all *.fmp type files return. The folder
must be complete and in the correct Windows format, including the drive identifier and a closing
backslash(\).

Example Command Line

findprotocols<TAB>c:\screenworks\protocols\<CR>

Example Response

[myprotocol1.fmp,myprotocol2.fmp,myprotocol3.fmp]<CR> or c45, error string
<CR>

Suggested Steps in Command Usage

Send findprotocol command at any time.
Response is a list of protocols separated by comma or a Condition code that confirms the
command did not execute.

Command Specific Error Responses

C45 - Folder does not existCondition
C46 - Invalid folder nameCondition
C50 - Current document is not valid protocolCondition
C56 - No protocols found in dirCondition

Runexperiment<TAB>[Data File Name]<CR>

Command Description

This command runs the open protocol, if it is valid for the current instrument configuration.

Running a protocol creates a data file and shifts the software focus to this data file for the
duration of the experiment. When you run in Remote mode, the data file closes when the
experiment is done and the focus returns to the protocol file.

Command Parameters

There is one optional parameter, data file name, for this command.

If you use a data file name parameter with this command, the data file created by running the
protocol is named from the data file name. The file name appends to the Data folder path you
specify in the protocol Settings dialog in the ScreenWorks Software. Never specify a data file
name that contains a full path.

If the data file name parameter is not given, the data file saves with the auto save name as
indicated in the Settings dialog.

Example Command Line

runexperiment<TAB>mydata10312003.fmd<CR>
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Example Response

ok<CR> or c50, error string <CR>

Suggested Steps in Command Usage

1. Check if instrument is functioning fine.
2. Make sure the experiment is not running.
3. Open protocol first by sending openprotocol command.
4. Send runexperiment command.

Response is OK that confirms the command executed or a Condition code that confirms the
command did not execute.

5. Monitor status for completion or errors.

Command Specific Error Responses

C00 - Instrument is not functionalCondition
C25 - Experiment is runningCondition
C50 - Current document is not valid protocolCondition
C47 - Invalid data file nameCondition

Stopexperiment<CR>

Command Description

This command stops the current action being performed by the instrument.

The stopexperiment command stops the experiment immediately. This can halt the
instrument pipettor in the midst of a motion causing the instrument to enter a fault state which
requires an instrument reset. The pipettor may not be in motion but might have tips that contain
fluid or are in a source or target plate. In these cases, it might be possible to recover without
resetting by washing the tips. An instrument reset is recommended following the use of the
stopexperiment command.

Command Parameters

There are no parameters associated with this command.

Example Command Line

stopexperiment<CR>

Example Response

ok<CR> or c55, error string <CR>

Suggested Steps in Command Usage

1. Check if instrument is functioning fine.
2. Make sure experiment is running.
3. Send stopexperiment command.

Response is OK that confirms the command executed or a Condition code that confirms the
command did not execute.

4. Monitor status for completion or errors.

Command Specific Error Responses

00 - Instrument is not functionalCondition
55 - No experiment is runningCondition
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Clearerror<CR>

Command Description

Cleans error in case recoverable error occurred.

Command Parameters

There are no parameters associated with this command.

Example Command Line

clearerror<CR>

Example Response

ok<CR>

Suggested Steps in Command Usage

1. Check instrument status.
2. Check if error is occurred.
3. Send clearerror command.

Response is OK that confirms the software has attempted to clear the error.
4. Monitor status for error is cleared.

Loadtips<CR>

Command Description

This command loads the tips onto the pipettor head from position s1.

This command executes if tips are not already loaded and a plate is in the tips position. The
instrument cannot confirm that the plate in the tip load position is actually a tip rack. You are
responsible to ensure that the plate in that position is actually a tip rack. Attempting to load tips
when a plate, rather than a tip rack, is in the tip load position results in an instrument fault and
can result in damage to the plate, the instrument, or both.

Command Parameters

There are no parameters associated with this command.

Example Command Line

loadtips<CR>

Example Response

ok<CR>
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Suggested Steps in Command Usage

1. Make sure an experiment is not running.
2. Check the instrument status to make sure tips are not already loaded.
3. Place tip rack in tip load position via the loadplate command.
4. Send loadtips command.

Response is OK that confirms the command executed or a Condition code that confirms the
command did not execute.

5. Monitor status for completion, and error status for any other kind of error.

Command Specific Error Responses

C58 - Cannot load tips, tips on pipettorCondition

Unloadtips<CR>

Command Description

This command unloads the pipette tips from the pipettor head into an empty tip rack you place
in the tip load position.

This command executes if you load tips and any plate is in the tips position. The instrument
cannot confirm that the plate in the tip load position is actually an empty tip rack. You are
responsible to ensure that the plate in that position is actually an empty tip rack. Attempting to
load tips when a plate or full tip rack, rather than an empty tip rack, is in the tip load position
likely results in an instrument fault and can result in damage to the plate, the instrument, or both.

Command Parameters

There are no parameters associated with this command.

Example Command Line

unloadtips<CR>

Example Response

ok<CR>

Suggested Steps in Command Usage

1. Make sure an experiment is not running.
2. Check the instrument status to make sure tips are currently loaded.
3. Ensure that an empty tip rack is in tip load position.
4. Send loadtips command.

Response is OK that confirms the command executed or a Condition code that confirms the
command did not execute.

5. Monitor status for completion, and error status for any other kind of error.

Command Specific Error Responses

C59 - Cannot unload tips, tips not on pipettorCondition
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Cyclecameratemp<CR>

Command Description

This operation cycles the camera temperature. It sets the camera setpoint to 20°C (68°F), waits
for the camera to reach this setpoint, resets the camera to -45°C (-49°F), and then waits for the
camera to return to this temperature. Use this command when you transition from fluorescence
to luminescence experiments. Cycling the camera temperature allows the camera CCD chip to
recover from the high light levels present during fluorescence experiments and improves data
quality in subsequent luminescence experiments.

This command requires up to 15 minutes to complete execution.

Command Parameters

There are no parameters associated with this command.

Example Command Line

cyclecameratemp<CR>

Example Response

ok<CR>

Suggested Steps in Command Usage

1. Make sure an experiment is not running.
2. Send cyclecameratemp command.

Response is OK that confirms the command executed or a Condition code that confirms the
command did not execute.

3. Monitor status for completion or errors.

Tempcontrolonoff<TAB>Temp<CR>

Command Description

This command sets the temperature for the instrument chamber. After you send this command,
the robotic controller monitors the instrument temperature to confirm that the instrument
reaches the setpoint. Some protocols do not execute until the required temperature is reached.

Example Command Line

tempcontrolonoff<TAB>12<CR>

Example Response

ok<CR>

Suggested Steps in Command Usage

1. Make sure an experiment is not running.
2. Send tempcontrolonoff command.

Response is OK that confirms the command executed or a Condition code that confirms the
command did not execute.

3. Monitor status until the instrument reports that it reaches the requested temperature.

Command Specific Error Responses

C60 - Temperature Control System is not functioning
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Washtips<TAB>Fluid Type, Wash Cycles, Volume/Stroke, Aspirate Speed,
Pump Speed, Strokes, Hold Time, Dispense Speed<CR>

Command Description

This command is the equivalent of clicking the Instrument menu and selecting Manual
Operation and then selecting Wash Tips. This selection washes the pipette tips with the
parameters you provide.

Command Parameters

There are eight required parameters for this command. You must supply all eight parameters for
this command to properly execute. For some of the parameters, acceptable values can vary
depending on the head type you install on the instrument. The following table lists the
parameters, their purpose, and the appropriate range for the commands.

Parameter Description Acceptable values or range

96-well

head

384-well

head

1536- well

head

Fluid type Indicates which wash fluid bottle to use. a, b

Wash Cycles Number of wash reservoir fill/drain cycles to

complete. The requested # of strokes is

repeated for each cycle.

1,2,3,4,5

Volume/stroke Volume to draw into the pipette tip in each

stroke.

5–206

(double)

1–28

(double)

.1–3

(double)

Aspirate speed Pipettor aspiration speed in micro liters per

second.

5.00,

10.00,

20.00,

30.00,

40.00,

50.00,

75.00,

100.00,

125.00

0.50, 1.00,

2.00,

5.00,

7.00,

10.00,

15.00,

20.00,

25.00,

30.00

0.25, 0.50,

0.75, 1.00,

1.25, 1.50,

2.00, 3.00,

5.00,

10.00

Pump speed Speed to run the pumps which fill and drain the

wash reservoir. Two speeds, fast and slow, are

available. Use slow for wash solvents which

tend to bubble.

fast, slow

Strokes Number of times which the pipettor fills and

empties in each wash cycle.

1–20

(integer)

Hold time Pause time in seconds at the top of the stroke of

the pipettor

0–15

Dispense speed Pipettor dispense speed in micro liters per

second.

5–200

(double)

1–50

(double)

.1–10

(double)

Example Command Line

washtips<TAB>a,2,28.0,20.00,fast,5,0.0,20.0<CR>
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Example Response

ok<CR>

Suggested Steps in Command Usage

1. Make sure an experiment is not running.
2. Ensure that tips are loaded.
3. Send washtips command.

Response is OK that confirms the command executed or a Condition code that confirms the
command did not execute.

4. Monitor status until the wash completes.

Command Specific Error Responses

C68 - Tips not loaded

Configuration<CR>

Command Description:

The configuration command returns the configuration of the instrument. The configuration
response is an ASCII text string which includes:

Information about the instrument type and firmware version.
Pipettor head type
Tip washer type
Bar code reader installed or not
Plate handler installed or not
Camera type installed
Chiller installed or not
LEDs installed
Emission filters wavelength

Example Command Line

configuration<CR>

Response format

instrument<SP>name<TAB>

version<SP>version#<TAB>

pipettor<SP>96|384|1536|384pintool| 1536pintool|no<TAB>

tip_washer<SP>96|384|1536|no<TAB>

bar_code<SP>installed|not installed<TAB>

plate_handler<SP>installed|not installed<TAB>

camera_installed<SP>emccd|<TAB>

chiller_installed<SP>installed|not installed<TAB>

wave1<SP>no led|470-495 nm|510-545 nm|390-420 nm|420-455
nm|610-626 nm|360-380 nm|525-550 nm|525-570 nm|570-595
nm|590-614 nm|620-648 nm|495-505nm|360-380 nm <TAB>

wave2<SP>no led|470-495 nm|510-545 nm|390-420 nm|420-455
nm|610-626 nm|360-380 nm|525-550 nm|525-570 nm|570-595
nm|590-614 nm|620-648 nm|495-505 nm|360-380 nm <TAB>
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emfilt1<SP>no filter|515-575 nm|565-625 nm|440-480 nm|475-535
nm|646-706 nm|400-460 nm|570-630 nm|590-650 nm|615-675
nm|634-694 nm|668-728 nm|526-585 nm|400-460 nm<TAB>

emfilt2<SP>no filter|515-575 nm|565-625 nm|440-480 nm|475-535
nm|646-706 nm|400-460 nm|570-630 nm|590-650 nm|615-675
nm|634-694 nm|668-728 nm|526-585 nm|400-460 nm<TAB>

emfilt3<SP>no filter|515-575 nm|565-625 nm|440-480 nm|475-535
nm|646-706 nm|400-460 nm|570-630 nm|590-650 nm|615-675
nm|634-694 nm|668-728 nm|526-585 nm|400-460 nm<TAB>

<CR>

Example Response

Instrument<SP>tetra<TAB>

version<SP>2.1.0.0<TAB>

pipettor<SP>96<TAB>

tip_washer<SP>96<TAB>

bar_code<SP>installed<TAB>

plate_handler<SP>installed<TAB>

camera_installed<SP>emccd<TAB>

chiller_installed<SP>installed<TAB>

wave1<SP>470-495 nm<TAB>

wave2<SP>510-545 nm<TAB>

emfilt1<SP>515-575 nm<TAB>

emfilt2<SP>515-575 nm<TAB>

emfilt3<SP>515-575 nm<CR>

Suggested Steps in Command Usage

Send configuration command.
Response is instrument configuration.

Statusex<CR>

Command Description

The statusex command is an extension of status command. It returns the status of the
instrument in more detail than the status command. The statusex response is an ASCII text
string which includes all status command response information plus:

Tip washer status
Camera chiller status
Camera intensifier status

Example Command line

statusex<CR>

Response format

instrument <SP>instrument name<TAB>

version<SP>mm/dd/yyyy<TAB>

function<SP>ok|errorcode|fatalcode,[errorstring]<TAB>
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inst_
status<SP>busy|fault|error|resetting|abort|idle,remote|manual,offline|online
<TAB>

exp_running<SP>yes|no<TAB>

readplate<SP>platename|none,have|empty<TAB>

sourceplate1<SP>platename|none,have|empty<TAB>

sourceplate2<SP>platename|none,have|empty<TAB>

sourceplate3<SP>platename|none,have|empty<TAB>

loadplates<SP>re[,s1,s2,s3,ti]|none<TAB>

removeplates<SP>re[,s1,s2,s3,ti]|none<TAB>

platehandler<SP>idle|busy_load|busy_remove<TAB>

plate_on<SP>yes|no<TAB>

camera_temp<SP>ok|not ok|off|busy|fault,temp,setpoint<TAB>

chamber_temp<SP>ok|not_ok|fault|off|busy<TAB>

waste_bottlea<SP>ok|full<TAB>

waste_bottleb<SP>ok|full<TAB>

fill_bottlea<SP>ok|empty<TAB>

fill_bottleb<SP>ok|empty<TAB>

tips<SP>on|off<TAB>

outer_auto_door<SP>open|closed<TAB>

tip_washer<SP>ok|not_ok|off|busy|fault<TAB>

chiller_status<SP>ok|not_ok|off|busy|fault,temp,setpoint<TAB>

intensifier_status ok|not_ok|off|busy|fault<CR>

Example Response

instrument<SP> tetra<TAB>

version<SP>2.1.0.0<TAB>

function<SP>ok<TAB>

inst_status<SP>idle,remote,online<TAB>

exp_running<SP>no<TAB>

readplate<SP>default96,have<TAB>

sourceplate1<SP>default96,have<TAB>

sourceplate2<SP>default96,have<TAB>

sourceplate3<SP>default96,have<TAB>

loadplates<SP>none<TAB>

removeplates<SP>none<TAB>

platehandler<SP>idle<TAB>

plate_on<SP>no<TAB>

camera<SP>temp ok,0,0<TAB>

chamber_temp<SP>off,0,0<TAB>

waste_bottlea<SP>ok<TAB>

waste_bottleb<SP>ok<TAB>

fill_bottlea<SP>ok<TAB>

fill_bottleb<SP>ok<TAB>
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tips<SP>on<TAB>

outer_auto_door<SP>open<TAB>

tip_washer<SP>ok<TAB>

chiller_status<SP>ok,18.0, 18.0<TAB>

intensifier_status<SP>ok<CR>

Cellflaskcontrol<TAB>Rate<CR>

Command Description

This command sets the stir rate for the cell flask control. After you send this command, the
robotic controller should monitor the instrument stir rate to confirm that the instrument reaches
the setpoint.

Command Parameters

There is one required parameter, rate, for this command.

If you use a value of zero for the rate parameter, the cell flask control stops stirring. If you use a
valid value for rate, the cell flask control turns on and stirs at this rate. Valid values for rate are
integers between 1–25.

Example Command Line

cellflaskcontrol<TAB>22<CR>

Example Response

ok<CR>

Suggested Steps in Command usage

1. Make sure an experiment is not running.
2. Send cellflaskcontrol command.

Response is OK that confirms the command executed or a Condition code that confirms the
command did not execute.

3. Monitor status until the instrument reports that it has reached the requested stir-rate.

Command Specific Error Responses

C76 – Cell flask stirring rate parameter was not sent
C77 – Parameter is out of range

Error Handling and Reporting

Interface Errors

Interface errors are errors generate when you issue a command. These errors are detected
upon receipt of the command by the ScreenWorks Software and are reported in the response
to the command. These errors consist of a single alpha character and a two or three-digit code.

Error

Code

Description

C01 Instrument is not in Remote mode. You can send only the status command when the

instrument is in Manual mode.

Interface Errors
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Error

Code

Description

C05 Invalid plate location.

C10 Plate handler is busy.

C15 Plate location already has a plate.

C16 Plate location has no plate.

C20 Landing pad has no plate.

C21 Landing pad has plate.

C25 Experiment is running.

C35 Protocol could not be opened.

C36 Invalid protocol name.

C45 Folder does not exist.

C46 Invalid folder name.

C47 Invalid data file name.

C50 Current document is not valid protocol.

C55 No experiment is running.

C56 No protocols found in dir.

C57 The temperature parameter (int) was not sent.

C58 Can't load tips, tips on pipettor.

C59 Can't unload tips, no tips on pipettor.

C60 The temperature control system is not functioning.

C61 The aspirate speed is out of range.

C62 The pump speed can only be Slow or Fast.

C63 Invalid number of wash strokes.

C64 Invalid number of parameters for the wash tips command.

C65 Invalid number of wash cycles.

C66 Invalid protocol parameters discovered at run time.

C67 Invalid wash fluid parameter.

C68 Can't wash tips, tips are not on.

C69 Unrecognized or badly formatted command.

C70 Volume stroke too large.

C71 Volume stroke too small.

C72 Hold time is too small.

Interface Errors (continued)
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Error

Code

Description

C73 Hold time is too large.

C74 Dispense speed is too large.

C75 Dispense speed is too small.

C76 Cell flask stirring rate parameter was not sent.

C77 Parameter is out of range.

C79 Invalid volume parameter. It must be 'low' or 'high'.

Interface Errors (continued)

The following table lists the errors for the runexperiment command. The errors explain how the
protocol does not match instrument configuration or the instrument is not ready to run the
protocol.

Error

Code

Description

E100 Invalid LED filter combination! Calibrate the LED filter combination or select a valid

combination.

E110 Plate does not exist in Plate Library. Choose an existing plate or add this plate to the Plate

Library.

E111 Plate is not present or is not in the proper location.

E112 Doors are opened. Close the doors before you start the experiment.

E113 Load Tips position not checked! Check the Load Tips position for auto load tips or manually

load tips before you run the experiment.

E114 The chamber temperature is not in range.

E115 Experiment requires wash tips and there is no tip washer.

E116 Bottle A is empty! Refill it or use another bottle.

E117 Bottle B is empty! Refill it or use another bottle.

E118 Waste bottle A is full. Empty the bottle to continue.

E119 Waste bottle B is full. Empty the bottle to continue.

E120 Remove redundant plates.

E121 Error related to the data folder. The path is not valid, cannot be accessed, or there is not

enough disk space.

E122 Error related to the export folder. The path is not valid, cannot be accessed, or there is not

enough disk space.

E123 The read interval is too short. Check settings in Read views.

E124 Invalid aspirate parameters in the protocol.

runexperiment Command Errors
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Error

Code

Description

E125 Invalid dispense parameters in the protocol.

E126 The wash tips parameters are invalid.

E127 Invalid fluid bottle specified in wash tips process.

E128 Invalid Read Mode configuration. You tried to take fluorescence (with excitation) and

luminescence (without excitation) read in one protocol. This is not allowed.

E129 Invalid Read Mode configuration. Camera gain is out of range. Check the protocol settings.

E132 Cell flask spinning rate could not be set. Check the instrument status.

runexperiment Command Errors (continued)
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Instrument Errors

The instrument errors that generate when you execute a command are detected during the
execution of the command. They are reported in the status response in the function line and
display a three-digit numeric code. Instrument errors are either recoverable or fatal. When fatal
errors occur, the instrument cannot continue to do any operations and aborts any pending
operations. You can provide instructions to the instrument for recoverable errors so that the
instrument can continue.

The status command returns ERRORCODE or FATALCODE.

Error Code Description

100-199 Contact Technical Support

200-299 Recoverable errors

300-399 Non-fatal errors

C15 Fatal errors

C16 Diagnostic errors

Instrument Errors

For a full list of these errors, see Troubleshooting on page 159.

Remote Interface Revision History

V1.0

First release.

V1.1

Added the following new commands:

version
loadtips
unloadtips
cyclecameratemp
tempcontrolonoff
washtips

Error code response include text description after code, for example, c45, folder does not
exist.

V1.2

Added Error Code:

C01, Instrument is not in Remote Mode.Only status command can be sent while
instrument is in Manual mode.

Bug Fix:

Commands made to the remote interface could sometimes take a long time and cause the
remote interface to not respond to the client application within an acceptable timeframe. Client
applications were able to work around this bug with massive TCP/IP timeouts (minutes) which
made a true hang or network dropout undetectable. This workaround is no longer required.
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The interface is unchanged, and if the client is correctly parsing the status response, no
changes should be required in the client application, with the exception of reducing the TCP/IP
timeout back to an acceptable value, for example, < 10 seconds. As always, rigorous regression
testing of client code is encouraged.

V1.3

Added the following new commands to support new functionality in the Tetra Plus:

statusex
configuration
cellflaskcontrol

Note: Tips location has changed from the Source 3 location to the Source 1 location.

Barcode Specifications

About Bar Codes

The FLIPR Penta System bar code scanner is an OEMmodule with decode capability to most
commonly used bar code symbols:

WPC (UPC /EAN/JAN
IATA
Code 39
Interleaved 2 of 5
Industrial 2 of 5
Code 128
Code 93
MSI/Plessey
Codabar (NW-7)

Bar Code Recommendations

The bar code reader allows a bar code read down to 7.5 mil (0.20 mm) on photographic-quality
symbols and ambient light < 450 ft-candles.

We recommend that the label stay above 7.5 mil (0.26 mm) since bar code printers might not
have the resolution needed to match the aspect ratio for a minimum of 3 mm-high symbol lines.
Before you adjust the bar code scanner to the bar code label location on the plate, follow these
general guidelines for the preparation and quality of the bar code label:

The minimum height or size of the symbol bars depends on the code symbol and the
density you use. Keep the height of the symbol bars to more than 0.12 in. (3.0 mm).
Do not change the aspect ratio required by the label printer. Do not force the bar code
symbol size to fit on the label space i.e., maintain the aspect ratio free of distortion.
Align the bars horizontally (side-to-side) and vertically (top-to-bottom) if possible, to keep
space available on the bar code label.
Keep a few millimeters (2–4) of empty dead or silent zone on both ends of the code-symbol
lines. Keep all symbol lines away from the label corners and lifted edges. Optimize the
characters so there is no need to cram a lot of lines on the label.
Keep the longitudinal dimension of the labels/symbols to less that 1.25–1.50 in. (30–
40 mm).
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Choose the media (label substrate material or paper) print or transfer ink to give good
contrast and optimal reflection. Metalized, very shiny or clear background labels may be
less reliable. Test a sample if you use a new color or surface material.

Bar Code Specifications
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Appendix G: Electromagnetic Compatibility

Regulatory for Canada (ICES/NMB-001:2020)

This ISM device complies with Canadian ICES-001.

Cet appareil ISM est confomre à la norme NMB-001 du Canada.

ISM Equipment Classification (Group 1, Class A)

This equipment is designated as scientific equipment for laboratory use that intentionally
generate and/or use conductively coupled radio-frequency energy for internal functioning, and
are suitable for use in all establishments, other than domestic and those directly connected to a
low voltage power supply network which supply buildings used for domestic purposes.

Information to the User (FCC Notice)

This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to part 18 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference when the equipment is operated in a commercial
environment. This equipment generates, uses, and can radiate radio frequency energy and, if
not installed and used in accordance with the instruction manual, may cause harmful
interference to radio communications. Operation of this equipment in a residential area is likely
to cause harmful interference in which case the user will be required to correct the interference
at their own expense. Changes or modifications made to this equipment not expressly
approved by the party responsible for compliance may void the FCC authorization to operate
this equipment.

G
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